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Disclaimer 

1.1 AVEVA does not warrant that the use of the AVEVA software will be uninterrupted, error-free or free from viruses. 

1.2 AVEVA shall not be liable for: loss of profits; loss of business; depletion of goodwill and/or similar losses; loss of 
anticipated savings; loss of goods; loss of contract; loss of use; loss or corruption of data or information; any special, 
indirect, consequential or pure economic loss, costs, damages, charges or expenses which may be suffered by the user, 
including any loss suffered by the user resulting from the inaccuracy or invalidity of any data created by the AVEVA 
software, irrespective of whether such losses are suffered directly or indirectly, or arise in contract, tort (including 
negligence) or otherwise. 

1.3 AVEVA shall have no liability in contract, tort (including negligence), or otherwise, arising in connection with the 
performance of the AVEVA software where the faulty performance of the AVEVA software results from a user's 
modification of the AVEVA software. User's rights to modify the AVEVA software are strictly limited to those set out in the 
Customisation Manual. 

1.4 AVEVA shall not be liable for any breach or infringement of a third party's intellectual property rights where such 
breach results from a user's modification of the AVEVA software or associated documentation. 

1.5 AVEVA's total liability in contract, tort (including negligence), or otherwise, arising in connection with the performance 
of the AVEVA software shall be limited to 100% of the licence fees paid in the year in which the user's claim is brought. 

1.6 Clauses 1.1 to 1.5 shall apply to the fullest extent permissible at law. 

1.7. In the event of any conflict between the above clauses and the analogous clauses in the software licence under which 
the AVEVA software was purchased, the clauses in the software licence shall take precedence. 

Copyright 

Copyright and all other intellectual property rights in this manual and the associated software, and every part of it 
(including source code, object code, any data contained in it, the manual and any other documentation supplied with it) 
belongs to, or is validly licensed by, AVEVA Solutions Limited or its subsidiaries. 

All rights are reserved to AVEVA Solutions Limited and its subsidiaries. The information contained in this document is 
commercially sensitive, and shall not be copied, reproduced, stored in a retrieval system, or transmitted without the prior 
written permission of AVEVA Solutions Limited. Where such permission is granted, it expressly requires that this copyright 
notice, and the above disclaimer, is prominently displayed at the beginning of every copy that is made. 

The manual and associated documentation may not be adapted, reproduced, or copied, in any material or electronic form, 
without the prior written permission of AVEVA Solutions Limited. Subject to the user's rights, as set out in the 
customisation manuals to amend PML software files contained in the PDMSUI and PDMSLIB folders and any 
configuration files, the user may not reverse engineer, decompile, copy, or adapt the software. Neither the whole, nor part 
of the software described in this publication may be incorporated into any third-party software, product, machine, or 
system without the prior written permission of AVEVA Solutions Limited, save as permitted by law. Any such unauthorised 
action is strictly prohibited, and may give rise to civil liabilities and criminal prosecution. 

The AVEVA software described in this guide is to be installed and operated strictly in accordance with the terms and 
conditions of the respective software licences, and in accordance with the relevant User Documentation. Unauthorised or 
unlicensed use of the software is strictly prohibited. 

Copyright 1974 to current year. AVEVA Solutions Limited and its subsidiaries. All rights reserved. AVEVA shall not be 
liable for any breach or infringement of a third party's intellectual property rights where such breach results from a user's 
modification of the AVEVA software or associated documentation. 

AVEVA Solutions Limited, High Cross, Madingley Road, Cambridge, CB3 0HB, United Kingdom. 

Trademark 

AVEVA and Tribon are registered trademarks of AVEVA Solutions Limited or its subsidiaries. Unauthorised use of the 
AVEVA or Tribon trademarks is strictly forbidden. 

AVEVA product/software names are trademarks or registered trademarks of AVEVA Solutions Limited or its subsidiaries, 
registered in the UK, Europe and other countries (worldwide). 

3
rd

 Party Software 

The copyright, trademark rights, or other intellectual property rights in any other product or software, its name or logo belongs to its 
respective owner. 

The following 3
rd
 party software is included in some of the AVEVA products described in this document: 

 Teigha™ for .dgn files 2007-2010 by Open Design Alliance. All rights reserved. 

 Teigha™ for .dwg files 2003-2010 by Open Design Alliance. All rights reserved. 

 Microsoft® Office Fluent™ user interface.  Fluent is a trademark of Microsoft Corporation and the Fluent user interface is 
licensed from Microsoft Corporation. The Microsoft Office User Interface is subject to protection under U.S. and international 
intellectual property laws and is used by AVEVA Solutions Limited under license from Microsoft. 



AVEVA Marine 12.1       User Bulletin 

Copyright 1974 to current year. AVEVA Solutions Ltd.   i 
 

Contents 

AVEVA Hull & Outfitting 1 

Release 12.1 1 

User Bulletin 1 

1. Introduction 1 

1.1 About AVEVA Hull and Outfitting 12.1 1 

1.2 About this Bulletin 1 

1.3 Software Distribution and Installation 1 

1.3.1 Projects in Folders with Embedded Spaces 2 

1.4 Licensing AVEVA Hull and Outfitting Software 3 

1.5 AVEVA Hull and Outfitting 12.1 Test Projects 4 

2. Upgrading from Previous Releases 5 

2.1 Upgrade Overview 5 

2.2 Upgrade Framework 5 

2.3 Database Version Control 6 

2.4 Part Upgrades Outside the Framework 6 

2.5 Global 6 

2.6 The Upgrade Process 8 

2.6.1 Locking the Project 8 

2.7 Extract Hierarchies 8 

2.7.1 Working Extracts 9 

2.7.2 Offline Locations 9 

2.8 International Characters (Unicode) 9 

2.9 Units of Measure 10 

2.9.1 Units in Outfitting 10 

2.9.2 Units in Hull and Drafting 10 

2.10 Schematics Functions 11 

3. Configuration 13 

3.1 Operating Environment 13 

3.2 PC Hardware Configuration 13 

3.3 Microsoft Windows 13 

3.3.1 Microsoft Internet Explorer 13 

3.3.2 Microsoft Office & Fonts 14 

3.4 Graphics Cards 14 

3.5 Environment Variables 14 

4. General System Changes 15 

4.1 Unicode Character Handling 15 

4.1.1 Restrictions 15 

4.1.2 Textual File Handling 15 

file://sena1_offline/users/lena.strand/Release%20Documentation/Bulletins/12.1/HullandOutfitting%20User%20Bulletin.doc%23_Toc305590472
file://sena1_offline/users/lena.strand/Release%20Documentation/Bulletins/12.1/HullandOutfitting%20User%20Bulletin.doc%23_Toc305590473
file://sena1_offline/users/lena.strand/Release%20Documentation/Bulletins/12.1/HullandOutfitting%20User%20Bulletin.doc%23_Toc305590474


AVEVA Marine 12.1       User Bulletin 

Copyright 1974 to current year. AVEVA Solutions Ltd.   ii 
 

4.1.3 Filenames and PML 15 

4.1.4 Using Forms and Menus 16 

4.1.5 Using TTY Mode 16 

4.1.6 Graphical Output 16 

4.2 Units of Measure 16 

4.2.1 Supported Dimensions and Units 17 

4.2.2 Other UNITS Commands 19 

4.2.3 Upgrading to use new Units 20 

4.2.4 Units set up for Hull and Drafting 21 

4.3 Enhanced Password Protection 22 

4.4 Status Control 23 

4.5 Report generation 23 

4.5.1 New Reporting Add-in 23 

4.5.2 ‗Classic‘ Reporting 24 

4.6 GML Performance 24 

5. Database changes 25 

5.1 New Database types 25 

5.1.1 Engineering Database 25 

5.1.2 Design Reference Database 25 

5.2 Access to Databases 26 

5.3 Increase in Number of Databases 26 

5.3.1 Admin GUI 26 

5.4 Duplicate Names 27 

5.5 Flexibility of Data Organisation 27 

5.5.1 Database Views 27 

5.5.2 Distributed Attributes 27 

5.5.3 Handling of Duplicated Names of UDAs and UDETs 28 

5.5.4 Top-Level Element Creation in Specific Database 28 

5.6 Dynamic Groups 28 

5.7 Database Performance 29 

5.7.1 Specifying the Buffer Size 29 

5.7.2 Dabacon Index Tables 30 

5.8 Units of Measure 30 

5.9 Unicode Storage of Name and Text Attributes 30 

5.10 DRAFT Line-style World Hierarchy 30 

5.11 Extract Control – Include Flush Capability 30 

6. User Interface 32 

6.1 Entry to System 32 

6.2 Save and Restore Views 32 

6.3 Grid Control 33 



AVEVA Marine 12.1       User Bulletin 

Copyright 1974 to current year. AVEVA Solutions Ltd.   iii 
 

6.4 Toolbar Popup Menu 33 

6.5 PML Collections 33 

6.6 Attribute Display, Editing and Validation 33 

6.7 Auto-naming Utility Enhancement 34 

6.8 Additional Debug Information about PML Applications 35 

6.8.1 Help About 35 

6.8.2 PML Alert 35 

6.9 Infragistics Toolkit 36 

7. Administration 37 

7.1 GUI Improvements 37 

7.2 Lexicon 37 

7.2.1 New Lexicon Graphical View 37 

7.2.2 UDA Lists of Values 38 

7.2.3 Database Views 38 

7.2.4 General 39 

7.3 Admin GUI Changes for Global 40 

7.3.1 Global Support for Linked Documents 40 

7.3.2 Database Distribution Form 42 

7.3.3 Creation of an Event without Times 44 

7.3.4 Remote File Details in Admin 44 

7.3.5 Enhanced User Interface for Sessions 45 

7.4 Engineering (ENGI) Database 45 

7.5 TAGS Module Definition 45 

8. Introduction to New Functionality 46 

9. AVEVA General Functionality 47 

9.1 Performance Improvements in AVEVA Marine 47 

9.2 SetStart Method of NameSeq Object 48 

9.3 BLOCK Creation in Specific Database 49 

9.4 Stable Identification of Un-named Hull Elements 50 

9.5 New Storage Model for Hull ObjectsDescription 51 

9.6 Hull Specific Design Explorer Configuration 52 

9.7 Limited Unicode Support in Hull Design 53 

9.8 Improved Local Language – Unicode Encoding 54 

9.9 Units of Measure – Extended Range of Conversions 55 

9.10 Extract Claims in Hull Applications 56 

9.11 Documentation 57 

10. AVEVA Initial Design 58 

10.1 Lines - New Grid in PACE 58 

10.2 Lines - Individual Tuft Size in Views in PACE 60 

10.3 Lines - Macro Editor in PACE 61 



AVEVA Marine 12.1       User Bulletin 

Copyright 1974 to current year. AVEVA Solutions Ltd.   iv 
 

10.4 Lines - Clines Project Limits (PMB and Mid Ships) 62 

10.5 Lines - Curve Highlighting 63 

10.6 Lines - Locking and Fitting to a Plane 64 

10.7 Lines - Curve Interrogation 65 

10.8 Lines – Angle Curve Creation/Editing 66 

10.9 Lines - User Local View 68 

10.10 Corrugated RSOs 70 

10.11 Compartment Export/Import in XML Format 71 

10.12 Release of Weights to Calc 72 

10.13 Axis Setting Reflected in Dialogs 73 

10.14 Sea Water Density 74 

10.15 Multiple Lightship Weights 75 

10.16 Oil Outflow 76 

10.17 Inclining Experiment 77 

10.18 Probabilistic Stability to SOLAS 2009 Rules 78 

10.19 Damage Case Summary Table 79 

10.20 MODU Wind Heeling Moments 80 

10.21 Connected Compartments 81 

10.22 ABS Towing Criteria 82 

11. AVEVA Hull General Functionality 83 

11.1 Reuse of Seam and Profile Numbers 83 

11.2 Multiple Negatives when Designing User Defined End Cut 84 

11.3 Split of Hull Notes and Posno 85 

11.4 Enhanced Selection Filtering 86 

11.5 Blocks and Panels from Tree View 87 

11.6 Set-up of a Project to Use Free Naming 88 

11.7 Hole Annotation Enhancement 89 

11.8 Hull Qualities in CATA 90 

11.9 Shellx with Plate Scantlings, Position Numbers and Material Quality 91 

11.10 New Dialog when Setting Functional Descriptions 93 

11.11 Increased Number of Surfaces 95 

12. AVEVA Surface Manager 96 

12.1 Surface Manager Replacing Surface Server 97 

12.2 Surface Manager – Compare Surfaces 98 

13. AVEVA Space Management 99 

14. AVEVA Hull Structural Design 100 

14.1 New Options when Creating Envelopes 100 

14.2 RSO Change Envelope 101 

14.3 RSO Recreate 102 

14.4 RSO Rename 103 



AVEVA Marine 12.1       User Bulletin 

Copyright 1974 to current year. AVEVA Solutions Ltd.   v 
 

14.5 Naming of Multiply Copied RSOs 104 

14.6 Pick Option Added in RSO KeyIn 105 

14.7 Pick Option Added in RSO Edit 106 

14.8 Right Click Menu on RSO 107 

14.9 Stable Multi Face RSO Reference 108 

14.10 Seam from RSO 109 

14.11 COR Keyword when Referencing RSOs and Surfaces 110 

14.12 Delete Surface Object from Design Database 111 

14.13 Block, Recreate All 112 

14.14 Right Click Menu on Blocks 113 

14.15 Jumbo Panels Removed 114 

14.16 FEM World for Idealised and FE Models 115 

14.17 FEM Additions 117 

14.18 FEM Improvements 118 

15. AVEVA Hull Detailed Design 119 

15.1 Separate Handling of Auto Bevel for Stiffener End Web and Flange 119 

15.2 Bevel Chamfer Option 120 

15.3 Bevel for Shell Stiffener Ends 121 

15.4 Position of Upper and Lower Cutting Curve 122 

15.5 Position Control of Shell Profile and Plane Panel Stiffener 123 

15.6 Compensation for Shell Plate Thickness 125 

15.7 Top View of Stiffener Improved 126 

15.8 Weld Built Profiles before Bending 127 

15.9 Weight Unit in Profile Sketches 128 

15.10 Generic File Viewer 129 

15.11 Looking Field Changed for Hull Mark Projection 131 

15.12 Control of Marking Gap at Holes 132 

15.13 GSD Marking of Built Profiles 133 

15.14 Mark Reference Plane on Both Sides of Profiles 134 

15.15 Nest Profiles without Rest 135 

15.16 New Nesting Default Parameters 136 

15.17 Nesting Plug-In Interface 140 

15.18 Storing Changes after Running Production Programs 141 

15.19 New MANU Data Model 142 

15.20 Automatic Naming of Production Sketches 144 

15.21 Find Documents Related to Production Parts 145 

15.22 Naming of Curved Plates and Stiffeners 146 

15.23 Function to Find and Remove Dangling MANU Parts 148 

15.24 Enhancement in Dialogue for Automatic Position Number Definition. 149 

15.25 Reflection in Hull Element Names and Hurefl Attribute 150 



AVEVA Marine 12.1       User Bulletin 

Copyright 1974 to current year. AVEVA Solutions Ltd.   vi 
 

15.26 FRP Additions 151 

15.27 Tribon 5 Curved Hull Input Data 152 

16. AVEVA Hull Weld Planning 153 

16.1 Weld Calculation Curved Panels 153 

16.2 Weld Calculation Shell Profiles 154 

17. AVEVA Design Reuse 155 

18. AVEVA Assembly Planning 156 

18.1 Curved Hull Panel as Base Panel for Assembly Orientation 156 

18.2 Clean Up Assembly References 157 

18.3 New Drawing Type for Assembly ADP Drawings 158 

18.4 Multiple Select 160 

18.5 Change Projection of an Assembly ADP Drawing View 161 

18.6 POS attribute available for ASMBLY Elements 162 

19. AVEVA Marine Drafting 163 

19.1 Symbolic View Menu 163 

19.2 Default Action at Start-up 165 

19.3 New Module Name 166 

19.4 Drawing Export Formats 167 

19.5 Navigate To 168 

19.6 General Note 169 

19.7 Choose Projection 170 

19.8 Fill Styles 171 

19.9 Symbol Files 173 

19.10 Dynamic Highlighting 174 

19.11 Arc Quarter Points 175 

19.12 New Definition of Line Segment, Direction + Length 176 

19.13 Simple Arithmetic in 2D Offset Input 177 

19.14 Automatic Chaining of New Contours to Existing Ones 178 

19.15 Dimensioning UI Improvements 179 

19.16 Improved Dragging Technique 180 

19.17 Plane Reference Text in Distance-To-Plane Dimensioning 181 

19.18 Delete Last Entity 182 

19.19 Persisting Contours to PADD 183 

19.20 Text Font Attributes 184 

19.21 Dimming & Checking of Menu Items 185 

19.22 Unicode 186 

19.23 Restriction of Symbolic Views 187 

19.24 Inspect Drawing 189 

19.25 Draw Assemblies 190 

19.26 RSO Default Colours 192 



AVEVA Marine 12.1       User Bulletin 

Copyright 1974 to current year. AVEVA Solutions Ltd.   vii 
 

19.27 RSO Enhancements in Insert Model 193 

19.28 Curved Panel Holes in Input Model 194 

19.29 Base Line Position Ruler 195 

19.30 Overlays 196 

19.31 Protection of the Drawing Form View 197 

19.32 Open Drawing 198 

19.33 Drag and Drop to the 2D Canvas. 199 

19.34 Marine .NET API (hull views) 200 

19.35 Removing Default Variables 202 

19.36 TBSystemFonts 204 

19.37 Persisting of part level modifications in Linear Dimensions 206 

20. AVEVA Outfitting Draft 209 

20.1 Extended Hatch Patterns 209 

20.2 Line Styles 209 

20.3 Line Widths 209 

20.4 System Defined Line Styles 209 

20.5 User Defined Line Styles 210 

20.6 Minimum Line Width 210 

20.7 Plotting User Interface 210 

20.7.1 DRAFT ―Plotting Options‖ Form 210 

20.7.2 DXF – General Options 211 

20.8 Enhanced Angular Dimensions 211 

20.9 Enhanced P-line Picking 212 

20.10 Improved Performance of Extrusions 212 

20.11 Drawing Gridlines 212 

20.12 Intelligent Text Handling Enhancement 212 

20.13 Export to CAD Formats 213 

20.14 Support for Unicode Text 213 

20.15 Improved Drawing Feature Export 213 

20.16 Configurable DXF & DWG Export 213 

20.17 Configurable DGN Export 214 

20.18 AVEVA Isometric ADP 214 

21. AVEVA Marine Migration 216 

21.1 Preparing Databanks for Import into Hull and Outfitting 12.1 216 

22. AVEVA Schematic 3D Integrator 217 

22.1 New Integrator Object Method 217 

22.2 Electrical Connections 217 

22.3 Whole Diagram Compare 217 

22.4 Selector Rules 217 

22.5 Improved Links Administration 218 



AVEVA Marine 12.1       User Bulletin 

Copyright 1974 to current year. AVEVA Solutions Ltd.   viii 
 

22.6 Configuration Rules Extensions 218 

22.7 Example Macro 219 

23. AVEVA Diagrams 220 

23.1 Diagram Change Highlighting 220 

23.2 Connection between Instrument and Process Items 222 

23.3 Automatic Upgrade of Options Settings Files 223 

23.4 Admin Settings vs. User Settings 224 

23.5 Handling of Units in Annotations 225 

23.6 Publish Diagrams Data to AVEVA NET 227 

23.7 Automatic Line Breaks Depending on Line Priority. 228 

23.8 Improved Shape Annotation in Schematic Model Viewer 229 

23.9 Automatic Line Breaks Depending on Line Priority. 230 

23.10 Improved Shape Annotation in Schematic Model Viewer 232 

23.11 Split-Merge for SCBRAN 234 

23.12 Setting SCVALV GTYP to INST rather than VALV 236 

23.13 Changes to Upgrade Drawing Functionality. 241 

23.14 Linked Files Update 243 

23.15 Possibility to Determine Connector Re-route Style 244 

23.16 Default Value of the Stencil in Batch Job 246 

23.17 Auto Hide Option for Shape Text for Short Connectors 248 

23.18 Miscellaneous Minor Improvements 250 

24. AVEVA Engineering 251 

24.1 Tags 251 

24.1.1 Admin Tab 252 

24.1.2 Tag Deletion 253 

24.2 Schematic Model Manager 254 

24.2.1 Use of units 254 

24.2.2 Units upgrade 254 

24.2.3 Change Highlighting in Diagram 254 

24.3 Tag Compare / Update 255 

25. AVEVA Outfitting Module 256 

25.1 Model Editor 256 

25.1.1 Offset From Feature… option 256 

25.1.2 Structural primitives 256 

25.2 Move, Drag Move and Plane Move Commands 257 

25.2.1 Summary of Move, Drag Move and Plane Move options 257 

25.3 Change highlighting and reversion 258 

25.3.1 Enhanced User Interface for Sessions 258 

25.3.2 Revert Elements Command 259 

25.3.3 Change Highlighting via Extract Data Control 260 



AVEVA Marine 12.1       User Bulletin 

Copyright 1974 to current year. AVEVA Solutions Ltd.   ix 
 

25.3.4 Change Highlighting via Model Changes Add-in 261 

25.4 Enhanced attribute export to Review 266 

25.5 Weight and Centre of Gravity (CofG) form 266 

25.6 DRAFT Explorer 266 

25.7 AVEVA Mechanical Equipment Interface 266 

26. AVEVA Outfitting Design Applications 268 

26.1 Equipment 268 

26.2 Piping 268 

26.2.1 Sloping piping 268 

26.2.2 Direct setting of Insulation Thickness & Material 269 

26.2.3 Bending Machine NC Output 269 

26.2.4 Improved production checks 271 

26.2.5 Material search for Pipe Bending Machine setup 271 

26.3 Structures 271 

26.3.1 Steelwork Connectivity Upgrade 271 

26.4 Hole Management enhancements 272 

26.4.1 Create Holes 272 

26.4.2 Merge Holes 272 

26.4.3 Modify (and Delete) Holes 273 

26.4.4 Utilities 273 

26.4.5 Configuration of Hole Management Data 275 

26.4.6 Hole Association Manager 275 

26.5 Penetration with Piping Component 277 

26.5.1 Creation of Penetration 278 

26.6 Standard Model Library 279 

26.7 Clash Utility enhancements 280 

26.7.1 Reports 285 

26.8 Cable Design 286 

26.9 Multi-Discipline Supports 286 

26.9.1 Cable Tray Supports 286 

26.9.2 Automatic generation of pads 287 

26.9.3 Updating client project defaults 287 

26.10 Outfitting Piping Isometrics 288 

26.10.1 New Output File Formats, Including PDF 288 

26.10.2 TrueType Fonts 288 

26.10.3 Large Coordinates 288 

26.10.4 Additional Coordinate Formats 289 

26.10.5 Drawing Pipe Spool 289 

26.10.6 ‗North‘ Arrow Text 290 

26.10.7 Pipe Penetration Seal Symbol 290 



AVEVA Marine 12.1       User Bulletin 

Copyright 1974 to current year. AVEVA Solutions Ltd.   x 
 

26.10.8 Setting Units in Options files 290 

26.11 Future Considerations 292 

26.11.1 Access platforms, Stairs and Ladders (ASL) 292 

27. AVEVA Global 293 

27.1 Global WCF 293 

27.2 Global Claim Commands 293 

27.3 Global WCF Service Name 293 

27.4 ADUUID Attribute Length 294 

28. AVEVA Catalogue & Specifications 295 

28.1 Model Settings 295 

28.2 Parameterised Detail Text 295 

28.3 Copy Button for Structural Catalogue 295 

28.4 Creation of Structural Specs 296 

28.5 Raw Plates in CATA 296 

29. Known Issues 297 

29.1 Outstanding Faults and Issues 297 

29.1.1 General Issues 297 

29.1.2 AVEVA Schematic 3D Integrator 297 

29.1.3 AVEVA Global 297 

29.1.4 New Reporting Add-in 298 



AVEVA Marine 12.1       User Bulletin 

Copyright 1974 to current year. AVEVA Solutions Ltd.   xi 
 

Revision History 
 

Date Description 

September 2011 Initial release of 12.1 

28/9/2011 Updated 

29/9/2011 Added information about ASL, moved Piping Isometrics to Outfitting 

Design. 

04/10/2011 Added section 1.3.1 Projects in Folders with Embedded Spaces. Added 

section 29.1.3 New Reporting Add-in. 

05/10/2011 Added section 29.1.3 AVEVA Global. 

18/10/2011 Added reference to Upgrade documentation in chapter 2, release note 9.1 

ha been updated with a last bullet point. 

 



AVEVA Marine 12.1       User Bulletin 

Copyright 1974 to current year. AVEVA Solutions Ltd.   xii 
 

 

 



AVEVA Marine 12.1       User Bulletin 

Copyright 1974 to current year. AVEVA Solutions Ltd.   1 
 

1. Introduction 

This bulletin describes the new and enhanced functionality available in AVEVA Hull and Outfitting 

12.1 as compared to AVEVA Hull and Outfitting 12.0. It gives an overview of the major changes, 

which are described in full in new and revised User Documentation. Some known issues are also 

described in this bulletin. 

1.1 About AVEVA Hull and Outfitting 12.1 

AVEVA Hull and Outfitting 12.1 is a major update from AVEVA Hull and Outfitting 12.0; many of 

the associated products have also been enhanced. 

1.2 About this Bulletin 

This manual gives an overview of changes since the previous major release: Hull and Outfitting 

12.0. It is aimed primarily at users upgrading from that release; those upgrading from earlier 

releases should also read the Hull and Outfitting 12.0 User Bulletin, preferably the edition issued 

with Service Pack 6. 

This bulletin also covers many of the associated products supplied on the same DVD-R. These 

products fall into 3 families – Engineer, Design and Manage – and these groupings within the 

Marine portfolio are reflected in this document. Those aspects that are common between most of 

the products are generally covered in the first part of the document. 

1.3 Software Distribution and Installation 

AVEVA Hull & Outfitting 12.1 is supplied on a DVD-R, which self-installs using standard Microsoft 

installation procedures. The full software suite is usually loaded onto individual PCs running 

Windows, with the license server and file loaded onto a networked Windows server.  

Please note that Hull and Outfitting 12.1 onwards requires Flexman 5 and an appropriate license – 
it will not work with Flexman 3 or 4. For further details of Flexman License Server releases, please 
see http://support.aveva.com/services/products/flex/index.asp and 
http://support.aveva.com/services/products/flex/flex_releases.asp . 

The installers use standard Microsoft Installer (MSI) technology, which facilitates silent installations 

through standard MSI means. They are usually triggered by use of a setup.exe file. 

There are fewer separate installers, each corresponding to an AVEVA ‗release‘, on the DVD. The 

Hull & Outfitting/Marine installer now includes options to install many of the associated products, 

although, for various reasons, some products still use a separate installer. 

http://support.aveva.com/services/products/flex/index.asp
http://support.aveva.com/services/products/flex/flex_releases.asp
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Using separate installers means that a selection of products can easily be installed together. This 

includes the AVEVA Global client option, which enables the use of Hull and Outfitting or other 

Marine products with Global. However, there is a separate installer for Global server, which is 

usually installed on a separate machine, such as a server, which does not necessarily have Hull 

and Outfitting installed. 

There are options to install batch files and shortcuts on the desktop and/or in the start menu for 

direct entry to popular modules. In addition, the pml index can be automatically configured. Please 

note that there is no ‗thin client‘ installation option as this is no longer supported. 

Existing installations should be changed, repaired or removed using Add or Remove Programs 

from the Control Panel. This process will prompt for the original DVD if required. This ensures that 

a consistent product set, as tested by AVEVA, will be deployed. 

Fix releases (patches) will use a standard updating process, which also checks, and if necessary 

‗heals‘, the existing installation. There is therefore no prompt for location, as the system already 

has this information. Fix releases may also be removed using Add or Remove Programs. Fix 

releases are applied to all products installed together, not to the individual products. The use of the 

latest fix release is recommended: this includes any previous fixes to products installed together. 

Please note: During the installation it is fully possible to change the path in which the Marine 

product is installed from its suggested default. However, it is required that the installation path does 

not include folders with spaces in the names. 

For full details of the installation options and procedure, and the hardware and software 

requirements, please refer to the Marine Software Installation Guide and Minimum System 

Requirements Marine. 

1.3.1 Projects in Folders with Embedded Spaces  
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AVEVA Hull & Outfitting 12.1 will not fully support projects with spaces in their pathnames. Work is 

in hand to remove these limitations but no definite release date is yet set. 

1.4 Licensing AVEVA Hull and Outfitting Software 

Upgrading to Flexman 5 is a pre-requisite for AVEVA 12 series software. It may also be worth 

stressing that customers do not need to wait for AVEVA 12 but can upgrade at any stage using an 

existing license file: Flexman 5 is compatible with previous software releases from VANTAGE 

Marine 11.6 and onwards. 

All AVEVA 12 series software requires access to a licensing file provided by the Flexman 5 

application, and loaded by the install wizard. The license file can be stored on a networked server 

with client access, a networked workstation with client access, or on the workstation on which the 

AVEVA 12 series software is currently loaded. 

The reason for storing the license file on a server or shared workstation is that it allows maximum 

user flexibility, while minimising the number of licenses that must be leased. 
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1.5 AVEVA Hull and Outfitting 12.1 Test Projects 

The table below shows details about the sample project supplied, and where to find the test data. 

 

Project MDB Description 

MAR ALL_NO_MDS MDB for Project Setup with ALL databases except MDS 

 ALL_WITH_MDS MDB for Project Setup with ALL databases including MDS 

 ASSYPLANNING For Assembly Planning Hull and Outfit Users 

 CABLEAFT For Outfit Aft Cable User 

 CABLETRAYAFT For Outfit Aft Cabletray User 

 CURVEDHULL For Curved Hull User 

 DBPROMPT For creating required db elements from DB Prompt 

 EQUIPAFT For Outfit Aft Equipment User 

 HADMIN For Hull Admin User 

 HULLNESTING For Hull Nesting User 

 HVACAFT For Outfit Aft HVAC User 

 INITDES For Initial Design User 

 LAYOUTAFT For Outfit Aft Layout User 

 MDSAFT For Outfit Aft MDS User 

 OUTSTEELAFT For Aft Outfit Steel User 

 PIPEAFT For Outfit Aft Piping User 

 PLANARHULL For Planar Hull User 

 PROJADMIN For Project Admin User 

 SCHEMATICS For Schematics User 

 STRUCDESIGN For Structural Design User 

 WELDPLANNING For Weld Planning User 

MAS (Catalogue) —  

 

The MDB‘s can be accessed by the system (FREE) user (SYSTEM/XXXXXX), each has their own 

'dedicated' user as well. There will be a full Project Description PDF file with each project which 

contains the details outlined in the table above, plus the Teams and Users (including passwords) 

available in the project. This can be found for the Marine (MAR) project at the projects installation 

location top level, (MARProjectDescription.pdf and MASProjectDescription.pdf). 
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2. Upgrading from Previous Releases 

Please note that the full Upgrade documentation is available from the User Documentation index 

page Read Me First / Upgrade 12.0 to 12.1. 

2.1 Upgrade Overview  

A number of the enhancements made at Hull & Outfitting 12.1 require an upgrade to the database. 

Each of these individual changes is referred to as a Part Upgrade. In general each of these has 

been designed to be ‗optional‘ from a customer perspective, in that the 12.1 software can work with 

a database that has not been upgraded and the software will degrade gracefully – that is, the 

software will continue to work, although some new functions may not be available. 

This means that it is possible for customers to continue to work with Foreign DBs, which may be 

shared with 12.0 or earlier projects and which have not been upgraded, included in their projects. 

An example would be a Corporate Catalogue DB used for 12.0 and multiple projects. 

Databases which have not been upgraded will however be read-only. The following warning will 

appear when opening an MDB from a project that has not been upgraded:  

 

This warning (or similar) indicates that the project needs to be upgraded to the latest version in 

order to allow write access. 

All the Part Upgrades will be run by a new Upgrade Framework, which converts a Hull & Outfitting 

12.0 project to 12.1. This is initiated from Admin using the following commands in the Command 

Pane (or TTY mode): 

lock 

dbupgrade project to latest 

unlock 

This procedure may also be used with Global projects if some additional precautions are taken. A 

brief summary is given below – further details are given in the 12.0 to 12.1 Upgrade manual. 

Earlier projects should first be upgraded to Hull & Outfitting 12.0. 

Schematic Model Manager has its own units handling at Hull and Outfitting 12.0. It also has its own 

upgrade mechanism, which is separately documented; the software will advise if it is necessary to 

run this: 

 

2.2 Upgrade Framework  
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The Upgrade tool is invoked from Admin; it controls the upgrade process and runs each Part 

Upgrade in the appropriate order. Upgrades relevant to Hull & Outfitting that are covered by this 

process are: 

 UKEYs (now include database number to avoid duplicates) 

 Performance of ‗finding‘ database elements (index by type) 

 Module Definitions – new TAGS module (and renamed Marine Drafting module) 

 Character handling (Unicode representation for names, text etc) 

 HULL FEM Data Model 

 Compressed HULL Objects 

 New Index on Hull Object Type 

 Start Value for Name Sequence 

 Assembly POS Attribute 

 Line widths in Draft (widths of thin, medium and thick lines now stored in system database) 

The upgrade tool puts an upgrade number in the databases, indicating the level to which they have 

been upgraded. This makes it easy to detect, on opening, whether a database has or has not been 

upgraded. This upgrade number will also be used by the Reconfigure process. 

2.3 Database Version Control 

The upgrade version number is used to verify that the versions of the database and the software 

that accesses them are compatible. During application start-up, databases are checked against the 

software; access may be restricted according to the following table: 

 Database Upgrade Version 

Pre 12.1 12.1.1 Future (e.g. 
12.2) 

Software Version Max Open Mode 

Pre 12.1 R/W X X 

12.1.1 R R/W X 

Future (e.g. 12.2) R R R/W 

This control ensures that AVEVA software that opens a database is compatible with the contents of 

that database and thereby prevents accidental data corruption. It also ensures that data intended 

for use with one software version is not modified by a newer, incompatible software version. 

X indicates ‗no access‘; however, versions earlier than 12.1 do not make this check, so cannot 

detect a database upgraded to 12.1 or later.  

2.4 Part Upgrades Outside the Framework  

These are independent of other non-framework upgrades; in other words, non-framework 

upgrades can be applied in any order. However, it will not be possible to backtrack to pre-upgrade 

sessions. 

2.5 Global 
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Each database must be entirely in either an upgraded or non-upgraded state for Hull & Outfitting to 

work correctly. Therefore it is essential that all extracts of any database are processed during an 

upgrade.  

The whole project, excluding Foreign databases, should be upgraded at once.  
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2.6 The Upgrade Process 

The upgrade process will be undertaken by System Administrators responsible for the project at all 

locations. When upgrading multiple projects, many System Administrators will need to co-ordinate. 

The upgrade process will upgrade one project at a time. Customers will need to give careful 

consideration to the order of upgrade for the various projects. 

The projects will need to be locked for the duration of the upgrade, with all Users out of the system. 

The upgrade process will be:- 

1. Ensure all users have exited from project 

1. Lock project at all locations (upgrade will check for this (see below) 

2. Disable Automatic update events if required. (Recommended but not essential) 

3. Expunge all users in the system at the local location 

4. Flush data from Working extracts – these will not be considered; in Global projects they 
should be deleted 

5. Check project using DICE (Integrity Checker) 

6. [If DICE reveals issues, address them, then re-run DICE] 

7. Administrator may want to unlock project while DICE issues are being addressed, but will 
need to exclude all users and Lock project again before final DICE check 

8. [After clean DICE check] 

9. Back-up project at all locations 

10. Temporarily relocate all non-Foreign DBs to their master‘s Primary location 

11. Check for No Transient Databases 

12. Upgrade the project at each location 

13. Optionally Merge Sessions 

14. Optionally Reconfigure for Unicode 

15. DICE check project 

16. Relocate extracts back to their original locations 

17. Perform non-framework upgrades if applicable 

18. Unlock the project 

2.6.1 Locking the Project 

The project as a whole cannot be locked, only individual locations; however, it is possible to lock all 

online locations from the HUB through Global. To do this run the following command from the 

HUB: 

LOCK AT <location> 

The HUB can be locked without the need for a daemon command using the command: 

LOCK 

It is possible to confirm whether locations are locked by evaluating the return result from: 

QUERY LOCK AT <location> 

2.7 Extract Hierarchies 

It should not be necessary to change the extract hierarchy, nor to consolidate data within extract 

hierarchies. Therefore the System Administrator should not need to FLUSH, ISSUE, DROP data 
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between extracts (working extracts are an exception to this – see below). Nor should they need to 

delete any extract families to leave only Masters. However all extracts will need to be relocated to 

a single location, although this does not need to be the HUB. 

2.7.1 Working Extracts 

The upgrade process will need to ensure that all data is up to date at the HUB where pre-scan data 

checks will need to be made. Working Extracts cannot be propagated as they are specific to a 

single location. As a result all data MUST be flushed, and claims released from the Working 

Extract into its parent. This is only true for working extracts; all other extracts do not need to be 

flushed, or have their claims released, as they will be available at the HUB. 

2.7.2 Offline Locations 

Global supports Offline locations; therefore we cannot assume that the Hub has a Global 

connection to that location. Offline locations do not support distributed Extracts but can support 

stand-alone extract families.  

It will not be possible to co-ordinate the upgrade from another location if Offline locations are used. 

Offline locations are relatively independent, and can be treated as such.  

2.8 International Characters (Unicode) 

New databases created at Hull & Outfitting 12.1 will by default use the Unicode character set for 

textual attributes and names – see section 5.1. However, no upgrade is required for older 

databases: they will be handled according to the project character set as defined in Admin 

(PROJECT CHARSET or PROJECT MBCHARSET commands). They will also be converted 

according to this setting if they are reconfigured so it is important that it is set correctly! 

In cases where an extended range of characters is needed, Reconfigure may be used to convert a 

‗legacy‘ database to a Unicode encoded database. 

In the following example legacy DICT databases (used to hold UDA and UDET names) are 

reconfigured to be Unicode encoded, using Admin 12.1.  

FROM DB MASTER/DICT 

TO FILE /c:\DICT1 /c:\DICT2 

RCFCOPY ALL 

RECONFIG SESSIONS 

 

FROM FILE /c:\DICT1 /c:\DICT2 

TO DB MASTER/DICT 

RECONFIG 

Doing it this way means that no deletion and recreation (or copy) is required for the DB, and 

therefore neither is re-adding to the MDB structures required. Using RECONFIG SESSIONS in the 

FROM phase of the reconfigure operation will preserve both the sessions and references. 

Summary 

Locally Encoded (Legacy) Databases: 

 can be opened for read access in both Hull & Outfitting 12.1 and earlier versions  

 can be opened for write access in both Hull & Outfitting 12.1 and non-Unicode versions, 
but the range of characters which may be used is restricted to the set defined by the 
project settings 

 require that the project settings are correct so that characters can be interpreted correctly 
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 can be reconfigured to a Unicode encoded database 

Unicode Encoded Databases: 

 cannot be opened for read or write access in versions of Hull & Outfitting prior to 12.1 

 can store the full range of Unicode characters available in Hull & Outfitting 12.1 

2.9 Units of Measure 

2.9.1 Units in Outfitting 

Distance and bore units are handled in much the same way as before and should need no 

conversion. Other attributes will now be converted to and stored in appropriate units.  Where a 

database has stored all quantities of a dimension in the appropriate unit, the new functions can be 

used without upgrade.  

Attributes other than distances and bores have the UNIT field set for the first time; in previous 

versions of Hull & Outfitting, they were until now stored as values with no specified unit, other than 

by use and convention - they could change from application to application, and project to project. 

This approach is not compatible with automated conversion so the storage units must be defined. 

For compatibility, it is possible to set the units to NUMERIC which will disable Units conversion for 

that physical dimension. Disabling a specific dimension in this way means that no advantage will 

be gained from the introduction of that dimension. 

Previous versions of Schematic Model Manager had special units support for Angle, Area, 

Pressure, Temperature, Volume and Weight values that could be included in the ISO15926 format 

import file. Units UDAs were provided as mandatory UDAs and were attributes on each Diagram 

element (SCDIAG). The chosen units for these dimensioned quantities could be set in the Project 

Options form in Schematic Model Manager. In 12.1, the new units capabilities mean that the 

special units support in Schematic Model Manager is no longer required. Data imported in 12.1 will 

be stored in the appropriate units consistent with the data read from the ISO15926 import file. The 

upgrade process for projects moving to 12.1 includes a part upgrade for Schematic Model 

Manager dimensioned data.   

Please note that the CATA database elements MSET, MTYP, ATLI, USEC and UDEF are no 

longer used; they will be removed from the database in due course. 

2.9.2 Units in Hull and Drafting 

In AVEVA Marine Hull and Marine Drafting applications the set up for Units differs from the Units 

setup in Outfitting. 

Presentation format for Units in Hull and Drafting can be set to SI or Imperial. SI units are default. 

The format for SI and Imperial respectively can be further controlled by a set of environment 

variables and default variables. 

For details on the Units usage in Hull and Drafting, please see the following chapters in the AVEVA 

Marine User Documentation: 

1. Hull Basic Features and Concepts -> Basic Features -> Imperial Units Syntax Description 

2. Marine Drafting -> Drafting -> User Guide -> Appendices -> Drafting default file keywords -
> Unit codes 

3. Marine Drafting -> Drafting -> User Guide -> Appendices -> Drafting default file keywords -
> Unit system 

4. Hull Initial Design -> Lines – User’s Guide -> Technical reference -> Conventions -> Units 
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Unit Controlled Dimensions in Hull and Drafting 

The dimensions that can be unit controlled in Hull and Marine Drafting are shown in the table 

below. 

Core units are independent of the Unit settings and are the same for Hull and Outfitting data. 

 

Dimension Core unit 
  

Coordinate mm 
  

Linear measure mm 
  

Area mm
2
 

  

Volume mm
3
 

  

Weight kg 
  

Density kg/ mm
3
 

  

Angle degree 
  

 

Presentation Format for Units in Marine Applications 

Within Hull and Marine Drafting specific application functions, values will be presented according to 

the Hull/Drafting settings.  

Attributes in Hull Initial Design are presented according to Initial Design settings. 

Within general functions available in Hull Design or Marine Drafting, e.g. Reporter, Attribute addin 

or Query attribute command, values will be presented according to the Outfitting Units system. 

Within common marine applications, such as Space Management and Assembly Planning, all 

attributes will be presented according to the Outfitting Units system.   

Within Outfitting specific functions, presentation of hull attributes will follow the Outfitting Units 

system. 

Input Format for Units in Marine Applications 

In Hull and Marine Drafting applications the input format can be SI or Imperial, independent of the 

Units settings.   

Units in Marine – Upgrade and Migration 

No upgrade or unit conversion from AVEVA Marine 12.0 to 12.1 is required for Units in Hull and 

Drafting, since core units have not been changed.  

The unit settings, including the default settings, for Hull and Marine Drafting are the same in 

AVEVA Marine 12.1 as in AVEVA Marine 12.0 (and in Tribon M3).  

2.10 Schematics Functions 

Projects that are upgraded from Hull and Outfitting 12.0 or earlier need a suitable module definition 

in order to use the new Engineering functions in the new Tags product (see above). 

The data will need some reconfiguring: 
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 Integrator links world (CYMWRL) has been moved to Reference database 

 Shape upgrades in Diagrams – automatic when opening a diagram in write mode 

Systems moved to Reference Design database 
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3. Configuration 

3.1 Operating Environment  

Hull & Outfitting 12.1 is supported on Windows XP Service Pack 3 (32-bit) and Windows 7 (both 

32- and 64-bit versions). Projects are usually installed on a server – both Windows Server 2003 & 

2008 R2 are supported. 

3.2 PC Hardware Configuration 

A minimum of 4 GB of memory is recommended for this release, especially when installed on 

Windows 7. Hull & Outfitting 12.0 will operate with less, but system performance will be 

compromised. A screen resolution of at least 1280x1024 is recommended, though most users now 

use either two such screens or a wide-screen (1920x1200) display. For details, please refer to the 

Systems Requirements Manual. 

3.3 Microsoft Windows  

Desktop 

Hull & Outfitting 12.1 is supported for use on Microsoft Windows XP Professional, Service Pack 

(SP) 3 or on Windows 7 (Business and Enterprise editions) Service Pack 1, with appropriate 

patches.  

A single 32-bit version of the Hull & Outfitting system is available; this is supported on both 32- and 

64-bit versions of Windows 7. It is no longer supported on Windows 2000; indeed Microsoft no 

longer offers support for Windows 2000 or Windows XP SP2. 

Please note that User Account Control (UAC) introduces new security restrictions at Windows 7 

(and Vista). In particular, this makes it important to ensure that files that need to be written are 

accessible by users without Administrator privileges.  

3.3.1 Microsoft Internet Explorer 

Internet Explorer is required for the on-line help system; version 7 or 8 is recommended as version 

9 does not currently work correctly. 

Hull & Outfitting 12.1 requires Microsoft‘s .NET Framework 3.5, which is supplied on the DVD and 

installed if required. It should be noted that installation of version 3.5 brings with it several of the 

earlier versions, on which it depends.  

The updated version of .NET used for Hull & Outfitting 12.0.SP6 onwards may prevent .NET add-

ins running if deployed on a network. This will not usually cause an issue as AVEVA recommends 

a local installation on each machine, but might cause problems for customers running their own 

add-ins. 

.NET security can cause issues when running Hull & Outfitting across the network where the add-

in assemblies reside on a different machine to the .NET runtime. The default security level for the 

local intranet is not set to Full Trust, which means that programs may not be able to access 

resources on the local machine. To overcome this, the intranet security may be set to Full Trust, 

though this means that any .NET assembly may run. Alternatively, Full Trust may be given to a 

specified group of strongly named assemblies. 

Trust levels may be set using the Microsoft Code Access Security Policy tool caspol. For details, 

please see http://msdn.microsoft.com/en-us/library/cb6t8dtz(v=VS.90).aspx.  

http://msdn.microsoft.com/en-us/library/cb6t8dtz(v=VS.90).aspx
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Serialization 

Please note that serialized settings (of the user interface configuration) are now saved in the 

following location on Windows XP: 

C:\Documents and Settings\<username>\Local Settings\Application 

Data\Aveva\ 

and on Windows 7: 

C:\users\<username>\Appdata\Local\AVEVA\ 

3.3.2 Microsoft Office & Fonts 

AVEVA Marine 12.1 is supported with Office 2007 and Office 2010. The use of the 32-bit version of 

Office, including Visio, is recommended on both 32- and 64-bit Windows as issues have been 

encountered with the 64-bit version. 

Excel Interoperability 

Import of data into a grid control requires an optional component from Microsoft Office. This is not 

supplied with Hull & Outfitting but is an installation option for Microsoft Office. Please ensure that 

―.NET Programmability Support‖ under Advanced customization of applications‖ is enabled when 

Office is installed. 

This will install the Microsoft Microsoft.Office.Interop.Excel.dll. If this assembly is not enabled, 

invoking the Excel import facility will not work. 

Screen Font for GUI 

The Hull & Outfitting user interface (version 11.6 onwards) requires the use of the Arial Unicode 

MS font, which is supplied with Microsoft Office (version 2000 onwards) and is usually installed 

automatically when using Windows XP or later.  

For further information, please refer to http://office.microsoft.com/enus/help/HP052558401033.aspx. If 

this font is not installed, some of the text in the user interface may become illegible. 

The layout of some GUI forms may also be adversely affected if the screen font size is not set to 

the smallest size, which is usually default. This setting is accessed from the Control Panel and is 

referred to as ―Normal‖ in Windows XP or ―Smaller‖ (100%) in Windows 7. 

3.4 Graphics Cards 

Due to the rapidly changing availability of hardware-accelerated OpenGL graphics cards, an up-to-

date list of supported cards is not included in the documentation released with Hull & Outfitting. 

The AVEVA Product Support website (accessible from http://www.aveva.com) – IT Configuration 

section,– contains a list of tested and supported graphics cards. 

3.5 Environment Variables 

Hull & Outfitting and some of the other products rely on the use of environment variables for 

various aspects of configuration, notably the location of folders for project databases and user 

workspace.  

http://office.microsoft.com/enus/help/HP052558401033.aspx
http://www.aveva.com/
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4. General System Changes 

4.1 Unicode Character Handling  

Earlier versions of Hull & Outfitting handled textual data such as element names, textual attributes 

and file names in a manner specific to the various supported character sets used in supported 

languages. This applied to most of the input, output and storage. This has now changed; all textual 

information in Hull & Outfitting is represented as Unicode. 

Unicode is a computing industry standard for the consistent encoding, representation and handling 

of text expressed in most of the world's writing systems. Developed in conjunction with the 

Universal Character Set standard and published in book form as The Unicode Standard, the latest 

version of Unicode consists of a repertoire of more than 109,000 characters covering 93 scripts. 

For more details, please see: http://en.wikipedia.org/wiki/Unicode.  

Unicode can be implemented using different character encodings. The Hull & Outfitting Internal 

Format for string data is Unicode UTF-8 format. This can handle all seven character sets 

supported in previous versions – and potentially many more.  

4.1.1 Restrictions 

Hull & Outfitting MS has been tested using the same range of languages as previous releases. No 

font files are available for any other language; this means that TrueType fonts must be used on 

drawings and that therefore it is not possible to produce plotfile output. 

With that restriction, it is anticipated that many other languages will work, though there are aspects 

of the Unicode standard that are not yet implemented. Hull & Outfitting currently handles the 

following correctly: 

 Left to Right languages; and therefore not, for example, Arabic and Hebrew 

 -
 

 Upper and lower casing of characters, where both cases have the same number of bytes 

4.1.2 Textual File Handling 

By default all sequential text files read by Hull & Outfitting will be expected to be in UTF-8 format 

with a Byte Order Mark (BOM) present to identify them. Similarly by default all sequential text files 

written by Hull & Outfitting will be in Unicode UTF-8 format with a BOM present.. 

A simple command line ‗transcoder‘ is also supplied; this may be used in some applications to 

convert files to a different encoding. 

4.1.3 Filenames and PML  

The Hull & Outfitting command processor supports Unicode characters. All PML string variables 

support Unicode values. You can use Unicode characters in PML variable names, PML object form 

and gadget names, PML method and function names. It is recommended that PML language files 

should either be UTF-8 format with a BOM present or else strictly ASCII (basic Latin) format. 

AVEVA application (appware) files are mostly ASCII at present. 

Filenames and directory names can also contain foreign Unicode characters, but may cause 

problems in other systems so it is recommended to keep to ASCII names. This applies to some of 

the systems to which Hull & Outfitting is interfaced, and even to some of the interfaces where the 

system makes use of third party software such as output of DXF and DGN. PML Publisher does 

http://en.wikipedia.org/wiki/Unicode
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not currently fully support Unicode filenames. AVEVA has also encountered problems using files 

with non-ASCII names in some development tools. 

4.1.4 Using Forms and Menus 

The default ‗system font‘ used by Forms and Menus (F&M) is Arial Unicode MS which contains a 

large number of the world‘s alphabets. Internally F&M uses Unicode, but can only display the 

characters accessible in its current ‗system font‘. You will be able to copy and paste Unicode 

characters from and to textual fields of F&M gadgets. This includes entering characters into the  

Hull & Outfitting command window. 

4.1.5 Using TTY Mode 

You can enter Unicode characters in Teletype (TTY) mode, but the Console Window can only 

display the characters which exist in its currently selected font. Console fonts tend to be quite 

restrictive so you need to select a suitable one.  In the UK you will probably be restricted to ―Lucida 

Console‖ or ―Consolas‖ which will display European characters but not Asian characters etc. 

4.1.6 Graphical Output 

In general Hull & Outfitting graphical output (2D and 3D) allows only the use of the TrueType fonts 

set up in the Admin module. This will allow you to display Unicode characters which are known to 

those fonts. By default you get font 5 = ―Arial Unicode MS‖ which gives a large range of character 

sets. 

Restrictions using Draft and Isodraft 2D Views 

For TrueType fonts, the TrueType font selected must have the correct character set(s) present for 

the language(s) you want to use. Arial Unicode MS has most, but other TrueType fonts typically 

have a subset. In this case, foreign and mixed language strings will work correctly. 

You can of course use fonts specific to a given language for Unicode characters in that language 

(even if the font name itself is in a foreign character set). 

It is recommended that you avoid using Hull & Outfitting (Wigwam) fonts if possible. It is not, in 

general, possible to have mixed language strings if you use them. They are more complicated to 

setup, and work more like 12.0, so are limited compared with TrueType. The following restrictions, 

some of which were documented in previous versions of the Hull & Outfitting Installation Guide, 

apply: 

4.2 Units of Measure  

The inclusion of a much wider range of units means that most real attributes now have a default 

unit (usually in SI units) for storage and input/output. User can also set a default unit, which must 

be of an appropriate type, for input and output. Input via the command line or GUI also allows the 

user to specify an alternative unit.  

This does mean some unavoidable changes to the command line so user applications using real 

attributes will need to be reviewed. There are also minor changes to many of the user interface 

forms. The new functions can also be accessed by the .NET Units interface, as detailed in the 

.NET Customization manual. 

Customers who have written or adapted PML applications may need to check these. They are 

explained in more detail in the 12.0 to 12.1 Upgrade manual. 

Several of the reference manuals have been updated to reflect these changes, including: 

Catalogue and Specifications Reference Manual 
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 Data Access Routine User Guide 

 Database Management Reference Manual 

 Design Reference Manual Creating The Model 

 Design Reference Manual General Commands 

 Lexicon Command Reference 

 Software Customisation Guide 

 Software Customisation Reference Manual 

4.2.1 Supported Dimensions and Units 

In previous versions of Hull & Outfitting, all dimensioned quantities other than distances or bores 

were output in units stored in the database, irrespective of the current units.  For example all 

masses were assumed to be Kg. 

There is a new set of commands to complement and extend the existing units functions.  These 

commands control the units of supported dimensions, and their dependent quantities (e.g. density 

and pressure). For masses, the command UNITS may be followed by KG MASS, GRAM MASS, 

POUND MASS, TONNE MASS or TON SHORT/LONG MASS. New DISTANCE options are also 

provided: ‗FOOT DIST‘ and ‗METRE DIST‘ to output and return values in these common units.   

The command which sets the distance units is: 

{MM INCH FINCH} DISTANCE 

The new commands use the keyword ‗UNITS‘ to define the units to use for the various dimension 

types.  For example: 

 UNITS MM DISTANCE 

 UNITS POUND MASS 

The leading UNITS keyword is optional for MM INCH and FINCH DISTANCE but is required for all 

new options in the commands listed below. The command and functionality of BORE units remains 

unchanged. 

Some units are case-sensitive to adhere more closely to SI conventions; strict adherence is not 

always possible due to syntax conflicts. This allow a distinction to be made between units such as 

s(econds) and S(iemens), hours and Henrys, tonnes and Teslas. This does not apply to Imperial 

units (IN or in, FT or ft are all valid) or to some metric units such as MM, which have been 

supported in previous releases.  

Units that are case sensitive are (m, s, g, t, K, h, Pa, N, V, A, F, Sv, d, J, W, C, S, H, T, W, P, G) – 

i.e metre, second, gram, tonne, Kelvin, hour, pascal, Newton, volt, ampere, farad, sievert, day, 

joule, watt, coulomb, Siemens, henry, tesla, watt, poise, gforce. SI prefixes are also case sensitive 

– for example, m means milli and M mega – except in their full form (e.g. MILLI and MEGA are 

both accepted). 

The table overleaf shows the new units of measure and the options available, as well as the old 

ones: BORE DIST SQDI CUDI. It gives their name (or description) recognised by the system, the 

assigned hash-code, the database storage units and the supported standard units for the quantity. 

For example, attributes of length have a hash code of DIST, are stored in mm and other standard 

units include inch, cm, ft, metre etc. 
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Name of Dimension HashCode
/Word 

Database 
units 

other specific units comment 

AbsPressure   ABSP pascal bar  atm  PSI  torr  mmHg 
inHg 

Pressure may be 
absolute or gauge 

Acceleration ACCL m/s2 gforce (gravity)  

Angle  ANGL degree radian  grade  arcmin  arcsec   

Angular Frequency           ANGF rpm   

AngularMomentum  ANGM N.m.s     

Area  SQDI mm2 acre hectare   

Bore  BORE mm in Range limited to mm and 
inch (and Finch) 

Capacitance  CAPA farad     

Charge  CHAR coulomb     

Conductance  COND siemens     

Content  PCUD mm-3     

Currency  CURY USDollar UKPound Euro   

Current  CURR ampere     

Density  DENS kg/m3     

DensityMANDB  MAND kg/mm3   Densities stored in 
MANU database 

ElectricConductivity  CNDT Si/m     

ElectricField  EFLD V/m2     

EMF  EMF volt     

Energy  ENER kiloWatthour joule BTU cal   

EnergyDensity  EDEN kg/m3     

Force  FORC newton poundal  dyne  kgF  lbF   

FoulingFactor  FFAC m2.K/W     

Frequency  FREQ hertz rpm   

GaugePressure  GAGE pascal bar  atm  PSI  torr  mmHg 
inHg 

Pressure may be 
absolute or gauge 

HeatCapacity  ENTR J/m     

HeatingValue  HVAL J/m3     

HeatTransferCoeff  HTRA W/m2/K     

Impedance  IMPE ohm     

Inductance  INDU henry     

Inertia  INER kg/m2     

KinematicViscosity  KVIS m2/s     

Length  DIST millimetre m in ft cm km mile yard 
micron thou angstrom 

  

LinearDensity  PDIS mm-1     

MagFieldIntensity  MFIN A/m     

MagFluxDensity  MFXD tesla     

MagneticFlux  MGFX weber     

Mass  MASS kilogram gram  tonne  pound  oz 
longTon  shortTon cwt 

  

MassFlow  MFLO kg/s     

Momentum  MOME N.s     

Permeability  PMBT H/m     

Permittivity  PMTT F/m     

Power  POWE kiloWatt hp watt   

Pressure  PRES pascal     

RadiationDose  RDOS sievert radd rem gray   

Radioactivity  RADY bequerel curie   

Resistivity  REST ohm/m     

RotationalStiffness  STFR N.m/rad     

SpecHeatCapacity  SHCP N/K     

SpecificEnergy  SENG J/kg     

Speed  SPEE m/s     

Stiffness  STIF N/m     
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Name of Dimension HashCode
/Word 

Database 
units 

other specific units comment 

SurfaceDensity  PSQD mm-2     

Temperature   TEMP degCelsius degF  K  degRankine   

TemperatureGradient  TPDI degC/mm     

ThermalConductivity  TCON W/m/K     

ThermalResistance  TRES K/W     

Time  TIME second min  hr  day month week year   

Torque  TORQ N.m     

UnitMass  UMAS kg/mm     

ViscosityDynamic  VISC s/Pa     

Volume  CUDI mm3 litre  ImpGallon  USGallon bbl 
Mbbl MMbbl 

  

VolumetricFlow  VFLO m3/s     

         

None NONE     numerical real attribute 

WORD  WORD     used to assign parameter 
dimensions etc. 

Parameter  UNIPAR     used for parameter 
attributes 

 

4.2.2 Other UNITS Commands 

Three additional forms of the UNITS command for the Fundamental dimensions (i.e. those 

settable) are supported – UNITS DEFAULT, UNITS NUMERIC, UNITS MKS and UNITS FPS and 

UNITS CGS. 

DEFAULT Units 

The default unit of a physical dimension is the database storage unit, which is listed in the table 

above. 

The command UNITS DEFAULT formerly set the DISTANCE default units to mm; it now sets the 

units of all the dimensioned attributes to their database storage units. Individual dimensions can be 

set to their default selectively using the command: 

UNITS DEFAULT dimension 

DERIVED Units 

The command UNITS DERIVED dimension is valid for compound dimensions such as 

volume, density and pressure.  It sets the current units for that dimension to be determined by the 

current units of its primary dimensions (most often mass and distance).   

Volumes, areas, densities, temperature gradients, and numeric densities can all be set to Derived 

units.  Only volumes can be set to specific units. 

NUMERIC Units 

All attributes that have the UNIT field set for the first time, were stored in previous versions as 

values with no specified unit. The units that were previously attributed to their values were 

determined by use and convention and could change from application to application, and project to 

project. This flexibility can no longer be supported as ‗storage units‘ must be defined. Database 

storage units have been set to those most commonly used, but this will not be universally 

compatible.  The UNITS NUMERIC command is introduced for compatibility: 

UNITS NUM/ERIC dimension 

is used to suspend unit conversions on input and output for attributes of the nominated dimension, 

that is:  
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 No conversion from the stored value will be made on output 

 No unit qualifying strings will be appended to output values  

 Input values with no qualifying unit strings will be stored without conversion in the 
database 

 If input values have a unit qualifying string, a conversion factor will be applied. 

This is of particular value to users who wish to continue storing and using attribute values as now, 

and especially when the values stored are assumed by their system to be in units that are 

DIFFERENT to those now being assumed by Hull & Outfitting. 

The system also supports UNITS NUMERIC DISTANCE for completeness. 

When a fundamental dimension‘s unit is NUMERIC, all derived dimensions that use this 

fundamental dimension will also be treated as NUMERIC. For example, setting NUMERIC MASS 

will force densities and pressures to be numeric, irrespective of the currently set distance units. 

Derived units can have their units set to NUMERIC even if their fundamental dimensions have 

units set. 

Weights and Masses 

In the past, Hull & Outfitting has not distinguished between weight and mass; this has now 

changed. Densities (mass/volume) are in Kg per cu metre and the weight of objects derived from 

this is in Kgf.   

Pressures 

Pressures are in Force per unit area. Pressure units are supported but whether the pressure is 

absolute or relative to atmospheric pressure (Gauge Pressure) is a matter for the user to determine 

when he sets values. No conversion is performed. 

4.2.3 Upgrading to use new Units 

To take advantage of the new functions, attributes need to be set to the correct dimension. This 

has been done for the standard attributes. Customers will need it to do it for their UDAs and 

catalogue and design parameters and properties. Any data imported to a Schematic database 

using Schematic Model Manager will need to have the 12.1 upgrade applied. 

It is not necessary to change all dimensions at the same time. For example, Lengths are already 

handled correctly. It is expected that angles are stored in Degrees, so they will also be handled 

correctly, but users will have to identify which UDAs are angles and set their UUNIT to ANGL.  

This will be done for a project; the administrator also needs to determine how to handle each of the 

dimensions used for other attributes – volumes, densities, pressures etc. It is possible to continue 

as before for any by using the NUMERIC option. For details, please refer to the 12.0 to 12.1 

Upgrade manual. The process for each will be: 

If all quantities have been stored in the new Database Units 

 Set the UUNIT for any UDAs 

 Any UDAs used to store the Unit values are no longer required and can be deleted 

 Any customer appware managing unit conversion or display can be removed or replaced 
by standard functions 

If all quantities have been stored in the same unit (which is not the new Database Unit) 

 Set the UUNIT for any UDAs 

 Output a datal file with the dimensions being set to numeric, e.g.  
UNITS NUMERIC TEMPERATURE 
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 Read the datal file back in with the current units set appropriately so that unqualified 

values are assumed to be in those units: UNITS DEGF TEMPERATURE 

o Any UDAs used to store the Unit values are no longer required and can be deleted 

o Any customer appware managing unit conversion or display can be removed or 
replaced by standard functions 

If quantities have been stored in mixed units with a UDA recording the unit for each 

 Set the UUNIT for any UDAs 

 Set the dimensions to numeric, e.g. UNITS NUMERIC TEMPERATURE 

 Output a file with the attribute values, with the value from the unit UDA appended 

 Check the format of the value plus unit conforms to new input format rules 

 If necessary edit the file with a text editor or script to achieve this 

 Read the file back in  

 Set current units as preferred, e.g. UNITS DEGF TEMPERATURE 

 Any UDAs used to store the Unit values are no longer required and can be deleted 

 Any customer appware managing unit conversion or display can be removed or replaced 
by standard functions 

If quantities have been stored in mixed units with ‗custom and practice‘ being the only record of the 

unit, which is hopefully rarely the case: 

 For the short-term set the dimensions to NUMERIC 

 Plan to move to more rigorous use of units, probably employing a combination of the 
techniques above 

4.2.4 Units set up for Hull and Drafting 

In AVEVA Marine Hull and Marine Drafting applications the set up for Units differs from the Units 

setup in Outfitting. 

Presentation format for Units in Hull and Drafting can be set to SI or Imperial. SI units are default. 

The format for SI and Imperial respectively can be further controlled by a set of environment 

variables and default variables. 

For details on the Units usage in Hull and Drafting, please see the following chapters in the AVEVA 

Marine User Documentation: 

1. Hull Basic Features and Concepts -> Basic Features -> Imperial Units Syntax Description 

2. Marine Drafting -> Drafting -> User Guide -> Appendices -> Drafting default file keywords -
> Unit codes 

3. Marine Drafting -> Drafting -> User Guide -> Appendices -> Drafting default file keywords -
> Unit system 

4. Hull Initial Design -> Lines – User’s Guide -> Technical reference -> Conventions -> Units 

Unit Controlled Dimensions in Hull and Drafting 

The dimensions that can be unit controlled in Hull and Marine Drafting are shown in the table 

below. 

Core units are independent of the Unit settings and are the same for Hull and Outfitting data. 
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Dimension Core unit 
  

Coordinate mm 
  

Linear measure mm 
  

Area mm
2
 

  

Volume mm
3
 

  

Weight kg 
  

Density kg/ mm
3
 

  

Angle degree 
  

 

Presentation Format for Units in Marine Applications 

Within Hull and Marine Drafting specific application functions, values will be presented according to 

the Hull/Drafting settings.  

Attributes in Hull Initial Design are presented according to Initial Design settings. 

Within general functions available in Hull Design or Marine Drafting, e.g. Reporter, Attribute addin 

or Query attribute command, values will be presented according to the Outfitting Units system. 

Within common marine applications, such as Space Management and Assembly Planning, all 

attributes will be presented according to the Outfitting Units system.   

Within Outfitting specific functions, presentation of hull attributes will follow the Outfitting Units 

system. 

Input Format for Units in Marine Applications 

In Hull and Marine Drafting applications the input format can be SI or Imperial, independent of the 

Units settings.   

Units in Marine – Upgrade and Migration 

No upgrade or unit conversion from AVEVA Marine 12.0 to 12.1 is required for Units in Hull and 

Drafting, since core units have not been changed.  

The unit settings, including the default settings, for Hull and Marine Drafting are the same in 

AVEVA Marine 12.1 as in AVEVA Marine 12.0 (and in Tribon M3).  

4.3 Enhanced Password Protection  

Password protection was made more rigorous at Hull & Outfitting 12.0.SP5. Additional checks 

have been at this release introduced to trap potential error conditions.  

A confirmation dialog, as shown below, warns if a user is created with no password:  
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A warning is also given, when using the Generate Script dialog, if the password for logging in to the 

project is not correct. An incorrect password could cause an invalid password error when the script 

is later executed. 

 

In addition to the ConfirmID(), method on the SESSION object, an analogous method has been 

added to the USER object. This method also takes a string as argument: the suggested password 

text with leading ‗/‘ character. It returns a boolean value that determines whether the password is 

correct for the specified user. Example: 

 !u = object USER(|MYUSER|) 

 if !u.ConfirmID( |/SESAME| ) then $*… 

4.4 Status Control 

A number of small improvements, which affect all constructor modules, have been made to Status 

Control. 

New pseudo-attributes STVMOD and STVUSE have been added to return the status last 

modification date and user. 

PML2 qualified attribute queries are now available for status data, for example: 

!statusDefinitions[1] = /DesignStatus 

!statusValues = !!ce.attribute('STVVAL', 

!statusDefinitions) 

A new command STM COMMENT has been added to set the status comment without modifying 

the status value. 

The Status Change Event Methods now take an array of objects as their first argument where 

previously this was a single element reference in a string. The StatusProjectHandler pml object has 

been modified accordingly and comments show where customised code can be placed. 

Customised code in the StatusProjectHandler pml object must be updated into the new version. 

Code for a single object can generally be inserted in the do loops where indicated by comments. 

The StatusData pml object has also been updated to better handle arrays of objects. It has 

additional members to hold arrays of data. The previously provided single object members have 

been maintained and hold the values of the first elements of each equivalent array at the end of 

each operation, so previously defined calling code will generally work as before. Code using the 

StatusData pml object will generally continue to work but must be tested, and reviewed to see if it 

can be made more efficient by using the array members. 

For More Information, please refer to the Status Control User Guide sections 5.1, 5.2, 8.1, and 8.3. 

4.5 Report generation  

4.5.1 New Reporting Add-in 

Hull & Outfitting 12.1 includes a new ―Reporting‖ add-in, based on the reporting tool Xtrareports 

from DevExpress. This can produce sophisticated formatted reports in a wide variety of formats 

and can also send the results to AVEVA NET via the Gateway. It is available in Design, Paragon, 
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Spooler, Draft and Isodraft, as well as in some of the Engineer product modules (Schematic Model 

Manager, Diagrams and TAGS.)  

Running existing reports should be simple. For detailed instructions on designing new reports, 

please see the new Report Designer User Guide. A chapter in that guide gives some further 

information about running reports – from the Search results grid and from Run Report: 

 

A new PML Reporting API is documented in the Software Customization Reference Manual. 

4.5.2 „Classic‟ Reporting 

The PML based reporting tool (now known as ―Standard Reporting‖) is still available as before: 

 

The reporting functions are largely unchanged; however, there are some changes due to the 

implementation of more units handling. The effect is that: 

 The units output for quantities other than distance will be the appropriate current working 
unit; distances will be given in mm unless ―inch‖ is specified   

 When Units Conversion is set to ―Off‖, quantities will have their units appended.  
In this case, distances will be in mm with ―mm‖ appended, for example a one inch distance 
will be shown as. ―25.4mm‖. When Units Conversion is set to ―Any/mm‖ or ―Inch‖, the units 
are not appended but are show as 25.4 or 1‖. 

Details are available, as before, in the Reporting Reference Manual. 

The new Report tool is available in Marine Drafting, but in Hull the reports are generated in the 

traditional way, with specific hull functions. 

4.6 GML Performance  

There are further improvements to the Geometric Modelling software used in Hull & Outfitting, 

aimed particularly at speeding up the drawing of data imported using the new Mechanical 

Equipment Interface. 
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5. Database changes 

5.1 New Database types 

5.1.1 Engineering Database  

The new ENGI database holds engineering data that does not normally appear on the schematics 

drawings. It therefore holds more detailed information necessary to fully specify the engineering 

equipment in a plant. For example, a schematic might show a pump, its name and its major 

connections – and perhaps a little more. The engineering database will include electrical data (for 

the motor, loading calculations etc), process data (the process conditions), mechanical data etc.  

These data may be owned and controlled by several different discipline engineers. This database 

will make it easy to produce lists of equipment and other tagged items. Using a separate database 

makes it simpler for the schematics and the engineering data to be compiled in parallel – and later 

checked for consistency. 

5.1.2 Design Reference Database  

This is a restricted Design database, used mainly for 

administrative purposes – it cannot include any SITE 

or HULL data. Its main use is for storing information 

about Systems and Areas for use in Engineering and 

Schematics applications.  It is therefore useful for 

users who are licensed only for 2D applications.  

It is created by setting a flag on the database when it 

is created; this is the only way to create it and the flag 

cannot be removed at a later date. 

Points to note about Design Reference databases: 

 Engineering or Schematics users can use 
them 

 They cannot be the default DB in an MDB 

 They cannot include SITEs; this also 
prevents the creation of elements below 
SITEs 

 They can include Schematic-3D link 
elements, making link information available in 
Schematics products when their users do not 
have access to normal DESI databases  
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5.2 Access to Databases  

The complete list of database types, apart from ‗system‘ types, is now: 

 Administrative: DICTIONARY, NSEQUENCE 

 Parts catalogue and material properties: CATALOGUE, PROPERTIES 

 3D Design and Drafting: DESIGN & DESIGN Reference, DRAFT (PADD), ISODRAFT 

 Schematics and Engineering: DESIGN Reference, SCHEMATIC, ENGINEERING 

In addition, MANUFACTURING and NSEQUENCE database types are primarily used by the 

Marine products.  

Access to the various types of database depends on the product and module being used as well as 

a user‘s access as determined by his team membership and any Data Access Controls in use. In 

summary: 

 All AVEVA Plant products have full read/write access to the administrative and catalogue 
data in the DICTIONARY, CATALOGUE, NSEQUENCE and PROPERTIES databases. 

 Hull & Outfitting users can read & write 3D databases; those who need to access 
Schematic or Engineering data also need a Schematic 3D Integrator license. The decision 
to work in ―Integrated‖ mode is taken when a user enters Hull & Outfitting and applies to 
the whole session.  

 Diagrams users can read & write SCHEMATICS databases; they can read but not write 3D 
databases. Diagrams users can also read (but not write) the new ENGINEERING 
database (see below). 

 Engineering users can read & write both Schematic and Engineering data; they can also 
read (but not write) 3D data. 

Existing users of Diagrams, Schematic Model Manager and Schematic 3D Integrator will require an 

updated license file. 

5.3 Increase in Number of Databases  

A larger number of databases can now be used in a project; the new limit is 250,000. New 

database numbers from 250,001 to 255,000 are reserved for AVEVA use, as well as those from 

7,001 to 8,000. 

It is now easier to avoid database number conflicts when databases are shared between projects. 

These conflicts may be avoided by creating DBRange elements to define the range of database 

numbers available for use in each of the projects. The database numbers may be between 10,000 

and 250,000; these numbers may also be used explicitly in a project that does not use DBRanges. 

A DBRange may be created in Admin under the STAT element in the SYSTEM or GLOBAL 

database and defines the start DBRBEG and end DBREND of a range of numbers. 

There is a new ―UNIQUE‖ option for the CREATE DB command to allow the user to create the next 

database in the defined range for the project; a new pseudo-attribute NXTDBU gives the next 

database number within the range. 

For full details, please refer to the Administrator User Guide and Command Reference Manual.  

5.3.1 Admin GUI  

To create a DB Range, a menu in the Settings pull down takes the user to a new form to set values 

for a DB Range. If no range already exists, this will create an unnamed DB Range and populate it 
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with the specified values; if more than one range is required for the project, these should be 

created on the command line. 

A Unique button for DB Number on the Create Database form ensures creation of a database 

within the project‘s range: see picture in section 5.1.2. 

5.4 Duplicate Names  

In general, AVEVA Marine products prevent the use of duplicate names within the current MDB. 

However, it may be desirable for Engineering or Schematics elements to use the same name as 

the 3D elements in the Design database. Hull & Outfitting 12.0 allowed name duplication between 

the DESI and the SCHE databases. 

It is now possible to create or rename an element in an Engineering (ENGI) database to have the 

same name as any element in any Schematic (SCHE), Design (DESI) or Marine Production 

(MANU) database in the current MDB. 

Similarly it is now possible to create or rename an element in any Schematic (SCHE), Design 

(DESI) or Production (MANU) database to have the same name as any element in any 

Engineering (ENGI) database in the current MDB. 

5.5 Flexibility of Data Organisation 

5.5.1 Database Views  

Database views provide a way to consolidate data from elements and attributes distributed across 

databases in an MDB. These views are set up by an administrator using the Database Views 

Editor and stored in the Lexicon (DICT) database in a ‗Database View World‘ (DBVWWL/D). Users‘ 

database views may also be saved a local settings file.  

The Editor is currently available in the Lexicon and Tags modules, under Display > Database 

Views Editor.  

A Database View uses a table to define a view of the data, which may be derived from a single or 

multiple elements. There is a row in the Database View table for each element of a particular type 

that meets the criteria defined by filters. These filters use the same concept as the search grid. If 

the criteria cannot be expressed using attribute filters, it is also possible to define an expression for 

evaluation. A row is present in the table only if all the filter criteria are met. 

This is a very powerful technique which can be used to derive data structures for a variety of 

purposes, including the new reporting function. The Excel Import/Export functions also work with 

Database Views, which are of particular importance in the integration of engineering, schematic 

and design data.  

5.5.2 Distributed Attributes  

Distributed attributes enable the definition of objects that have groups of attributes distributed 

across databases, currently restricted to the DESIgn and new ENGIneering database types. This 

enables a number of new possibilities: 

 Improved concurrency 

o Several users may work in parallel on an object, using different sets of data  

o Simultaneous multi-discipline updates on the same object are possible 

o Claims may be smaller, only claiming the relevant ―portions‖ of an object 

 Distribution of an object‘s attributes across hierarchies and databases 

o Easier distribution using Global 



AVEVA Marine 12.1       User Bulletin 

Copyright 1974 to current year. AVEVA Solutions Ltd.   28 
 

o Reduced need for Global extracts 

 Simplified access control 

o It may be sufficient to use database ownership (by teams) 

 Data may be included or excluded by database  

 Extensibility of data structures – an alternative to direct use of UDETs and UDAs 

A ‘binding’ element is used to achieve this: it may bind any number of bound elements, but these 

bound elements can only bind to one binding element. The attributes defined on the bound elements 

are then available on the binding element for both querying and manipulation. 

Details of the configuration and use of distributed attributes can be found in the Database 

Management Reference Manual and Lexicon User Guide. 

5.5.3 Handling of Duplicated Names of UDAs and UDETs  

UDA keys now take into account database number to remove the possibility of conflicts between 

UDA names in different databases. In previous versions, this could occur when merging data from 

different projects or MDBs.  

A new command in Lexicon allows a user to reallocate existing UKEY values to the new format for 

UDAs and UDETs. They can operate on either a selection of UDAs and UDETs or all in the current 

MDB. The old keys are stored in the attribute OLDKEY for reference. Admin commands allow 

update of project data to use the new keys. 

For details, please refer to the Lexicon and Admin Command Reference Manuals. 

5.5.4 Top-Level Element Creation in Specific Database 

It is now simpler to ensure that top level elements are created in a specific database; a DB 

keyword and name can be added to the NEW command: 

NEW element_type element_name DB database_name 

where element_name is also optional; database_name is a full database name, i.e. 

team/database. 

For example, this command will create a new SITE named /MYSITE in the MYTEAM/MYDB 

database: 

NEW SITE /MYSITE DB MYTEAM/MYDB 

5.6 Dynamic Groups  

A PML1 collection expression, evaluated whenever the group is used, may now be used to define 

a selection for a GPSET. The SCOSEL attribute is used to store this selection, for example:  

SCOSEL ALL EQUI FROM CLAIMLIST 

More complex dynamic selections are possible, for example: 

ALL PIPE WHERE (BORE GT 80) 

ALL BRAN MEMBERS WHERE (SPREF EQ /MYSPEC) for SITE 

/SITE1 

There is a performance overhead in evaluating more complex selection expressions.  
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5.7 Database Performance 

A number of enhancements have been made to the performance of the Dabacon database. Those 

noted here are the most visible to users. 

Dabacon Buffer 

The Dabacon buffer is used for temporary storage of data in local memory and can therefore have 

a significant effect on performance. Increasing its size is likely to reduce the amount of network I/O, 

so in generally a larger buffer will improve performance. However if it is larger than the available 

memory, paging will increase, thus offsetting some of the advantages. 

Previous versions of Hull & Outfitting 12 have limited the buffer to between 32,000 and 51,200,000 

(integers) with a default of (in general) only 12,800,000. This corresponds to a default of 50 and a 

maximum of 200 Mbytes; with modern PCs, most customers found it best to use the maximum 

value, set by use of the BUFFER command in Admin.  

These values have been increased at Hull & Outfitting 12.1; it may now be set to between 20 

Mbytes and 1 Gbyte. 

Default Buffer Size 

The default buffer for modules in a new project is now: 

Monitor  20 MBytes 

Admin, Specon, Propcon, Isodraft, 

Lexicon 

DARs, Toolbox  

200 Mbytes  

Design, Draft, Paragon, Spooler  

Diagrams, Schematic Model Manager, 

Tags 

500 Mbytes 

5.7.1 Specifying the Buffer Size 

The Dabacon buffer may be set in Admin for each module or by use of an environment variable for 

all modules.   

Buffer Setting for Each Module in a Project 

The setting for each program module is usually performed using the modmac.mac file during 

project setup. At a later date, the ED MOD command may be used to change its value for one or 

more modules.  

The value may be specified in Mbytes or integers; 256000 integers means the same as 1 MByte. 

For example, ED MOD DESIGN 12800000 is the same as ED MOD DESIGN 50 Mbytes 

Buffer Setting Per User 

The Dabacon value may be set for a particular user by setting the environment variable 

‗PDMSBUF‘ before running Hull & Outfitting. This sets the buffer size in Megabytes for use by all 

Hull & Outfitting modules; it will be ignored if its value is greater than 1000. For example, set 

PDMSBUF=500 sets it to 500 MByte. 
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Querying the Amount of Unused Buffer 

This may be queried using the command: Q DABACON AVAIL.  

5.7.2 Dabacon Index Tables  

The use of Dabacon index tables has been extended to speed up selection by Hull object type 

code, element type, UDET or UDA value.  

5.8 Units of Measure  

This enhancement enables Outfitting to store attribute data in standard units and perform 

conversions as appropriate. The system handles this automatically dependent on the units and 

also stores appropriate information with parameterised attributes to enable them to be handled. 

A new dynamic UNIPAR attribute has been added to all catalogue elements with PARA attributes – 

namely SCOM, SPRF, JOIN and FITT – and to all design elements with DESP attributes. It is a 

hidden (VISI FALSE) integer array attribute (that may not be listed or queried) and holds the set of 

WORD unit values corresponding to the dimensions of the values in a sibling PARA or DESP 

attribute.  

5.9 Unicode Storage of Name and Text Attributes 

Marine Outfitting and Marine Drafting code will handle Unicode strings. Administrators may have 

chosen to convert all DBs which do not contain Hull data to Unicode as part of their upgrade 

process, or may decide for each DB whether and when to upgrade manually, and perform this 

upgrade using Reconfigure as in the example above.  

5.10 DRAFT Line-style World Hierarchy 

System line-style widths are now stored in the system database, for consistency throughout a 

project, and are initially set to ISO defaults: Thin=0.25mm, Medium=0.35mm, Thick=0.70mm. See 

also  

5.11 Extract Control – Include Flush Capability  

Enhancements have been made to Extract Control in the Design/Engineer modules Design, 

Diagrams and Schematic Model Manager. When working in an extract database, issuing, flushing 

or dropping an element that has a referencing Integrator link will automatically include the link 

object. 

The new reference array attribute INCFLU (include flush) returns any Integrator or Status link 

elements that reference the current element. Flushing, issuing or dropping an element with 

referencing link objects will act on those link objects even if the element itself is not claimed or 

modified. The Extract Control form will display an ―R‖ label on such elements. 
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6. User Interface 

6.1 Entry to System 

Entry to the system has been changed to allow direct entry to any module, without the need to go 

via Monitor. The login form is presented with the appropriate splash screen. Desktop and Start 

menu shortcuts are provided for the popular options. 

A new checkbox, labelled ―Integrated Schematics and Engineering‖, determines whether or not the 

Hull & Outfitting user will also have read access to the SCHEmatic and ENGIneering databases.  

This option is relevant to customers who also use one of AVEVA‘s 2D products, AVEVA Diagrams 

or AVEVA Engineering. Checking this option allows users to access to these data and is necessary 

in order to use the Schematic Integrator Addin during the session. 

 

Note: The console window may be suppressed by using a –noconsole argument to the start-up 

script. It may also be controlled using an environment variable: if you wish to run the system with 

the console hidden, use: 

set AVEVA_NOCONSOLE=TRUE 

6.2 Save and Restore Views This new feature allows a user to take a 

snapshot of a view and save it to file. The saved view can be reinstated when required, including a 

new session of Hull & Outfitting. A saved view consists of three elements: 

 The current drawlist 

 View properties (e.g. view direction) 

 A snapshot picture of the view when it was saved 

When selecting which view to restore, the snapshot picture is shown to help identify the correct 

view. Note that this snapshot is just a picture captured at the time the view was saved. Elements in 

that picture may have been modified or deleted since the picture was saved, so when the view may 

look different once it is restored. In fact, it is possible that an empty view may appear if all elements 

in the drawlist have been deleted or moved outside the view area since the original view was 

saved. 
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The Save & Restore 3D Views function is accessed via a new icon on the 3D View: 

The old numbered saved views are no longer available. 

For details, please refer to the Graphical Model Manipulation Guide. 

6.3 Grid Control 

A number of enhancements have been made to the grid control. These include an enhanced 

column setup form, a new filter on the row filter, an autofit function and an ability to copy a set of 

grid cells and paste them into another document. In addition, Drag and Drop may be used in the 

grid for some operations. The Grid Control has also been enhanced to support multi-element and 

distributed attribute editing using Database Views. 

6.4 Toolbar Popup Menu 

The popup context menu displayed from the Toolbar area has a new entry Lock the Toolbars. 

This enables users to lock the position of the toolbars to prevent accidental change of layout. 

6.5 PML Collections  

A PML Collection with unlimited scope now collects data from the entire database; in other words, 

an empty scope now means ALL rather than NONE. [This means that the collection operation will 

take much longer, so it may be worth checking any PML functions to ensure that this is what is 

required.] 

6.6 Attribute Display, Editing and Validation  

A new Attributes Utility replaces the previous Query Attributes and Attributes forms; it combines the 

functions of both and also enables attributes to be edited if access rights permit.  Attributes that are 

not editable are shown with a grey background; feedback is given for inappropriate attribute 

values. The form displays the attributes of the current database element either in a list or by 

category: see pictures below. 

The form allows the user to edit attributes, where appropriate, and is available in all modules. It 

replaces the old PML Query Attributes form and the old C# Attributes form. 

The popup menu provides various new functions such as an ability to set the current element to a 

reference attribute value. The details vary between modules and are documented in the 

appropriate manuals. 
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Attributes displayed in a list     Attributes displayed by Category 

6.7 Auto-naming Utility Enhancement  

This utility has been enhanced to allow the formulation of a name to use an IFTRUE statement, 

which is a PML1 facility. For example, if you wish to make up a name based on attributes of a 

PIPE, you can use the following PML2  autonaming rule: 

!!ce.fluref.namn & '-' & !!ce.pspec.namn & '-' & !!ce.ispec.namn & 

'-' & !index 

However this rule will fail if any of the attributes (FLUREF, PSPE, ISPE) have not been set. You 

can now use the IFTRUE function in PML1 form to do the same by using the following rule: 

iftrue(badref(fluref) ,'unset' , namn of fluref) & '-' &  

iftrue(badref(pspec) ,'unset' , namn of pspe) & '-' &  

iftrue(badref(ispe) ,'unset' , namn of ispe) & '-' & !index 

Please note that the whole ‗Format‘ must be PML 1, concatenated with the ‗&‘. It is not possible to 

mix PML1 and PML2 functions. The result of this rule can be seen below: 
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The FLUREF and ISPE have not been set but the PSPE is set to /A3B, so the resultant name is 

unset-A3B-unset-1.  

6.8 Additional Debug Information about PML 
Applications  

6.8.1 Help About  

A new button has been added to the Help About > Additional Information dialog, with a new 

option to scan all Application Appware files to check if they have been changed. 

 

 

6.8.2 PML Alert  
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An additional button has been added to the PML alert dialog to allow extra information relevant to 

the alert to be saved to file. Clicking the Save Support Info… button will bring-up a save file dialog 

and allow the user to save the extended information: 

 

6.9 Infragistics Toolkit 

Hull & Outfitting 12.1 uses an updated Infragistics Netadvantage toolkit (version 10.3) for its GUI. 

The filenames of the Infragistics DLLs no longer include the version number, which will make future 

upgrades easier. 
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7. Administration 

7.1 GUI Improvements  

A number of features have been added to the GUI to improve its ease of use and make it more 

consistent with other modules. For example: 

Import from Excel  

Data for Admin elements such as users, teams etc may now be imported reliably from Excel. This 

has resulted in three changes in behaviour: 

 Access Control Assistant (ACA) is no longer hidden during Import and Rollback 
operations. 

 The Export and Import logging dialog no longer has a Cancel button; it is also less 
responsive to Window operations such as move or resize, while export or import 
operations are in progress. 

 The Export and Import logging dialog "OK" button has been renamed "Dismiss". 

For details, please refer to the Admin User Guide. 

For full details of the various different types of view, please refer to the Lexicon User Guide. 

7.2 Lexicon  

7.2.1 New Lexicon Graphical View  

A new user interface can show a graphic representation of the relationships between Lexicon data 

entities, using nodes and links, in the style of UML and entity relationship diagrams. 

There is a series of graphical views, which are shown on separate tabbed panes in the Lexicon 

User Interface. There are 4 types of view, showing UDAs, UDETs, status definitions and distributed 

attributes. Each view tab is opened by selecting the ‗Graphical View‘ menu option during a ‗right-

click‘ on an element of a supported type in the Lexicon explorer. 

The picture below shows a screenshot of Lexicon with the new Graphical View on the right, side-

by-side with the Dictionary Explorer and Current Element Editor. Individual views are associated 

with a single database element. To open a view, select the element of interest in the explorer and 

click the context menu. Each view opens in a separate tab, whose title reflects the name of the 

element for which it was opened. 
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7.2.2 UDA Lists of Values  

User-Defined Attributes (UDAs) and User System Defined Attributes (USDAs) can have a list of 

valid values (for text attributes) or a list of valid ranges (for numeric attributes). These lists are 

checked when setting the UDA to prevent the use of values outside the valid range.  

A new logical attribute on UDA and USDA elements determines whether the valid values or ranges 

(if such exist) are optional. The default behaviour remains that the restrictions remain non-optional. 

If, however, this attribute is set TRUE and the UDA or USDA definition is re-compiled, it will be 

possible to override the restriction and set the attribute to a value outside the valid range.  

To support this, a new method has been added to PML2 Attribute object and .NET public interface. 

The new method LIMITSVALIDOPTIONAL(ELEMENTTYPE) complements the existing 

LIMITS(ELEMENTTYPE) and VALIDVALUES(ELEMENTTYPE) methods. 

The .NET database interface class for attributes, Aveva.Pdms.Database.DbAttribute 

has a new method to determine whether the valid values or range is optional for a particular 

element type: 

public abstract bool IsAllowedOptional(DbElementType type); 

7.2.3 Database Views  

A Database View defines a table for viewing manipulating data in the database; these data may be 

derived from a single element or multiple elements.  There is a row in the Database View table for 

each element that has a particular element type and meets the criteria defined by attribute filters. 

These Filters are similar in concept to those in the search grid. In addition, if element match criteria 

cannot be expressed using attribute filters, it is possible to define an expression for evaluation.  

For example, a Database View could be derived from all Equipment elements in the current MDB 

with a description of ‗Vessel‘. The user also specifies the required columns; each can be a 
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database attribute or an expression run against the equipment element. The user can also specify 

how to navigate to related elements, such as the owning SITE or ZONE, and derive further 

columns from that element. This is similar in concept to a saved search except that editable 

columns may be derived from several elements.  

Database Views may be defined and modified in the DICTIONARY database using Lexicon to set 

up new elements in a new ‗Database View World‘ (DBVWWL/D). Their definition may alternatively 

be stored as a local settings file (similar to saved searches) or as part of an application. This 

allows: 

 User defined Database Views for reports, ad-hoc working etc. 

 Project defined Database Views, shared via Global  

 Application defined Database Views for specialist applications  

The Editor is currently available in the LEXICON and TAGS modules, under Display > Database 

Views Editor.  

 

Access to the full Editor is gained by selecting Element Views from the dropdown list in the View 

Definition Set area. For details, please refer to the Tags User Guide. 

Database Views are created automatically to represent element type structures so that users don‘t 

have to define them to make element information accessible to the generic reporting tool.  This 

means there is already a Database View for equipment elements with their attributes defined in 

columns. 

7.2.4 General  

The User Interface has been changed to help with maintenance and improve consistency.  In 

particular the following have changed: 

 New menu on the menu bar 

 Explorer right click menu (now consistent with other modules) 

 Edit Members on the Explorer menu  

 New element types, which have changed the contents of the Explorer, Current Element 
editor and ElementType editor. 
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7.3 Admin GUI Changes for Global 

7.3.1 Global Support for Linked Documents 

Global has been extended to include support for linked documents by propagating any document 

marked as ‘propagating’ between two locations. By default the propagation of Linked documents is 

disabled. To enable the propagation of Linked Documents switch on the ‘Propagate Link 

Documents’ setting under the ‘Project’ menu in Admin: 

 

Note: Link Documents are only available in DESI databases 

Link Document Propagation can be enabled on the command line by setting the GLINKP attribute 

on the GLOCWL (/*GL) element. The default is false indicating that Link propagation is disabled for 

the project.  

To determine which documents require propagation the update process must scan applicable 

databases. As this has a performance impact on the overall time for updates, the administrator can 

select which databases to scan. By default all DESI databases will be scanned for Link documents. 

It is possible to disable Link Documents propagation for a single database via the 

CREATE/MODIFY Database form by deselecting the Link Documents tick box: 
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Note: The linked Document tickbox is only available for DESI databases;  

this option is not available for other types of databases. 

The DBLOC element for the Database contains the attribute NOLNKP to determine whether the 

database should be scanned for link documents. This defaults to False indicating that links will be 

propagated if enabled. To determine if a Database can support Link Documents the attribute 

ISLNKD can be queried. The attribute DBLNKP can be queried to determine if the update process 

will scan this database for link documents.  

The Global update process will scan all relevant databases to determine what linked documents to 

propagate to the remote location. Link Documents are applied to the database through the creation 

if a LNDESC element. The scan will select all link documents that have the LNKPRP attribute set to 

SEND. The document is referenced via the URL link which must have the format 

‘file:///<pathname>’; The file specified by <pathname> must exist at both the source and 

destination locations. Usually this is best achieved using an Environment variable to hide 

installation differences. Link Documents fully support the use of spaces in path/filenames. 

The Update process only propagates documents that are not present at the remote location. It 

does not support documents that have changed and as a result these will not be propagated over 

the top of the previous version. However, it is possible to force the propagation of link documents 

by using the following command in Admin:- 

SYNCHR <dbname> LINKDOC FORCE 

Note: There is no UI to support this command 

On allocation of a new database, the propagation of all link relevant documents will be forced to 

the remote location. Recover will force the propagation of all relevant linked documents in the 

direction of the recover. Therefore if recovering a database back to the primary location then the 

linked documents will also be recovered back to the primary location.  
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Note: The originating location of a document referenced by an extract hierarchy may be 

unclear. For this reason RECOVER and the FORCE option of SYNCHRONISE should be 

used with caution for extracts. 

Progress and State (Success/Failure) of linked document propagation is recorded in the 

transaction database  

Limitations 

When creating a new location with allocated databases the linked documents will not be 

transferred. These will require a forced Synchronisation after the location has been configured and 

initialised. 

Global does not delete linked documents at the remote location when the linked document has 

been marked with LNKPRP DELE.  

Offline transfer is not supported. 

Linked documents propagation does not guarantee consistency between files at different locations. 

In particular:- 

 Linked documents functionality is primarily intended for files which are part of the data 
model, such as PDF Plotfiles, and certain Marine files; 

 Linked documents are not definitely linked to the database which references them. It is 
therefore difficult to track such documents once the link description is no longer available. 

 Likewise linked documents may be referenced multiple times. This will be the norm for 
extract databases. This makes it difficult to identify the primary location of a document. 

 It is possible to reference Linked documents for other data types of documents, such as 
Word documents and Excel spreadsheets; 

 It is possible for users to change documents at the destination location; this will lead to an 
inconsistency between locations. The update process does not detect this. 

 Behaviour for extract hierarchies may not be as expected. For this reason the FORCE 
option should be used with caution on databases in an extract hierarchy, since it could 
overwrite the wrong version of the file. 

 No documents are deleted when a database is de-allocated. For this reason ALLOCATE 
will always overwrite any pre-existing files. 

 There is a strong likelihood that ‗orphan‘ linked documents will be left behind after 
databases have been merged, backtracked, de-allocated or deleted. 

7.3.2 Database Distribution Form  

This new form helps visualise where databases are allocated, and which location databases are 

primary. This form provides additional functionality to change the primary location of a series of 

databases. It is available from the Data menu in Admin:- 
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The Data Distribution form lists all Databases in the project and maps it against a matrix of 

locations. This uses the common symbols of:- 

‘+’ indicates the database is primary at this location 

 ‘-‘ indicates the database is allocated to this location but is primary elsewhere 

‘>’ indicates the database is in transit from this location under a pending transaction 

‘*’ indicates the database is foreign and allocated to this location 

 

 

By selecting a number of databases and a location, it is possible to change all those databases to 

be primary to the selected location. 
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7.3.3 Creation of an Event without Times  

The Update event form will now allow the creation of an event without times, to run scripts at the 

remote location. To do this, create an update event at the current location with the Frequency text 

box left blank, and the Transfer Scripts text boxes filled in. When an update occurs between A and 

B, the scripts will be run at B. The arguments will be reversed (B, A). 

For details, please refer to the AVEVA Global User Guide Section 4.12 Creating Update Events wrt 

Transfer Scripts. 

7.3.4 Remote File Details in Admin  

When querying remote file details at different locations to compare them, the results for the 

different queries are available. Each press of the Apply button appends the results to the list on the 

right of the form. This means you can choose different locations and see the information for 

selected databases together in the list.  

Press the Clear button to empty the results list. Results can be stored in a file by pressing the Save 

Report button which will display a file browser for you to save the results into a text file.  

For details, please refer to the AVEVA Global User Guide. 

Satellite Commands filter for Transactions 

The Transactions form display can now be filtered so that only Global commands are listed. Global 

commands are defined as those that take place via the Global daemon (i.e. not locally), For 

example, an Extract claim made when an owning extract database is NOT at the same location.  

For details, please refer to the AVEVA Global User Guide. 
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7.3.5 Enhanced User Interface for Sessions 

Forms that display details of a database session now also include the reason for that the session. 

In particular, the DB sessions form, available from Query > Project > DB Sessions, shows it thus: 

 

7.4 Engineering (ENGI) Database 

The Engineering database type has been added to the list for database creation. Note that the top 

level database element for Engineering databases is SATWLD.  

It has also been added to the module definitions (modmac.mac) and as appropriate in the other 

admin and global forms for selection, sorting, allocation etc.  

7.5 TAGS Module Definition 

The new TAGS module has been added to the product modules defined by modmac.mac and 

therefore available for use. 
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8. Introduction to New Functionality 

This bulletin describes the new and enhanced functionality available in AVEVA Hull and Outfitting 

12.1 as compared to 12.0. It gives an overview of the major changes, which are described in full in 

new and revised User Documentation.  
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9. AVEVA General Functionality 

9.1 Performance Improvements in AVEVA Marine 

Description 

A number of improvements have been made to speed of functions and usability AVEVA Marine. 

 In start-up of AVEVA Marine, the loading of Dll‘s have been improved to take less time. 

 Many of the Addins will be loaded but they are only notifying the main process that 
they exists. Data load by an Addin, will take place when needed. 

 New indexes are introduced in the database to speed up searching of different Marine 
objects such as panels, profiles, plate and profile parts, nesting‘s. 
For example: 

 List Drawings 

 Auto scale of drawing 

 Create Symbolic View 

 Recreate Symbolic View 

 Input Model 

 Schema run 

 Automatic Creation of Planar Parts (PPanparts) 

 Automatic Creation of Curved Parts (CPanparts) 

 Open Nest 

 Part Menu 

 Selected forms have changed behaviour to remember more information, for example 

 Planar Hull Statement Wizard 

 Boundary to remember last used point mode 

 Stiffener to remember type, connection and endcut codes 

 Flange to remember type, connection and endcut codes 

 The reading of large objects from the database over a high latency network has been 
improved. 

Work in this important area is on-going. 
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9.2 SetStart Method of NameSeq Object 

Description 

The NameSeq object that can be used to make user defined name sequences working with data in 

an NSEQ database has been extended with new methods. Earlier the SetStart method made a 

name sequence to start over from a specified value. Now it is possible to store a specific start 

value for a sequence by the SetStart method (which no longer restarts a sequence). By a new 

ReStart method a name sequence can be restarted from the stored initial value. Name sequences 

with wraparound, will automatically restart by the initial value when required. 

Benefits 

Handle wraparounds and name sequence restarts from specified initial value.   

Compatibility Constraints 

To store an initial value other than zero upgrade of NSEQ dbs is required. 

For More Information 

Only noted here. 

Affected Programs 

Curved Hull Design and any customisation using NSEQ dbs. 
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9.3 BLOCK Creation in Specific Database 

Description 

There is a new PML function available for creating BLOCKs in specific databases.  

 

!!HullNewBlock(!blkName is STRING, !dbName is STRING) is DBREF 

 

The parameter blkName is the name of the new block and it is mandatory. 

The parameter dbName is the name of the new block and it is optional (needs to be passed as 

space, i.e. ‗‘). 

The function returns the DBREF to the newly created BLOCK element if successful. Otherwise an 

error message is issued and the function result is undefined. 

 

Example: 

 

!blk = !!HullNewBlock(‘MYBLOCK’, ‘MYTEAM/MYDB’)  

 

That statement will create a new block, MYBLOCK, in the database MYTEAM/MYDB. 

 

!blk = !!HullNewBlock(‘MYBLOCK’, ‘/MYHBLWLD’)  

 

That statement will create a new block, MYBLOCK, under the existing HBLWLD /MYHBLWLD. 

 

Benefits 

The new PML function makes it possible to create Hull Blocks without using DBPrompt.  

Compatibility Constraints 

None. 

For More Information 

See User Guide Hull in Dabacon / Marine Project Setup – Getting Started / Create Initial Data 

Structures. 

Affected Programs 

 Hull Design  
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9.4 Stable Identification of Un-named Hull Elements 

Description 

When the name of an unnamed element is displayed, it is composed by its type and member 

position. 

 

TYPE n of … 

 

The n is its numbered position in the list of its owner, only counting elements of the same type. 

Some types of elements are possibly better identified by the value of an attribute than by its 

position among its equal type of siblings. For some marine hull type of elements this is just the 

case.The name of an unnamed element is normally presented in the format: 

 

HSTIFF 3 of HPANEL /ER2-LP32_2 

 

While it onwards instead will be presented in the format 

 

HSTIFF idsp 6003 of HPANEL /ER2-LP32_2 

 

The value 6003 is provided by the TBID attribute for the HSTIFF element. Hull elements with a 

TBID attribute will be presented in this format. 

Command graphs are adjusted so that the same format can be used as input by user to change 

position in the element hierarchy.  

Benefits 

More stable identification of unnamed hull elements. 

Compatibility Constraints 

None. 

For More Information 

Refer to Design Reference Manual / How to Use the Syntax Graphs / Standard Syntax Graphs / 

Design Element Identity <gid> and User Guide Hull in Dabacon / General / Identification of 

Unnamed Elements. 

Affected Programs 

This is a core change that affects all programs exploring hull data. 
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9.5 New Storage Model for Hull Objects 

Description 

The underlying Hull objects (i.e. OBJHD) are stored in a more efficient way in the database. 

Benefits 

Performance in terms of read/write I/O; and less space consumed in the database. I/O reductions 

on up to 40 percent can be achieved. 

Compatibility Constraints 

None. 

For More Information 

See the upgrade documentation for details on how to optionally convert object into new storage 

model. 

Affected Programs 

HullDesign, HullDrafting 
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9.6 Hull Specific Design Explorer Configuration 

Description 

The Design Explorer is configured to expose an additional name for hull part nodes. Beside the 

name derived from the FLNM attribute hull parts are presented by a second name derived from the 

PARNAM attribute. If the environment variable MARINE_DESIGN_EXPLORER_PLAIN is assigned 

any value the additional name presentation is switched off. 

Benefits 

None. 

Compatibility Constraints 

None. 

For More Information 

Only noted here. 

Affected Programs 

Hull Design, Outfitting Design, Marine Drafting 
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9.7 Limited Unicode Support in Hull Design 

Description 

Even if a project is in Unicode mode the same restrictions on allowed characters in the names of 

objects created using Hull Design still apply. 

I.e. only uppercase letters A-Z, digits and the special characters hyphen (-), full stop (.), underscore 

(_) and plus (+) can be used. 

 

A B C D E F G H I J K L M N O P Q R S T U V W X Y Z 0 1 2 3 4 5 6 7 8 9 - . _ + 
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9.8 Improved Local Language – Unicode Encoding 

A major internal change at Hull & Outfitting 12.1 is that the system uses the Unicode standard for 

text storage and manipulation, rather than the various specific and somewhat proprietary methods 

that are used in Hull & Outfitting 12.0 and earlier releases. This standard covers all common world 

languages – and special characters – and will make it much easier to provide support for additional 

character sets in the future. It makes text handling more robust and makes it much easier to relax 

some of the previous restrictions, particularly to the use of Asian 16-bit character sets. For 

example, these may now be viewed in the 3D views. Inputs and outputs may be in Unicode or local 

standards.  
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9.9 Units of Measure – Extended Range of Conversions 

Hull & Outfitting has always provided conversions for distance and (pipe) bore measurements, to 

cater for the use of both Metric and Imperial (English) units. This has allowed users to work with 

feet and inch input & output, but with database storage always in millimetres. Area and volume 

units have been derived from the length units. Other physical quantities have been handled as 

purely numeric and have had no conversions applied to them. 

Hull & Outfitting 12.1 extends these facilities to a much wider range of measures, and includes 

built-in definitions and conversion factors for a wide variety of units of measure, with standardised 

storage and efficient conversion.  

These extensions are needed to provide for the much wider range of data now being handled, 

particularly for plant engineering and schematic data. These data now include Distance, Bore, 

Area, Volume, Angle, Weight, Temperature, Density, Pressure, Force, Voltage, Current, 

Impedance, and many others. 

Please note that this does mean that the behaviour of some real attributes is different; users‘ PML 

applications that check or manipulate these values will need to be reviewed.  
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9.10 Extract Claims in Hull Applications 

Description 

Hull object locking (claiming) and releasing in extracts has been improved. When working in 

extracts, it is no longer a requirement to make explicit extract claims of hull objects before making 

modifications to them. I.e. when modifying a hull object, e.g. a planar panel, in an extract, the 

application will implicitly try to claim the object to the extract. 

Benefits 

Hull user does not need to make explicit extract claims. 

Compatibility constraints 

None 

For more information 

Only noted here 

Affected programs 

Hull Design applications 
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9.11 Documentation  

A great many changes have been made to the documentation set for Hull and Outfitting 12.1, with 

all manuals updated. 

Notable improvements to the documentation set include: 

 A new 12.0 to 12.1 Upgrade manual  

 Manuals for new functions and products: Design Reuse, Space Management, Surface 
Manager, Report Designer, Tags, Isometric ADP 

 Major update for Lexicon manual 

 A new section on Event Driven Graphics in the Software Customisation Reference Manual 

 

A new index page gives access to the online help system, which may also be accessed direct from 

the system using <F1> as usual.  

 

 

 

It should be noted that the PDF manuals are no longer supplied separately but may be obtained 

from the on-line help by clicking on entry to any manual. 
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10. AVEVA Initial Design 

10.1 Lines - New Grid in PACE 

Description 

To improve the usability of the grid used in PACE, the way the grid is displayed has changed from 

a graph paper like grid to a less intrusive intersection point based grid. The rulers have been made 

more distinct and locked to the sides of the viewport. The coordinate axis are also displayed. 

 

 

 

Benefits 

A less intrusive grid and more distinct rulers make it easier to work when geometry and grid 

coincide. 
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Compatibility Constraints 

None 

For More Information 

Only noted here. 

Affected Programs  

AVEVA Marine Lines 
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10.2 Lines - Individual Tuft Size in Views in PACE 

Description 

It is now possible to have different size of tufts in individual views in PACE. 

Benefits 

This makes fairing easier when the scale difference is large between individual views. 

Compatibility Constraints 

None 

For More Information 

See User Guide Initial Design / Lines / Screen Based Reference Guide / Patch and Curve Editor / 

Graphics View Control. 

Affected Programs  

AVEVA Marine Lines 
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10.3 Lines - Macro Editor in PACE 

Description 

The Lines macro editor is now available in PACE, and can be used in a similar fashion as in Lines. 

Recording of macros however should be avoided as not all PACE actions will generate 

corresponding macro commands. 

Benefits 

There is now a possibility to run macros without interaction, without having to switch to Lines. 

Compatibility Constraints 

None. 

For More Information 

Only noted here. 

Affected Programs  

AVEVA Marine Lines. 
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10.4 Lines - Clines Project Limits (PMB and Mid Ships) 

Description 

Cline projection limits have been extended to include a general Midbody limit. In this way, giving 

e.g. the upper limit as Midbody, a pline would stop at either the FOS, FOB or PMB Aft curve, 

whichever is the aft most point.  

  

 

 

Benefits 

The parallel surface limit can be automatically set for curves which has a Cline as source. 

Compatibility Constraints 

None 

For More Information 

Only noted her. 

Affected Programs  

AVEVA Marine Lines 
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10.5 Lines - Curve Highlighting 

Description 

An enhancement to the highlighting of the current curve has been implemented in the curve grid. 

The currently selected curve from the Curve tree view is now highlighted in the curves grid. 

Selecting a curve in a graphical view will also scroll into view and highlight the corresponding curve 

in the curve grid. 

 

 

 

Benefits 

It is more apparent which curve is currently selected 

Compatibility Constraints 

None 

For More Information 

Only noted here. 

Affected Programs  

AVEVA Marine Lines 
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10.6 Lines - Locking and Fitting to a Plane 

Description 

Curves can now be fitted and locked to arbitrary planes. Curves lying in the principal planes (for 

example boundary curves) are already locked and fitted, and as such the items below are not 

applicable. For both locking and fitting, specification of the plane for the curve can be done in two 

ways – either using automatically determined points, or manually via selected points. 

 

 

 

Benefits 

Easier fairing and manipulation of planar curves not lying in a principal plane. 

Compatibility Constraints 

None 

For More Information 

Only noted here. 

Affected Programs  

AVEVA Marine Lines 
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10.7 Lines - Curve Interrogation 

Description 

Coordinates and angles at X/Y/Z values can be examined for a curve. The function is activated by 

the right mouse button and values are shown on the output window. 

 

 

 

Benefits 

Coordinates can be derived for inserting a point into a curve  

Compatibility Constraints 

None 

For More Information 

Only noted here. 

Affected Programs  

AVEVA Marine Lines 
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10.8 Lines – Angle Curve Creation/Editing 

Description 

It is now possible to create and manipulate angle curves in PACE. The angle curves can be set 

active as other curves and are visually superimposed on the existing orthogonal and oblique views. 

They can therefore be changed graphically or edited by changing the values in the Data Point grid. 

 

 

 

The angle curves can be created by function Curve, Create Angle Curve and the angle coordinates 

are put by means of the dialog box.  

 

 

 

Benefits 

The angle curves can more easily be changed in PACE. 

Compatibility Constraints 

None 
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For More Information 

Only noted here. 

Affected Programs  

AVEVA Marine Lines 
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10.9 Lines - User Local View 

Description 

An oblique local view based either on a locked curve or on a user specified coordinate system can 

be created. The view context menu in an oblique view contains the items ―Local (specified axes)…‖ 

and ―Local (from selected curve)‖.  The second option is available when a curve locked in an 

arbitrary plane is selected. The first option is always available. 

From selected curve 

When available, selecting this option will switch the view to an oblique view with a local coordinate 

system defined by the plane of the selected curve. The title bar will change to reflect the curve on 

which the view is based, and the axes it is defined by. 

Specified axes 

 

 

 

Selecting this option will provide a dialog where an arbitrary Cartesian coordinate system can be 

specified. The user entered coordinates are normalized and adjusted to ensure the axes are 

orthogonal. To ensure a right handed system is defined, the z axis may require negation. If the 

user coordinates can be used to form a system, the resulting system is displayed as edits are 

made. Clicking ok will switch the view to one defined by the calculated axes. 

Benefits 

Makes definition and fairing of planar curves easier when they are not located in a principal plane. 

Compatibility Constraints 

None 

For More Information 
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Only noted here. 

Affected Programs  

AVEVA Marine Lines 
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10.10 Corrugated RSOs 

Description 

Corrugated bulkheads with stools created in Surface & Compartment, using the Corrugation or 

Stool tab in the Internal Surfaces dialog, now has an extended representation which closes the 

design loop between Surface & Compartment and Structural Design for these RSOs. 

As previous a parametrically defined bulkhead will be stored in the model, but along side it a 

geometric identical copy will be stored, but instead of the parametric definition it will be defined by 

using sheer and camber curves. In this new representation the stools and corrugation are 

individual entities. These new entities will be possible to edit in the same way a knuckled bulkhead 

is today.  

The above allows for creation of corrugated bulkheads with stools in Surface & Compartment, 

releasing them to design, further editing with Structural Design tools and updating Surface & 

Compartment with the changes via the ―Use Design‖ function. 

Benefits 

Enables RSO modelling to be made in a more flexible way 

Compatibility Constraints 

None 

For More Information 

Only noted here. 

Affected Programs  

AVEVA Marine Geometry. 
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10.11 Compartment Export/Import in XML Format 

Description 

A new open XML-based format is introduced to support import/export of compartments. The format 

covers compartment definition and content data as well as category information. 

The export and import functionality is accessed through added functionality in the ―File – Export‖ 

and ―File – Import‖ functions. 

Benefits 

Open format for describing compartments. 

Compatibility Constraints 

None. 

For More Information 

See User Guide Hull Structural Design / Functions Overview / Functions in the XML Menu. 

Affected Programs  

AVEVA Marine Geometry 
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10.12 Release of Weights to Calc 

Description 

The default settings for releasing weight of objects to the Hydrostatics and Hydrodynamics 

application have been changed. Previously the default was to release the weight. This will now be 

set to off. As before the setting of this is done in the weight analysis dialog, 

Benefits 

Ease of use. 

Compatibility Constraints 

None. 

For More Information 

Only noted here. 

Affected Programs  

AVEVA Marine Surface & Compartment 
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10.13 Axis Setting Reflected in Dialogs 

Description 

In Hydrostatics/Hydrodynamics it has been possible to set the direction of the x-axis and y-axis to 

be used in reports. This setting is now also reflected in dialogs in Hydrostatics/Hydrodynamics 

application. 

Benefits 

Ease of use. 

Compatibility Constraints 

None. 

For More Information 

Only noted here. 

Affected Programs  

AVEVA Marine Hydrostatics  

AVEVA Marine Hydrodynamics 
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10.14 Sea Water Density 

Description 

A different sea water density can now be specified for each Loading Condition. The sea water 

density is entered on the Options page of the Loading Condition dialog. 

Benefits 

Ease of use. 

Compatibility Constraints 

None. 

For More Information 

Only noted here. 

Affected Programs  

AVEVA Marine Hydrostatics and Hydrodynamics 
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10.15 Multiple Lightship Weights 

Description 

Hydrostatics/Hydrodynamics can now handle alternative lightweights. More than one Lightweight 

module can be created in the General Particulars folder. A combo box for selecting which 

lightweight to use, has been added to the Loading module dialog. The Deterministic, Loading 

Sequence and Summary Table modules have also been updated to handle multiple lightweights. 

Benefits 

Ease of use. 

Compatibility Constraints 

None. 

For More Information 

Only noted here. 

Affected Programs  

AVEVA Marine Hydrostatics and Hydrodynamics 
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10.16 Oil Outflow 

Description 

A new Oil Outflow module has been added to the Regulations folder. This calculates the oil outflow 

performance according to MARPOL Regulation 12A p11 concerning the probability of oil outflow 

from damaged fuel tanks. 

Benefits 

Ensures compliance with the statutory regulations. 

Compatibility Constraints 

None. 

For More Information 

See User Guide Initial Design / Hydrostatics / Major Tasks / Regulations / Oil Fuel Outflow. 

Affected Programs  

AVEVA Marine Hydrostatics 
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10.17 Inclining Experiment 

Description 

The Inclining module In Hydrostatics/Hydrodynamics has been corrected and revised according to 

comments received from users. The calculations and output should now fully comply with statutory 

requirements. 

Benefits 

Ensures compliance with the statutory regulations. 

Compatibility Constraints 

None. 

For More Information 

Only noted here. 

Affected Programs  

AVEVA Marine Hydrostatics and Hydrodynamics 
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10.18 Probabilistic Stability to SOLAS 2009 Rules 

Description 

The Probabilistic Stability module In Hydrostatics/Hydrodynamics has been updated to include the 

latest 2009 SOLAS cargo/passenger ship rules. The damage case generation algorithm for multi-

zone damage has also been revised to bring it in line with the recommended interpretation of the 

rules. 

The implementation also provides for different damage permeabilities for different loading 

conditions, as specified in the rules. 

Benefits 

Ensures compliance with the latest statutory regulations.  

Compatibility Constraints 

None. 

For More Information 

See User Guide Initial Design / Hydrostatics / Major Tasks / Probabilistic Stability. 

Affected Programs  

AVEVA Marine Hydrostatics and Hydrodynamics 
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10.19 Damage Case Summary Table 

Description 

A summary of damage cases is now included in the loading condition intact condition report. The 

table is included by default, but there is an option for turning it off.  

Benefits 

A concise way of reporting damage case results. 

Compatibility Constraints 

None. 

For More Information 

See User Guide Initial Design / Hydrostatics / Operator’s Instructions / Calculations / Stability 

Calculations / Damage Scenarios. 

Affected Programs  

AVEVA Marine Hydrostatics and Hydrodynamics 
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10.20 MODU Wind Heeling Moments 

Description 

The IMO Mobile Offshore Drilling Unit method of calculating the wind force and moment on the 

structure, has been implemented. To use this feature, all exposed above and under water 

elements, must be defined as compartments and assigned to a special category with an identifier, 

SL, and name, Sail. The program assumes that the specified Structural permeability is the Shape 

Factor for these elements. Also the wind moment must be set to the MODU wind moment, in the 

Criteria file.  

Benefits 

Allows stability assessment for MODU's.. 

Compatibility Constraints 

None. 

For More Information 

See User Guide Initial Design / Hydrostatics / Major Tasks / Rig Wind Heeling Moments in Initial 

Design. 

Affected Programs  

AVEVA Marine Hydrostatics and Hydrodynamics. 
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10.21 Connected Compartments 

Description 

Compartments specified as connected to damaged compartments, are now just added to the list of 

damaged compartments for the analysis and treated as being damaged to the outside waterline. 

Previously, such compartments were combined to form one multi-compartment, but this meant that 

only one damage permeability could be applied, which was that of the first damaged compartment. 

With this new method, each connected compartment will have its own damage and probabilistic 

stability permeability. The latter can vary with loading draft.  

Also compartments are now connected in one direction only. Flood water will flow from the first to 

second compartment, but not the other way. Note that this means that to specify flow in both 

directions, two connected compartment records are now needed.  

Benefits 

Ensures compliance with the latest statutory regulations. 

Compatibility Constraints 

None. 

For More Information 

See User Guide Initial Design / Hydrostatics / Screen Based Reference Guide / Dialogs in Detail / 

General Particulars / Openings and Deck Edge Points and Other Data. 

Affected Programs  

AVEVA Marine Hydrostatics 
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10.22 ABS Towing Criteria 

Description 

The special ABS bollard pull criterion has been added. The user must edit a local copy of the 

Criteria file and specify the bollard pull heeling moment arm for the particular vessel according to 

the rules, using the Edit/Criteria menu option in the program.  

Benefits 

Ensures compliance with the latest statutory regulations. 

Compatibility Constraints 

None. 

For More Information 

Only noted here. 

Affected Programs  

maridcalc 
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11. AVEVA Hull General Functionality 

11.1 Reuse of Seam and Profile Numbers 

Description 

When using the option of free naming for seams and shell profiles the same number will be given 

to objects with the same name within one session. I.e. creating seam seam_at_fr32 results in the 

seam getting the number 123. If the seam is deleted and then a new seam is created with the 

same name in the same session the new seam will get number 123. If the seam ―seam_at_fr32‖ is 

deleted and then the application is restarted and a new seam with the same name, 

―seam_at_fr32‖, is created then it will not get the same number. The same is relevant for shell 

profiles as well. 

When starting batch generation of seams and shell profiles from the interactive application, the 

information needed to recreate any deleted seams and shell profiles with the same number as they 

had in the interactive application session, will be sent to the batch process.  

Benefits 

The name sequence database is better utilised and thus less numbers will be used. 

Compatibility Constraints 

None. 

For More Information 

Only noted here. 

Affected Programs  

AVEVA Marine Structural Design 

AVEVA Marine Detail Design 
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11.2 Multiple Negatives when Designing User Defined 
End Cut 

Description 

The current implementation of user-defined end cuts has been restricted to only one negative 

extrusion and to cut angles less or equal to 90 degrees. 

This has now been improved, allowing any number of negative extrusions defined in any plane, 

e.g. one negative extrusion used to define the end cut for the web and another one defining the 

flange end cut. Furthermore, extensions of the profile is supported, allowing also cut angles greater 

than 90 degrees. 

 

Benefits 

The improvement makes it possible to define any type of complex end cuts 

Compatibility Constraints 

None 

For More Information 

See User Guide Hull Detailed Design / Setup, Customisation and Standards / Profiles in AVEVA 

Marine / Profile Endcuts in AVEVA Marine / Customer Set-up of Endcut Standard / User Defined 

Endcut / Setting up User Defined Endcuts. 

Affected Programs  

AVEVA Marine Structural Design 

AVEVA Marine Detail Design 
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11.3 Split of Hull Notes and Posno 

Description 

The identification of a Hull Note and Position number has been split in the way that a Hull Note is 

recognized as a note and not as a position number. 

Benefits 

Possibility to handle all the Hull Notes without disturbing the position numbers in e.g. delete 

notes/all. 

Compatibility Constraints 

None. 

For More Information 

Only noted here. 

Affected Programs 

AVEVA Marine Structural Design 

AVEVA Marine Detail Design 
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11.4 Enhanced Selection Filtering 

Description 

The OR syntax can now be used when defining filters in the Selection Tool. 

In the general Selection Tool different kind of filters are used to extract the model items both when 

defining the scope of plane panels and the groups within these panels. The filters can be used both 

for selecting blocks or panels with wildcards, and by using the scheme syntax to select panels or 

groups. 

The wildcard characters % and * represents any single character and any number of characters 

respectively. But certain selections could not be made, e.g. a selection of both stiffeners and 

flanges was not possible because making a filter accepting stiffeners will exclude flanges and vice 

versa. Likewise selecting only the blocks AB123 and AB124 but not the other blocks with names 

starting with AB12 was not possible. 

This can now be done using the vertical bar character | as the OR operator. The two alternative 

patterns must be surrounded by parentheses having the OR operator between them. 

 E.g. in the example above with the two blocks the expression (AB123|AB124) will only accept 

panels belonging to these two blocks. Note that no blanks are added around operator and 
parenthesis. (AB1%%-FR*|AB2%%-FR*) will accept panels with a name containing the letters FR 

and starting in AB1 or AB2. 

To select stiffeners and flanges with a material grade equal to A23 the expression can be 
(STI|FLA)*, QUA=A23*; 

The parenthesis are necessary to define the two alternate patterns separating the OR clause from 

the common part of the filter. If the parentheses are left out they are added at the beginning and 

the end of the filter which may give unexpected results. E.g. if the parentheses where left out in the 

example above only the flanges would match as the stiffener pattern will only be the three 

characters STI which doesn‘t match any statement. 

Benefits 

By using the OR operator in defining the filters a greater variety of panels and groups can be 

collected in one selection.  

Compatibility Constraints 

None. 

For More Information 

Only noted here. 

Affected Programs 

AVEVA Marine Structural Design 

AVEVA Marine Detail Design 
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11.5 Blocks and Panels from Tree View 

Description 

Like some other functions within Hull Design, the Panel Scope of a Selection can now also be 

defined by picking blocks or panels via a tree view dialog in addition to the existing picking from the 

picture. 

Benefits 

Tree view available for picking blocks and panel for the Panel Scope 

Compatibility Constraints 

None. 

For More Information 

Only noted here. 

Affected Programs 

AVEVA Marine Structural Design 

AVEVA Marine Detail Design 
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11.6 Set-up of a Project to Use Free Naming 

Description 

Today the environment variable SBH_FREE_SEAMPROF_NAMES is used to control if a project is 

set in free naming mode or not. From now on this has to be set using the InitHull application. 

Benefits 

It will no longer be possible to change this setting if seams or shell profiles have been created in a 

project.  

Compatibility Constraints 

The variable will still be used as a last resort for determining whether the project allows free 

naming. However, as soon as the hull reference object has been recreated in InitHull, the variable 

will not be used any longer in that project. 

For More Information 

Only noted here. 

Affected Programs  

AVEVA Marine Structural Design 

AVEVA Marine Detail Design. 
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11.7 Hole Annotation Enhancement 

Description 

 

The possibility to annotate holes in symbolic views has been extended with more customisation 

possibilities. The following 3 default values have been added to the Hull Modelling default file: 

 

HOLE_ANNOTATE_SIGN 

 

The sign in the dimension string between the dimensions (e.g. the X in HO200X500). Default value 

is X. 

 

HOLE_ANNOTATE_USE_TYPE 

 

If set the text in the hole type will be omitted (e.g. HO200X500 will be 200X500). The value is unset 

by default. 

 

HOLE_AN_MIN_TEXT_HEIGHT 

 

The minimum text height for the hole annotation. Default value is 2.0. 

Benefits 

Enables the user to control the annotate hole note better. 

Compatibility Constraints 

None. 

For More Information 

See User Guide Hull Detailed Design / Planar Modelling / Default File of Planar Modelling / Picture 

Derivation. 

Affected Programs 

AVEVA Marine Structural Design 

AVEVA Marine Detail Design 
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11.8 Hull Qualities in CATA 

Description 

The definition of the Hull qualities has been moved from the file assigned to the environment 

variable SBH_QUALITY_LIST to the catalogue in the Property World. The quality elements can be 

defined in Paragon using the PML script HullCreateQualityList. Input to the script is the file defined 

by the environment variable SBH_QUALITY_LIST. 

Benefits 

This change is beneficial for projects using Global. 

Compatibility Constraints 

The qualities must be defined on cata. 

For More Information 

Further details are given in the 12.0 to 12.1 Upgrade manual. 

Affected Programs  

AVEVA Marine Hull Design 
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11.9 Shellx with Plate Scantlings, Position Numbers and 
Material Quality 

Description 

 

The shell expansion view is now created with plate thickness, plate quality and plate position 

number annotated on each plate. Furthermore, each plate is drawn with a hatch pattern chosen to 

display the plate thickness that is used. 

The user can control the visibility of this information in two ways: 

By using the function Symbolic View->Curved Hull View->Properties and picking a shell expansion 

view. The user will get the possibility to display or hide the plate information. Furthermore, if plate 

hatching is chosen to be shown, an accompanying legend can also be created that shows each 

used hatch pattern and the thickness it represents.  

The shell expansion view is initially presented with shown information controlled by new keywords 

available in the default file: 

 

SHX_DRAW_PLATES = TEXT Plates are shown with plate thickness annotated 

 

                                     = DRAW Plates are shown with hatch patterns 

representing the plate thickness 

 

                                     = NOT SET Plates are shown with plate thickness information 

hidden (default) 
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SHX_SHOW_POSNO    when given, plates are shown with position number annotated 

 

                                       = NOT SET Plates are shown with position number hidden 

(default) 

 

SHX_SHOW_MATQ      when given, plates are shown with material quality annotated 

 

                                       = NOT SET Plates are shown with material quality hidden 

(default) 

 

                       

 

Benefits 

Visual overview of plate thicknesses in shell expansion view. 

Compatibility Constraints 

None 

For More Information 

Refer to User Guide Hull Detailed Design / Curved Modelling / Interactive Functions, Curved Hull 

Menu / Curved Panel. 

Affected Programs  

AVEVA Marine Detail Design 
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11.10 New Dialog when Setting Functional 
Descriptions 

Description 

The dialog for the function Hull Tools > Functional Description has been changed. The following 

dialog is now presented when activating the function: 

 

 

 

First select an interval from the drop-down list. This interval represents either a component on a 

planar or curved panel or a planar or curved panel. When the selection is made, the functional 

descriptions that are specifically defined for this interval will be presented and possible to select.  A 

Tick-box is available to show all system defined functional descriptions in case these are the ones 

to be set on components or panels. It‘s also possible to key in any integer value. Once the 

selection is made, the use of the OK button will hide the dialogue and the user is requested to pick 

components or panels depending on the interval that was selected. Picked elements will be 

updated with the selected functional description. Involved objects are made active before the 

update and it‘s necessary to apply the changes to get the update confirmed. 

Benefits 

Easier update of functional descriptions 

Compatibility Constraints 

None. 

For More Information 
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See User Guide Hull Detailed Design / Planar Modelling / Interactive Planar Hull Modelling 

Functions / Hull Tools. 

Affected Programs 

AVEVA Marine Hull Design 
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11.11 Increased Number of Surfaces 

Description 

The number of surfaces to be used in the Hull system is limited. With the possibility to add 

parametric surfaces, the limit of 100 is easily reached. To be able to add and handle more 

surfaces, the limit has been increased to 1000. This affects the Hull default keyword SURFACES, 

where the surface numbers to be used in Create View are listed. 

Benefits 

More surfaces can be handled 

Compatibility Constraints 

None 

For More Information 

Only noted here. 

Affected Programs  

Marine Planar and Curved Hull 
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12. AVEVA Surface Manager 

Description 

Surface Manager is a new module that allows transfer (import/export) of surfaces from/to external 

systems by the use of neutral standards. It also offers tools for the assessment of the quality of the 

imported surface and if needed can repair selected defects detected in the surface coming from 3
rd

 

party.  

Surface Manager requires a specific license. 

Benefits 

Key features are: 

 Import surfaces into AVEVA Marine projects 

 Graphically displays the layout of the surface 

 Finds problem areas and shows them graphically 

 If possible optimises the surface by removing problem areas 

 Extract curves for use in Hull Design 

 Extracts surfaces from existing AVEVA Marine projects 

 Exports surfaces to file 

 Possible to select only part of a surface to export 

 Mirror surfaces in the centre line plane 

 Supports the most commonly spread formats: IGES, SAT, DML, STEP AP203 

Compatibility Constraints 

None 

For More Information 

See User Guide AVEVA Surface Manager / Tools and Functions. 

Affected Programs 

AVEVA Marine Hull  
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12.1 Surface Manager Replacing Surface Server 

Description 

For a long time the only way of using an external surface with Aveva Marine has been through the 

surface server. This has limited the type of operations performed on the surface and control of the 

quality, ―fit for purpose‖, of the surface.  

Starting with AVEVA Marine 12.1 all surfaces have to be released into the database and the 

surface server will not be used. To help with this when working with surfaces created by non Aveva 

software, there is a new application, the AVEVA Surface Manager. It can import surfaces in IGES, 

SAT, STEP and dml formats. It also has a number of features for checking and repairing the 

surface. 

Benefits 

More advanced operations can be performed on the surface and the user can check the externally 

created surface before importing it to the database. 

Compatibility Constraints 

None 

For More Information 

See User Guide AVEVA Surface Manager 

Affected Programs  

None. 
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12.2 Surface Manager – Compare Surfaces 

Surface manager has a function which can compare surfaces in Tribon M3SP6 and AVEVA Marine 

12.1. To create the input from Tribon M3SP6 there is a program sj708 that intersects a surface and 

writes a text file with sample points that can be read by Surface Manager compare function. To get 

the program sj708, please contact regional support representatives. 
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13. AVEVA Space Management 

Description 

Space Management is a new application that can be used to create and manage an automatic 

subdivision of a ship into spaces. Space Management can also be used for analysis, planning, 

monitoring and follow up on space arrangements generated for different purposes such as: 

 SOLAS classification of compartments 

 Design Zones 

 Compartmentation and stability assessment 

 Sub-contractors subdivision 

 Production Planning 

 Painting areas 

 Fire/Noise/Thermal insulation plans 

 Etc. 

Space arrangements can be reused in all other modelling disciplines and as the design evolves, 

spaces can be interrogated regarding all objects within each space.  

Space Management requires a specific license. 

Benefits 

Key features are: 

 A new tool for simulations, estimations and decisions, de-risking design of more complex 
ships 

 Better productivity for GA activities and drawings 

 Better cost follow-up by getting early and precise estimates of e.g. insulation material or 
painting areas 

 Increased production efficiency by optimisation of block structure 

Compatibility Constraints 

None 

For More Information 

See User Guide Space Management 

Affected Programs 

AVEVA Marine Space Management  
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14. AVEVA Hull Structural Design 

14.1 New Options when Creating Envelopes 

Description 

The function Envelope has been updated with an option to define an envelope as an axis-parallel 

box in space. The dialogue has changed as shown below: 

 

When a new envelope is defined, the tick-box ‗Generate from Box‘ can be used. When ticked the 

boundary list will be dimmed and the key-in fields for minimum and maximum points are enabled. If 

data for general particulars is available, these will be fetched and added to the key-in fields when 

using the function Box from GP. The fetched values are extended with one meter in all directions. 

When the limits selected to generate an envelope generate more than one closed volume there is 

now the possibility to select which one to use as the desired envelope, by specifying a point inside 

the created envelope. 

Benefits 

The new possibility to generate envelopes enables RSO modelling to be made in a more flexible 

way. 

Compatibility Constraints 

None. 

For More Information 

Only noted here. 

Affected Programs 

AVEVA Marine Structural Design and Space Management. 
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14.2 RSO Change Envelope 

Description 

A new function RSO Change Envelope has been added, which allows the user to move RSOs from 

one envelope to another. When moved, the RSO is recreated in the target envelope. The following 

dialog is presented when the function is activated: 

 

When an envelope is selected from the drop-down list, all RSOs belonging to this envelope are 

presented in the list. When a target envelope is selected, one or many RSOs can be selected and 

added to the target envelope. The added RSOs are recreated in the new envelope by selecting 

Apply or OK. 

Benefits 

Enables RSO modelling to be made in a more flexible way. 

Compatibility Constraints 

None. 

For More Information 

See User Guide Hull Structural Design / Functions Overview / Functions in the Project Menu / 

Envelope and AVEVA Space Management / Functions Overview / Functions in the Project Menu / 

Envelope. 

Affected Programs 

Structural Design 

Space Management 
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14.3 RSO Recreate 

Description 

A new function ―RSO Recreate‖ has been added, which recreates the geometry of the RSO based 

on the current definition of limiting objects and the envelope. The function is activated from the 

RSO menu, when right-clicking a RSO or as a right-click menu option in the function ―RSO 

Property‖. 

When the function is activated from the RSO menu, the user is asked to pick an RSO in the 

drawing. By using the Option button, the user can select all RSOs within a view on the drawing. 

When the function is activated within the function ―RSO Property‖, the user can select to recreate 

the indicated RSO or all RSOs. 

When the function is activated by right-clicking the geometry of an RSO, the indicated RSO is 

recreated. 

Benefits 

Enables RSO modelling to be made in a more flexible way. 

Compatibility Constraints 

None. 

For More Information 

See User Guide Hull Structural Design / Functions Overview / Functions in the Functional Structure 

Menu / RSO and AVEVA Space Management / Functions Overview / Functions in the Functional 

Structure Menu / RSO. 

Affected Programs 

AVEVA Marine Structural Design and Space Management 
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14.4 RSO Rename 

Description 

A new function RSO Rename has been added, which renames a RSO, updates all panels located 

in the renamed RSO and updates all other RSOs that are topologically dependent of the renamed 

RSO. All other topological dependences are currently not updated, e.g. hull panels using the RSO 

as boundary limit needs to be manually updated. 

The function is activated from the RSO menu, when right-clicking a RSO or as a right-click menu 

option in the function RSO Property. 

Benefits 

Enables RSO modelling to be made in a more flexible way. 

Compatibility Constraints 

None. 

For More Information 

See User Guide Hull Structural Design / Functions Overview / Functions in the Functional Structure 

Menu / RSO and AVEVA Space Management / Functions Overview / Functions in the Functional 

Structure Menu / RSO. 

Affected Programs 

AVEVA Marine Space Management 

AVEVA Marine Structural Design 
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14.5 Naming of Multiply Copied RSOs 

Description 

The naming of multiply copied RSOs is improved in the following way: 

If name XXX is given as target name and multiple copies are requested, then the copied RSOs are 

named XXX, XXX1, XXX2, … XXXn 

If name XXX10 is given as target name and multiple copies are requested, then the copied RSOs 

are named XXX10, XXX11, XXX12, … XXXn 

If name XXX10(10) is given as target name and multiple copies are requested, then the copied 

RSOs are named XXX10, XXX20, XXX30, … XXXn 

Benefits 

More accurate naming can be defined. 

Compatibility Constraints 

None. 

For More Information 

See Hull Structural Design / Functions Overview / Functions in the Functional Structure Menu RSO 

/ Copy. 

Affected Programs 

AVEVA Marine Structural Design and Space Management 
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14.6 Pick Option Added in RSO KeyIn 

Description 

An option to pick limiting RSOs has been added in the function RSO KeyIn. 

The dialogue is presented with new command buttons which will hide the dialogue and ask the 

user to pick an RSO in the current drawing.    

The command buttons are enabled when the function RSO KeyIn is activated from the RSO menu 

or when right-clicking a RSO, but disabled when the function is activated from the RSO Property 

function  

Benefits 

Enables RSO modelling to be made in a more flexible way. 

Compatibility Constraints 

None. 

For More Information 

See User Guide Hull Structural Design / Functions Overview / Functions in the Functional Structure 

Menu / RSO /Properties and AVEVA Space Management / Functions Overview / Functions in the 

Functional Structure Menu / RSO / Properties. 

Affected Programs 

AVEVA Marine Structural Design and Space Management 
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14.7 Pick Option Added in RSO Edit 

Description 

An option to pick limiting RSOs has been added in the function ―RSO Edit‖. 

The dialogue is presented with new command buttons which will hide the dialogue and ask the 

user to pick an RSO in the current drawing.    

The command buttons are enabled when the function ―RSO Edit‖ is activated from the RSO menu 

or when right-clicking a RSO, but disabled when the function is activated from the RSO Property 

function  

Benefits 

Enables RSO modelling to be made in a more flexible way. 

Compatibility Constraints 

None. 

For More Information 

See User Guide Hull Structural Design / Functions Overview / Functions in the Functional Structure 

Menu / RSO /Properties and AVEVA Space Management / Functions Overview / Functions in the 

Functional Structure Menu / RSO / Properties. 

Affected Programs 

AVEVA Marine Structural Design and Space Management 
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14.8 Right Click Menu on RSO 

Description 

A right click menu with RSO functions has been added when right clicking RSO geometry in a 

drawing. 

The following menu is displayed and functions can be selected to operate on the indicated RSO: 

 

 

 

Benefits 

Enables RSO modelling to be made in a more flexible way. 

Compatibility Constraints 

None. 

For More Information 

See User Guide Hull Structural Design / Functions Overview / Right Click Contexts Menus and 

AVEVA Space Management Functions Overview / Right Click Contexts Menus. 

Affected Programs 

AVEVA Marine Structural Design and Space Management 
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14.9 Stable Multi Face RSO Reference 

Description 

When positioning a plane panel relative to a multi face RSO either the face number or an axis 

aligned ray (point) can be used. If e.g. the statement wizard is used to build up the panel and an 

RSO face is picked via the graphical display the direct face number is added to the panel definition. 

In the panel statement it shows as a clause of the form ―NO=<number>‖. 

However if the RSO is modified it may be that the faces are renumbered and all the panels located 

by the RSO may get the wrong face number reference giving unpredictable results when 

regenerating. 

The other option to select a face within an RSO is to give a coordinate pair in the global coordinate 

system, either (X,Y) or (X,Z) or (Y,Z). These coordinate pairs will geometrically describe a ray in 

space. If this ray intersects an RSO face, that face will be used to define the panel plane. Using a 

ray to select a face is more stable than a direct face number as it is insensitive to face 

renumbering. 

From AVEVA Marine 12.1 the system will automatically update the panel definition provided the 

panel plane is defined via an RSO face number on a multi face RSO. When storing the panel a ray 

definition will be created and added to the panel definition. The direct face number will be kept as 

information, but the ray will take precedence. 

At storing, if the face number is out of date it will be updated from the ray. Single face RSOs are 

not affected by this development. If the ray hits multiple RSO faces, the direct RSO number is kept 

as the primary definition. 

Benefits 

Panels with location defined by multi face RSOs will be insensitive to RSO face renumbering. 

Compatibility Constraints 

None. 

For More Information 

Only noted here. 

Affected Programs 

AVEVA Marine Structural Design 

AVEVA Marine Detail Design 
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14.10 Seam from RSO 

Description 

A new way to define seams has been introduced. Seams can now be defined as an intersection 

between an RSO and a surface. 

A seam is defined by using the interactive function for creating seams. Select Surface/Surface 

type, indicate the intersecting RSO. 

Benefits 

Enables seams to be defined as an intersection between surface and RSO. 

Compatibility Constraints 

 None. 

For More Information 

Only noted here. 

Affected Programs 

AVEVA Marine Structural Design 

AVEVA Marine Detail Design 
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14.11 COR Keyword when Referencing RSOs and 
Surfaces 

Description 

The result of using the COR keyword has been harmonised for panel, RSO and Surface 

references. They now all work in the way planar panels have worked before. 

Benefits 

Consistency when modelling. 

Compatibility Constraints 

Panels created, before this release, with the COR keyword referencing RSOs and Surfaces might 

change when recreated with this release. 

For More Information 

Only noted here. 

Affected Programs  

AVEVA Marine Hull Design and Structural Design. 
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14.12 Delete Surface Object from Design Database 

Description 

Object of type CSURF can now be deleted from database. In the administration dialog, ―Register 

Surfaces‖, a new button, ―Delete‖, have been added. Selected surface will be deleted. 

Note: It is not possible to delete a surface which have objects associated with it, e g the surface 

have been used when creating curved hull objects. 

 

 

 

Benefits 

Improved administration of surfaces.  

Compatibility Constraints 

None. 

For More Information 

See User Guide Hull Structural Design / Functions Overview / Functions in the Project Menu / 

Surfaces. 

Affected Programs  

Structural Design 
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14.13 Block, Recreate All 

Description 

A new function, Recreate All, has been added to right-click menu in the Block Edit dialogue. When 

activated, all blocks are recreated using the definition data stored with the blocks. 

Benefits 

Enables all blocks to be recreated in one operation. 

Compatibility Constraints 

None. 

For More Information 

See User Guide Hull Structural Design / Functions Overview / Functions in the Project Menu / 

Block and AVEVA Space Management / Functions Overview / Functions in the Project Menu / 

Block.  

Affected Programs 

AVEVA Marine Structural Design 

AVEVA Marine Space Management 
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14.14 Right Click Menu on Blocks 

Description 

A right click menu showing the block edit function has been added when right clicking block 

geometry in a drawing. 

The following menu is displayed and the block edit or the recreate function can be selected to 

operate on the indicated block: 

 

 

 

Benefits 

Enables block modelling to be made in a more flexible way. 

Compatibility Constraints 

None. 

For More Information 

Only noted here. 

Affected Programs 

AVEVA Marine Structural Design and Space Management 
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14.15 Jumbo Panels Removed 

Description 

The functions handling jumbo panels have been either removed or modified to handle any kind of 

planar panel. The functionality of the removed functions is covered by more recent concepts like 

modelling panels on RSOs and the use of Design Panels. The term ―jumbo panel‖ is removed from 

dialogs and messages and the data type (object code 1) interval previously associated with them 

(800 – 899) is reserved for future use. 

Benefits 

Obsolete functions removed from the system. 

Compatibility Constraints 

None. 

For More Information 

Only noted here. 

Affected Programs 

AVEVA Marine Structural Design 

AVEVA Marine Detail Design 
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14.16 FEM World for Idealised and FE Models 

Description 

A new top level element FEMWLD for FEM related items has been introduced. The FEM world can 

contain idealised blocks (HIBLO), idealised plane (HIPAN) and curved panels (HICPAN), FE 

models (FEMODL) and FE images (FEMIMG). 

 

 

 

Idealised plane panels are now drawn in the 3D canvas according to the applied idealisation 

settings (no thickness, stiffeners as lines…): 

 

 

 

It is also possible to draw FE images in the 3D canvas for inspection purposes (example contains 

shell and beam image): 
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Benefits 

All FEM related items can be found in one place. 

Compatibility Constraints 

Before running new idealisations in 12.1 a FEMWLD element needs to be created in a design 

database. It is recommended to store all FEM related objects in a separate database. 

Idealised models and FE models from AM 12.0 are not upgraded to AM 12.1. All FEM related 

objects are deleted from the project under the upgrading process. 

For More Information 

See User Guide Hull Structural Design /Finite Element Model. 

Affected Programs 

AVEVA Marine Structural Design  
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14.17 FEM Additions 

Description 

Analysis | Idealise Model, Idealisation Settings: 

The idealisation option *ignore if prof. height smaller than‘ has been added to filter stiffeners, 

pillars, flanges and swages by their profile height. 

The idealisation option ‗ignore if prof. area smaller than‘ has been added to filter stiffeners, pillars 

and flanges by their profile area. 

Analysis | Create FE Model: 

All options to create images for investigation of FE models have been moved to the idealised 

block‘s context menu. Only the options to create model images are left in the dialogue. Now two 

separate images are created for beam and truss elements. 

 

 

 

The check box Unwarp shell elements has been added. Previously unwarping was done 

unconditionally. That makes it possible to create the FE model in steps applying one option after 

another or in different orders. Unwarping can then be done in a separate step at the end of the 

process. 

Benefits 

More flexible creation of idealised and FE models. 

Compatibility Constraints 

None 

For More Information 

See User Guide Hull Structural Design /Finite Element Model. 

Affected Programs 

AVEVA Marine Structural Design  
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14.18 FEM Improvements 

Description 

Handling of knuckled panels: 

Knuckled main panels are now part of the idealised model. Before, idealised panels had been 

created from the subpanels without creating a knuckled main panel. But then references to main 

panels where no longer correct which has been solved now. 

This means that a knuckled panel in the original model will be represented as a knuckled panel 

also in the result from the XML Hull Steel Export as opposed to before when it was represented by 

the individual subpanels exported as ordinary panels. 

Symmetry issues of idealised subpanels have been solved. 

Using a limiting box for idealisation: 

Now the idealisation process uses the common Block Division facility for plane panels. Temporary 

copies of the original panels are no longer necessary. 

Benefits 

Quality improved. Redundancies removed. 

Compatibility Constraints 

None 

For More Information 

Only noted here. 

Affected Programs 

AVEVA Marine Structural Design 
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15. AVEVA Hull Detailed Design 

15.1 Separate Handling of Auto Bevel for Stiffener End 
Web and Flange 

Description 

Today bevels can be defined automatically at a stiffener end by defining a bevel set in the bevel 

default file and then specifying that the set is to be valid for stiffener end in the bevel set file. The 

bevel is then automatically defined for both flange and web. It is possible to prevent auto bevel for 

the stiffener end by giving the key word NABE in the stiffener statement.  

It is now possible to prevent bevel for the web or flange separately. Two new keywords have been 

added NABF and NABW for the stiffener statement, deactivating auto bevel for stiffener end flange 

or web respectively.   

Benefits 

Makes it possible individually control the use of automatically defined bevelling for the web and 

flange at a stiffener end. 

Compatibility Constraints 

None, the keyword NABE remains and has the same meaning as before. 

For More Information 

See User Guide Hull Detailed Design / Planar Modelling / Design Language of Hull Modelling / 

Stiffener Statement / Stiffeners Except Connection Stiffeners.  

Affected Programs 

AVEVA Marine Structural Design 

AVEVA Marine Detail Design 
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15.2 Bevel Chamfer Option 

Description 

Previously when no bevel was set for a seam or boundary, the system to some extent assumed a 

bevel type 10 (square butt welding). The benefit here was that chamfer was taken in to 

consideration when such an edge was included in an abutting boundary. 

When the option 99 was introduced to the CHAMFER_ADJUST default keyword this faulty way of 

handling edges without any bevel was removed. This has caused problems when reusing old 

designs since the behaviour now is different. 

In order to get this default behaviour back in older designs, an environment variable, 

SBH_DEFAULT_BEVEL, has been introduced and should preferably be set to a tight butt bevel 

type that is defined in the bevel control object. 

Behaviour when SBH_DEFAULT_BEVEL is defined (as a tight bevel code of type 10) 

 

 

Default behaviour. 

 

 

Behaviour when SBH_DEFAULT_BEVEL is defined (as a tight bevel code of type 10) 

Benefits 

Old designs are still presented with correct chamfer information. 

Compatibility Constraints 

None. 

For More Information 

Only noted here. 

Affected Programs 

AVEVA Marine Structural Design 

AVEVA Marine Detail Design 
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15.3 Bevel for Shell Stiffener Ends 

Description 

The handling of automatic definition of bevel for shell stiffener ends has been harmonised with the 

corresponding functionality for planar panel profiles. Therefore it is no longer controlled by the 

environment variable SBH_PROF_TIGHT but by settings in the file as defined by the environment 

variable SBH_BEVEL_SETS. 

Benefits 

Unified automatic bevel setting for all profiles. 

Compatibility Constraints 

None. 

For More Information 

See also User Guide Hull Detailed Design / Setup and Customisation / Bevel Excess and Weld / 

Bevel Handling in AVEVA Marine / Customer Set-up of Bevel Standards / Automatic Bevel 

Definition. 

Affected Programs 

AVEVA Marine Structural Design 

AVEVA Marine Detail Design 
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15.4 Position of Upper and Lower Cutting Curve 

Description 

 

The upper and lower material curves of a plate edge are calculated from the plate thickness of the 

bounding plate, i.e. the e-measure of the current bevel. This means that the upper material curve 

ends according to the point D in the upper view in the figure above. This is also the position of the 

so called bump contour. 

However, since the chamfer defined by the variants is cut (or grinded) off after the normal end 

cutting, the nested plate parts might be positioned to close to each other. 

A more correct way to calculate the upper and lower material curve is to take the current plate 

thickness and the current variant into consideration when calculating the curves. This means that 

the upper material curve will be positioned according to the point D in the lower sketch in the figure 

above. 

The environment variable SBH_ADJUST_FOR_BEVEL_VARIANT can now be used to switch to 

the new way of calculating the material contours. By giving the variable the value YES, the new 

method will be used. In any other case, the old method is still applied. 

Benefits 

This development enables the user to control the size of bump contours of plates when variants 

are involved, avoiding potential problems with plates being nested too close too each other. 

Compatibility Constraints 

None 

For More Information 

See also User Guide Hull Detailed Design / Setup and Customisation / Bevel Excess and Weld / 

Bevel Handling in AVEVA Marine / End User Handling of Bevelling / Bevel and Extraction of Parts. 

Affected Programs 

Hull Design 

Plane Parts Generation 
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15.5 Position Control of Shell Profile and Plane Panel 
Stiffener 

Description 

 

 

The figure above is showing a plane view with two longitudinals, one with the material pointing 

upwards (the red one), one pointing downwards (the black one). 

In this example, the Automatic Bevel box in the Profile section of the Shell Stiffener has been given 

the value No. The intersection point of the mould plane of the Shell Stiffener and the hull curve in 

the panel plane is the same. 

In the plane view two different panels have been defined. Each of them containing a stiffener 

abutting one of the longitudinals and a cutout for the same longitudinal. 

The figure below shows two other longitudinals where the value Yes has been given in the 

Automatic Bevel box.  

 

 

 

Here the automatic bevel defined in the Shell Stiffener is considered. This means that the 

intersection point of the mould plane of the Shell Stiffener and the hull curve in the panel plane will 

be modified to accept tight connection at the trace of the Shell Stiffener. When modelling plane 

panels, components (e.g. stiffeners, cutouts) referring such a Shell Stiffener, will be adjusted to 

meet this modification. 
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When creating profile parts of these Shell Stiffeners, there are no problems with the profile size. 

When creating plate parts of the Shell Stiffeners, via a control file defined by the logical name 

SBH_PROF_TO_PLDB, there are no problems with the profile size of the web plate when the 

inclination angle, seen from the mould edge of the Shell Stiffener, is positive, i.e. for the lower 

profile in the figure above. 

However, if the connection angle, when seen from the mould edge of the Shell Stiffener, is 

negative, the current solution in the system will result in a too big profile part. 

The first step when creating the plate part of the web of the profile is to build up the geometry in the 

profile plane. The upper part of the web plate is positioned at a distance, equal to the web height, 

away from the trace part.  

Next step is to calculate the dotori angles along the trace curve of the plate and to create a guiding 

contour. In this step the plate part is made wider and wider. There is no problem with the material 

size because the plate part is cut from a bigger plate, but the final web plate part will be too big and 

the position of the flanges in the figure above will coincide, except for the web thickness. This 

means that e.g. an abutting stiffener will be to wide and a cutout maybe to small. 

Since the described process for converting profile parts to plate parts has been the same for a long 

time, some customers may have found their own workarounds to meet this problem. 

Therefore this functionality is now enhanced to give the customer a possibility to have the profiles 

positioned as shown in the first figure. By setting the Environment Variable 

SBH_CHECK_PROF_TRACE to any arbitrary value, further checks will be done. If the profile to be 

examined fulfils the criteria to be converted to plate part according to the rules given in the file 

assigned to SBH_PROF_TO_PLDB, calculations of connecting components like stiffeners, 

brackets and cutouts will be performed according to the first figure. 

Inclined plane panel stiffeners will be examined and treated in the same way as described for the 

shell stiffeners.  

Another way, already in the system, to control the position of inclined profiles is via the 

Environment Variable SBH_PROFPT_ADJUST. However, automatic bevel selection via 

SBH_BEVEL_SETS will always be the first choice. 

Benefits 

Enables the user to control the position of inclined profiles, curved as well as planar. 

Compatibility Constraints 

None. 

For More Information 

See also User Guide Hull Model Concept / Run Mode Control / Control on Application Level / 

Reference Point of Profile Section. 

Affected Programs 

Hull Structural Design 

Hull Detail Design 
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15.6 Compensation for Shell Plate Thickness 

Description 

For each shell profile, an additional trace is calculated considering the actual surface of shell plates 

over which the profile extends. This may be important in areas of heavy curvature along the profile 

trace if the profile and shell plates are located on the same side of the moulded surface, and in 

particular in areas with thick plates. 

In Inithull it is possible to specify per surface whether to compensate for shell plate thickness. This 

setting is done separately for planar panels and shell profiles. 

Benefits 

This development means that views will be more accurately drawn and production output such as 

profile sketches and weight and centre of gravity calculations will be more accurate. 

Compatibility Constraints 

For a project first created in an earlier AVEVA Marine release, plate thickness options should be 

setup in inithull before further modelling work is done. Shell profiles must be regenerated before 

plate thickness is considered. Planar panels must be regenerated if thickness settings for surfaces 

differ compared to before (i.e. thickness should be considered for some surfaces but not for 

others). 

For More Information 

Refer to User Guide Hull Model Concept / Run Mode Control / Control on Application Level / 

Compensation for Thickness of Shell Plates.  

Affected Programs  

AVEVA Marine Detail Design 

AVEVA Marine Production Programs 
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15.7 Top View of Stiffener Improved 

Description 

There is as an option in ‗detail view stiffener‘ which makes it possible to define the view looking 

from the top if the stiffener has a flange. The function has now been adjusted to always look at the 

chosen profile from above the flange. 

Benefits 

The function always displays the stiffener the same way 

Compatibility Constraints 

None. 

For more information 

Only noted here. 

Affected Programs 

Planar Hull. 
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15.8 Weld Built Profiles before Bending  

Description 

When built profiles parts are manufactured, the lengths of the web and flange parts are, by default, 

calculated to satisfy a manufacturing process where parts are first bent and then welded together. 

By setting the new ip WELD_BEFORE_BEND in the curved panel parts generation ip-file 

cpanparts.ip, the lengths will be calculated to fit a manufacturing process where web and flange 

parts are first welded together and then bent. 

Benefits 

Support for a manufacturing process where built profile parts are first welded together and then 

bent. 

Compatibility Constraints 

None. 

For More Information 

See User Guide Hull Detailed Design / Manufacturing / Automatic Generation of Curved Parts / 

Release of Curved Parts for Production / Set-Up of Program / Default File. 

Affected Programs  

AVEVA Marine Production Programs. 
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15.9 Weight Unit in Profile Sketches 

Description 

It will now be possible to choose if the approximate weight of profiles should be presented in tons 

or kilograms in profile sketches. This is accomplished by setting the new keyword WEIGHT_UNIT 

in the restriction file identified by the logical variable SBH_SKETCH_RESTRICT. Possible settings 

are WEIGHT_UNIT=KG and WEIGHT_UNIT=TON, where the latter setting is default. 

Benefits 

More possibilities to customise output data. 

Compatibility Constraints 

None. 

For More Information 

See User Guide Hull Detailed Design / Manufacturing / Profile Manufacturing / Production, Output 

Profiles / Automatic Generation of Profile Sketches / Creating Profile Sketches. 

Affected Programs  

AVEVA Marine Production Programs 



AVEVA Marine 12.1       User Bulletin 

Copyright 1974 to current year. AVEVA Solutions Ltd.   129 
 

15.10 Generic File Viewer 

Description 

The generic files of type 2AXIS and 3AXIS generated in Plate Nesting and Plate Interface, can now 

be viewed graphically using the new function ―GenFile Viewer‖ in the function Hull Tools  

> Part Checking. 

Benefits 

The viewer is an easy and fast function for visually controlling the data in the generic files.  All 

geometric data and production information texts can be displayed with different colours and line 

types for different kinds of geometry (burning with bevel, burning without bevel, marking etc). The 

colours and line types are user-controlled and defined in the Nesting default file. 

 

 

 

Compatibility Constraints 

None 



AVEVA Marine 12.1       User Bulletin 

Copyright 1974 to current year. AVEVA Solutions Ltd.   130 
 

For More Information 

See User Guide Hull Detailed Design / Planar Modelling / Interactive Planar Hull Modelling 

Functions / Hull Tools / Part Checking. 

Affected Programs  
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15.11 Looking Field Changed for Hull Mark Projection 

Description 

When a hull text is to be projected on a planar panel or surface, the orientation in space of the hull 

text in space before projection is defined by several fields in the dialog. One of these is ―Looking‖, 

which replaces ―Looking from‖ in previous versions. This means that the opposite value compared 

to earlier versions should be set to get the same result. For example, a ―Looking‖ value of PS is 

equivalent to the previous ―Looking from‖ value of SB. 

Benefits 

This change aligns the way looking direction is defined with that of other functions, e.g. for creating 

symbolic hull views. 

Compatibility Constraints 

None. 

For More Information 

Refer to User Guide Hull Detailed Design / Miscellaneous Functions / Hull Marks. 

Affected Programs  

AVEVA Marine Detail Design 
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15.12 Control of Marking Gap at Holes 

Description 

When creating plane panel parts via the Plane Part Generation (ppanparts) functionality, the user 

has the possibility to set a default parameter value, MARKGAP, that controls the distance marking 

lines will be cut off at the outer contour of the plates. If a marking line ends at (or crosses or is 

close to) a hole, no check on any marking gap has been done so far. 

However, there is one exception. Marking lines defined via the MARKING statement in the Hull 

Modelling will be cut off at holes using the parameter MARKGAP. 

Because of possible plate damage when burner cutter crosses a marking line, the possibility to 

reduce other type of marking lines have been implemented. 

Three new default parameters have been entered into the ppanparts function. The names of the 

parameters are: 

REDUCE_MARKGAP_OF_STI_AT_HOLES, 

REDUCE_MARKGAP_OF_PLANE_AT_HOLES, 

REDUCE_MARKGAP_OF_PANEL_AT_HOLES, 

By giving REDUCE_MARKGAP_OF_STI_AT_HOLES, marking lines of the mould lines of 

stiffeners (default parameter STI must be given) will be checked for and reduced if the conditions 

mentioned above is fulfilled. 

By giving REDUCE_MARKGAP_OF_PLANE_AT_HOLES, marking lines of the reference planes 

(default parameter REFPLANE must be given) defined in Hull Modelling will be checked for and 

reduced if the conditions mentioned above are fulfilled. 

By giving REDUCE_MARKGAP_OF_PANEL_AT_HOLES, marking lines of abutting plane panels 

(default parameter PAN must be given) will be checked for and reduced if the conditions 

mentioned above are fulfilled. 

Benefits 

Enables the user to control the extension of marking lines around holes. 

Compatibility Constraints 

None. 

For More Information 

See also User Guide Hull Detailed Design / Manufacturing / Manufacturing of Plane Panel Parts / 

Plane Panel Part / Set-up of Program / Set-up of the IP File. 

Affected Programs 

Sf416d.exe 
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15.13 GSD Marking of Built Profiles 

Description 

When assembling built profiles there is a need for marking the flange and the web parts so that 

they may be correctly aligned to each other. This may now be done by setting the new keyword 

BUILT_FLA_SHAPE in the GSD default file. 

BUILT_FLA_SHAPE may be assigned three different values giving different options for the 

marking of the flange part. 

BUILT_FLA_SHAPE=THICKNESS will mark the flange with two parallel lines indicating the web 

thickness. This is the default option. 

BUILT_FLA_SHAPE=HOOK will mark the flange with a hook. 

BUILT_FLA_SHAPE=HOOK_THICKNESS will result in a marking which is a combination of the 

thickness and hook marking, where a line and the hook together indicate the web thickness.  

The generic files created by the Plate Interface and the Profile Sketch and List programs will 

contain the new marking types FACE_PLATE_ALIGNMENT. 

Benefits 

Increased accuracy when assembling built profile parts. 

Compatibility Constraints 

None. 

For More Information 

See User Guide Hull Detailed Design / Setup, Customisation and Standards / Alignment Marking / 

Marks for Assembly (GSD) / GSD Customising / Control of GSD:s via a Default File. 

Affected Programs  

AVEVA Marine Production Programs. 
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15.14 Mark Reference Plane on Both Sides of Profiles 

Description 

If REFPLANE is defined in the ppanparts.ip then reference plane markings will be added to plate 

and profile parts when running Plane Panel Parts Generation. Profile parts will however only be 

marked on the moulded side. 

By defining REFPLANE, BOTH_SIDES, in ppanparts.ip profile parts will be marked on both sides 

of the profile web. 

Benefits 

Increased marking possibilities. 

Compatibility Constraints 

None. 

For More Information 

See User Guide Hull Detailed Design / Manufacturing / Manufacturing of Plane Panel Parts / Set-

up of Program / Set-up of the IP file. 

Affected Programs  

AVEVA Marine Production Programs. 
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15.15 Nest Profiles without Rest 

Description 

It will now be possible to nest profile parts on raw profiles without creating rest profiles. 

To accomplish this do the following two steps: 

 Define a raw profile with type and dimensions the same as the profile part that should be 
nested. Define the length as zero. 

 Insert the new keyword NEST_WITHOUT_REST=YES in the general section of the profile 
restriction file, as defined by SBH_PROF_RESTRICT. 

Nesting will now be performed as if the length was the maximum length for the profile type. When 

nesting is completed the length will be set to the exact length needed, so that no rest part will be 

created. 

Benefits 

Flexibility. 

Compatibility Constraints 

None. 

For More Information 

See User Guide Hull Detailed Design / Setup and Customisation / Setup for Production / The 

Restriction File / Keywords in the General Section of the Restriction File. 

Affected Programs  

Profile Nesting. 
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15.16 New Nesting Default Parameters 

Description 

The following additions/changes have been made for the Nesting/PLCM defaults: 

 

SYMB_HEIGHT_EXCESS 

 

Symbol height for excess text in burning sketch 

 

DISPLAY_EXCESS_SYMBOL 

 

Code for displaying the excess symbol in the burning sketch: 

0 = No display 

1 = Display 

 

MULTIPLE_NEST_NCOL (Nesting only) 

 

The number of nests in each column for multiple nest. 

 

LABEL_AUTO_POSNO_METHOD (PLCM only) 

 

The method used for presenting labelled position numbers: 

None = label posno as given 

Partname = label posno via partname control 

 

CVBA_SKETCH_ANGLE 

 

The code for the cvba angle display in the burning sketch: 

Along       = End angle in burning direction 

Maximum = The maximum of the start and end angles 

Minimum  = The minimum of the start and end angles 

Average    = The average of the start and end angles 

 

AUX_VALID_START_POS 

 

Text presented for auxiliary functions valid in the starting position 

 

AUX_VALID_END_POS 
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Text presented for auxiliary functions valid in the ending position 

 

EDIT_PRODUCTION_TEXTS 

 

Code for editing production texts in burning sketch using Right-Click: 

No =  Editing not possible 

Yes = Editing possible 

 

DRAW_RAW_PLATE_CORN 

 

Code for drawing the raw plate corners in the burning sketch: 

No =  Do not draw 

Yes = Draw 

 

MOVE_START_CONFIRM_OPPSITE 

 

Code for confirmation when a marking start is moved to a marking line valid only 

on the opposite side: 

No =  No confirmation 

Yes = Confirmation 

 

MARK_AUTO_OPPOSITE  

 

This default is now valid also in PLCM. 

 

CUTSEQ_MIN_AREA 

 

Minimum area of plate for which cutting sequence information are added to the  

sketch. 

 

ALL_STARTS_TYPE 

 

The type of starts to be treated when the start sequence is added in the burning 

sketch: 

All starts 

All burning starts 

 

ALL_STARTS_COLOUR 
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The colour for the start sequence information in the burning sketch. 

 

ALL_STARTS_HEIGHT 

 

The text height for the start sequence in the burning sketch. 

 

AUTONEST_ASSEMBLY_LEVEL 

 

The assembly level for the parts. Ignored if zero.  

 

AUTONEST_CUSTNAME_CTRL 

Customised part name control: 

= No     Do not use customised part name 

= Yes    Use customised part name 

 

AUTONEST_PART_SELECTION 

 

The minimum area in mm2 for the parts to be nested ‗large parts first‘. If < 0, the ‗ 

Parts are not nested by area. 

 

AUTONEST_ROTATION_CTRL 

 

Rotation control: 

= No No control, any rotation angle can be used 

= Yes Only rotation angles which are a multiple of 90 degrees are used 

 

AUTONEST_STOP_MULTIPLE 

 

The time limit in milliseconds for a multiple nest 

 

AUTONEST_STOP_SINGLE 

 

The time limit in milliseconds for a single nest 

 

Benefits 

Improved configuration possibilities. 

Compatibility Constraints 



AVEVA Marine 12.1       User Bulletin 

Copyright 1974 to current year. AVEVA Solutions Ltd.   139 
 

None 

For More Information 

See User Guide Hull Detailed Design / Manufacturing / Nesting /  

Hull Plate Nesting / Initialisations for Nesting / Defaults. 

Affected Programs  

AVEVA Marine Plate Nesting 
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15.17 Nesting Plug-In Interface 

Description 

In the Nesting Plug-In Interface, additional parameters have been added to some of the interface 

modules. The new parameters have been defined  as Nesting Defaults. 

Benefits 

The new parameters will make it easier to control any external pattern generator. 

Compatibility Constraints 

The new parameters must be added in all applications using the Plug-In Interface. 

For More Information 

See User Guide Hull Detailed Design / Manufacturing / Nesting / Hull Plate Nesting / Nesting Plug-

In / Plug-In Interface and Hull Detailed Design / Manufacturing / Nesting / Hull Plate Nesting / 

Initialisations for Nesting / Defaults. 

Affected Programs  

AVEVA Marine Detail Design 
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15.18 Storing Changes after Running Production 
Programs 

Description 

The production programs are not updating any data in design databases (DESI) anymore. 

Furthermore, some objects previously stored in manufacturing databases (MANU) are not stored at 

all. 

Bracket panels have until now been split and stored as plate parts in MANU. The brackets pointing 

at that bracket panel have been stored without geometry, but with a reference to the bracket panel 

plate part. From now on the information stored in the bracket panel plate part is copied into the 

bracket plate part and the bracket panel plate part will no longer be stored. 

Sub panel plate parts have until now been split and stored as plate parts in MANU. Since the main 

panel plate parts are either referring to a single sub plate or to two or more sub plates and the main 

panel plate parts are built up by these parts, there is no need to have the sub panel parts stored in 

MANU. 

When creating bending templates for a curved plate, previously the sight plane and sight line plane 

were stored in the plate in DESI. This information will from now on be stored in the plate templates 

in MANU. 

When creating plate jigs for curved panels, previously the calculated assembly plane and some 

additional information about the orientation of the plate jigs were stored in the curved panel in 

DESI. From now on this information is stored in the plate jigs in MANU. 

When creating jig pillars for curved panels, previously the jig pillar was stored in DESI. The jig pillar 

contains information similar to that stored in the plate jigs. From now on the jig pillars are stored in 

MANU and the orientation information is no longer copied to the curved panel. 

Benefits 

This change means an improved structure of stored data, and is beneficial for projects using 

Global. 

Compatibility Constraints 

Projects created in an earlier AVEVA Marine release needs to be upgraded before continued use 

with AVEVA Marine 12.1. The upgrade will change the storing of selected objects as described 

above, as well as reorganise the MANU contents (described in another release note). 

For More Information 

Further details of the upgrading of old projects are given in the 12.0 to 12.1 Upgrade manual. 

Affected Programs  

AVEVA Marine Production Programs 
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15.19 New MANU Data Model 

Description 

In AVEVA Marine 12.0 the manufacturing data base (MANU) reflected the design and for each 

design block (BLOCK) the corresponding block (MBLOCK) was automatically created when the 

production parts where created. Below each MBLOCK, MPANEL elements were created and the 

production parts were stored below the MPANEL element. The production part elements are 

MPLATE for planar and curved plates, MPROF for planar and curved profiles and MBPRO for built 

profiles. 

In AVEVA Marine 12.1, the MBLOCK and MPANEL elements are obsolete and the production 

parts are stored in manufacturing package elements MANPKG. These elements contain a filter 

element (MPKGFT) as well as one or more manufacturing package folders (MPKGFL). The rules 

defined in the MPKGFT elements determine in which manufacturing package the production parts 

will be stored. Each folder within a manufacturing package has a rule which makes it possible to 

e.g. store different types of plate parts in different folders. 

 

 

 

Examples of rules are: 

 

 MATCHWILD ( ATTRIB NAMN, ‗ER5*‘) 

 ATTRIB TYPE EQ ‘MPLATE‘ 

 ATTRIB TYPECD EQ 91 
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 MATCHWILD ( ATTRIB QUATXT OF FIRST MPLRWI, ‘A*‘) 

 ATTRIB NAMN OF OWNER INSET( ‗ER2‘, ‗TEST‘) 

 TRUE 

 

The last rule can be used in a last folder to ensure that there always is a folder to put the 

production part in. This folder should normally be empty. 

 

 

 

Benefits  

 Easier to use 

 Easier to find information 

 Easier to distribute 

Compatibility Constraints 

Old projects must be upgraded to 12.1 using the Upgrade tool in the new ManuConfig addin. 

For More Information 

Further details of the upgrading of old projects are given in the 12.0 to 12.1 Upgrade manual. 
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15.20 Automatic Naming of Production Sketches 

Description 

Hull production programs running in batch can create receipt sketches which are given 

automatically generated names. With this release a new set-up tool is introduced for a uniform 

customisable naming of production sketches. 

Users may now define how the sketch names should be put together by a set of rules. The naming 

rules are stored in a file referenced by the logical variable SBH_DWGNAME_RULES. Naming 

rules are defined individually for a number of applications. Each rule consists of a keyword 

identifying the application, followed by a number of attributes defining how the name is built up. 

The naming rule attributes are applied in the order they are given. Only rule attributes valid for the 

application may be given. First rule attributes are interpreted and the resulting values for each 

attribute are concatenated to form a sketch name. The rules are of mainly three types:  

5. Names (Current object name, part names, block name and computer name). 

6. Numbers (Next global sequence number for the application, job numbers and counters 
local for the application) 

7. Other (Free text, page number)  

Benefits 

Naming of production sketches may be customised in a uniform way. 

Compatibility Constraints 

Old techniques for generating automatic sequence numbers for the Parts List and WCOG 

applications are not valid any more. The keyword NAME_METHOD in the profile restriction file 

may not be used anymore and should be removed. 

For More Information 

See User Guide Hull Detailed Design / Manufacturing / Production Program Interface / Automatic 

Naming of Production Sketches. 

Affected Programs  

AVEVA Marine Production Programs. 
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15.21 Find Documents Related to Production Parts 

Description 

A large number of different reports and sketches are created by production programs. 

To be able to easily view documents valid for a specific production part, production programs will 

now create links from parts to relevant reports and sketches. The user will be able to view related 

documents in the Linked Documents dialog in Hull Design.  

This is done by the following steps: 

1. Bring up the Linked Documents dialog and mark Follow CE (current element). 

2. Indicate a production part in the Manufacturing Explorer and related reports and drawings 
for the indicated part will appear in the Linked Documents dialog. The reports and drawings 
may then be opened by right-clicking on the displayed link.  

Benefits 

Reports and sketches related to a specific production part may be easily viewed. 

Compatibility Constraints 

None. 

For More Information 

Refer to User Guide Hull Detailed Design / Manufacturing / Production Program Interface / Hull 

Production Program Interface / Links to Documents from Related Production Parts. 

Affected Programs  

AVEVA Marine Production Programs. 
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15.22 Naming of Curved Plates and Stiffeners 

Description 

Handling of names is slightly changed for shell plates and stiffeners in DESI databases and curved 

plate parts in MANU databases. 

It is no longer possible to have shell plates and stiffeners automatically renamed when adding 

them to a curved panel. This option (controlled by the environment variable 

SBH_CPAN_RENAME_PARTS) was a legacy from much older versions of the system and might 

cause problems if used wrongly. Shell plates and stiffeners will now always keep their initial name 

even after being added to a curved panel. 

Secondly, it is possible to control how curved plate parts are named in MANU by use of the above 

mentioned variable. 

In earlier versions, after parts splitting, the names of curved plate parts belonging to a CL panel 

have ended in SP even for PS/SB specific or symmetric plates. 

It is now possible to control the plate part names in such cases, optionally having the names 

reflecting the actual plate symmetries. 

The old naming for a panel BLOCK1-2SP with one CL-plate and one symmetrical plate (both PS 

and SB) was: 

 

 BLOCK1-2SP-1SP 

 BLOCK1-2SP-3SP 

 BLOCK1-2SP-4SP 

 

The new naming will be: 

  

 BLOCK1-2SP-1SP 

 BLOCK1-2SP-3P 

 BLOCK1-2SP-4S 

 

To use the new naming rules for plates belonging to a CL panel, set the environment variable 

SBH_CPAN_RENAME_PARTS to ‗CL‘. 

Benefits 

Project administration becomes easier due to increased consistency in naming of shell plates and 

shell stiffeners as well as production parts. The plates and stiffeners will keep the names as given 

by the user even after they have been added to a curved panel. 

The naming of curved plate parts after parts splitting will reflect the individual storing. 

Compatibility Constraints 

The new naming should not be mixed with the old one in an on-going project. 

For More Information 

Refer to User Guide Hull Model Concept / About Naming / Specific Name Rules. 
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Affected Programs 

AVEVA Marine Detail Design 

AVEVA Marine Production Programs 
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15.23 Function to Find and Remove Dangling MANU 
Parts 

Description 

When a panel (planar or curved) is removed from the model, any corresponding production parts 

are automatically removed. If this, e.g. due to a restricted database access, cannot be done, the 

result will be dangling plate and profile parts which should not be manufactured. 

A PML function has been developed to clean up the database and take care of this situation. The 

function searches for elements of type MPLATE, MPROF and MBPRO and removes all those for 

which a corresponding panel does not exist. 

The function, hullDeleteUnrefMANUParts, can be found in the installation directory, under 

PMLLIB\hulldesign\functions. 

Benefits 

The risk of manufacturing unnecessary parts (and thus increasing production cost) is reduced. 

The function does not need any parameters when called and is quite easy to use. All parts to be 

removed will be found automatically, which is more efficient than searching for them manually. 

Compatibility Constraints 

None. 

For More Information 

Only noted here. 

Affected Programs  

None. 
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15.24 Enhancement in Dialogue for Automatic 
Position Number Definition. 

Description 

The automatic definition of position numbers is controlled by an Autopos control object with 

different cases for position number definition. It may be relevant to have more than one Autopos 

object, e.g. when defining both with and without the option to treat symmetrical parts equally. 

The dialog for Automatic Position Number Definition has been enhanced to present all available 

Autopos control objects in a drop-down list. The cases available in the highlighted control object 

are presented in a list. When switching to another Autopos Control Object by selecting it on the 

drop-down, the user must click the ‗Update‘ button to list the relevant cases for the selection. 

Benefits 

No need for the user to remember the names of cases and objects 

Compatibility Constraints 

None 

For more information 

See User Guide Hull Detailed Design / Manufacturing / Automatic Position Number Setting. 

Affected Programs 

AVEVA Marine Detail Design 
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15.25 Reflection in Hull Element Names and Hurefl 
Attribute 

Description 

Slightly changed naming rules apply for hull elements created in the Design database by Planar 

and Curved Hull: 

 For any non-symmetric object there will be only one element. The name of this element will 
be equal to the object name as given by the user (or in some cases automatically by the 
system). 

 For a symmetric object there will be two elements. One of these will be named as the 
object and one will have a name composed by the object name and a _R suffix (R 
meaning ―reflected‖). 

 For a symmetric object with the geometry defined on PS, the PS element will have the 
shorter name and the SB element will have a _R suffix. 

 For a symmetric object with the geometry defined on SB, the SB element will have the 
shorter name and the PS element will have a _R suffix. Currently only planar panels can 
be symmetric and have their geometry defined on SB. 

The Hurefl attribute will strictly answer the question ―Is the current element in its reflected position 

relative to where the geometry is defined?‖ This implies two things: 

 Even a non-symmetric element may have a Hurefl value of True. 

 The Hurefl value (True/False) and the element name (with or without _R suffix) will not 
always match. 

Benefits 

There will be less confusion regarding element names for non-symmetric objects, and there will for 

certain always be an element with the object name as given by the user. This solution is more 

intuitive and customised development may be simpler as well. Still functionality using the Hurefl 

attribute, e.g. weld detection, will work properly. 

Compatibility Constraints 

Objects generated in AVEVA Marine 12.0 that are valid on one side but with the geometry on the 

other must be recreated before the new rules for element name and Hurefl fully apply. Note in 

particular that this applies to SB specific curved panels, which internally have their geometry 

reflected to PS. The objects are recreated via the Recreate functions in the Planar Hull and Curved 

Hull menus, respectively. 

For More Information 

Only noted here. 

Affected Programs  

AVEVA Marine Detail Design 
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15.26 FRP Additions 

Description 

Laminate can be given not only for planar plates and stiffeners, but also for flanges. 

The old term GRP (Glass fibre Reinforced Plastics) has been replaced by the more general term 

FRP (Fibre Reinforced Plastics). As a consequence, two attributes in the TIL input file when setting 

up FRP has been renamed. PERCENT_OF_GLASS is now PERCENT_OF_FIBER and 

GLASS_WEIGHT has been renamed to FABRIC_WEIGHT. 

Benefits 

This development means better support for production with laminate technique. 

Compatibility Constraints 

Old TIL input files for FRP settings must be modified, adapting them to the renamed attributes. 

For More Information 

Refer to User Guide Hull Detailed Design / Setup, Customisation and Standards / (Fibre) 

Reinforced Plastics Option (FRP) / Definition of the FRP Object / Laminate Plate Statement.  

Affected Programs  

AVEVA Marine Detail Design 

AVEVA Marine Production Programs 
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15.27 Tribon 5 Curved Hull Input Data 

Description 

In the Tribon M series there is an option to convert Tribon 5 Curved Hull Input data for Seamgen, 

Profgen and Cpangen. This option existed only so that users could more easy migrate from Tribon 

5 into Tribon Mx version. The way of creating data in Tribon 5 format does not exist anymore and 

is not described anywhere in the documentation. This option to convert old data files into newer 

XML format will in AVEVA Marine 12.1 be deprecated and finally removed in AVEVA Marine 12.2. 
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16. AVEVA Hull Weld Planning 

16.1 Weld Calculation Curved Panels 

Description 

The calculation of welds on curved panels with holes crossing seams, is now excluding the part of 

the plate boundary that represents the hole. 

 

 

 

Benefits 

The result of the weld calculation is more accurate 

Compatibility Constraints 

None 

For More Information 

Only noted here. 

Affected Programs  

AVEVA Marine Weld Planning 
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16.2  Weld Calculation Shell Profiles 

Description 

The calculation of welds on shell profiles with notches is now excluding the part where the notch is 

defined. 

 

 

 

Benefits 

The result of the weld calculation is more accurate 

Compatibility Constraints 

None 

For More Information 

Only noted here. 

Affected Programs  

AVEVA Marine Weld Planning 
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17. AVEVA Design Reuse 

Description 

Design Reuse is a tool to simplify the work required to copy design data between projects and 

thereby reuse design work. Design data that is copied is re-generated and adapted to the design 

context of the target project. Copying design data follows an export/import scenario with an 

intermediate storage in a Transfer Set. The functionality provided is accessible through the 

command line and through a graphical user interface. Design Reuse is made as a so-called addin 

and is hosted by the Hull Design, Outfitting Design and Marine Drafting modules.  

Design Reuse requires a specific license. 

Benefits 

 Very useful for design reuse between ships. The design is copied from one ship to 
another, and adapted to the second ship. The model is re-generated and adapted to the 
design context of the second ship. 

 Support for different naming conventions by fully customizable name substitution rules. 

 Maintains the references within the model as well as between drawings and models by 
reference adaptation at import to the second ship. 

 Drawings keep their associations and are updated at import. 

 GUI for interactive usage inside Hull Design / Outfitting Design / Marine Drafting. 

 Commands supporting all available functions. 

 Provides high level customization through trigger functions. 

 Sisterships can be synchronized by customer written automation scripts executed at 
regular intervals.  

Compatibility Constraints 

None. 

For More Information 

See User Guide Design Reuse. 

Affected Programs 

Hull Design, Outfitting Design, Marine Drafting 
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18. AVEVA Assembly Planning 

18.1 Curved Hull Panel as Base Panel for Assembly 
Orientation 

Description 

Through the assembly properties dialog, when the predefined orientation is set to ―Specific Panel‖, 

it is now possible to select curved panel from the enumeration list of hull panels. The orientation of 

the selected curved hull panel is calculated and assigned as the orientation of the assembly. 

The method to calculate the orientation of a curved hull panel utilizes a plane derived from the 

corner points provided by the seam limits, the same method as used by the Jigs calculations. 

Benefits 

Can use curved hull panels as base panel for assembly orientation. 

Compatibility Constraints 

None. 

For More Information 

Refer to User Guide Assembly Planning / Graphical User Interface / Context Sensitive Menu 

Functions / Properties. 

Affected Programs 

Assembly Planning 
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18.2 Clean Up Assembly References 

Description 

Any type of element deleted is captured for an assembly specific evaluation to see if the element is 

referenced from any assembly node, and if so then the reference is deleted too. However, this 

follow up mechanism works only when it is the precise element specified for deletion that also is 

referenced from an assembly. I.e. it is not working if the element deleted holds a substructure into 

which assembly references are made. E.g. if a hull plate is assembled the assembly reference will 

be deleted if the plate is specifically deleted. But, if the hull panel is deleted the assembly reference 

is kept as an invalid reference and is denoted as <Missing> in assembly planning. To extend this 

general follow up mechanism with more assembly specific code would slow down the system as it 

is acting generally for all delete operations.  

As a solution an assembly planning specific core command is created that top down from the 

assembly selected will remove all references to parts no longer existing. This core command is at 

delivery not available from the Assembly Planning context sensitive menu, but can be added 

through the ordinary customize function. I.e. you can add your ―Clean invalid part references‖ 

function and connect the command "AVEVA.Marine.AssemblyPlanning.Clean" to it. The reason 

why it not is added from start is that it is a quite powerful command and should be used with 

caution and is better configured per user.  

 

 

Benefits 

Remove invalid assembly references. 

Compatibility Constraints 

None. 

For More Information 

Only noted here. 

Affected Programs 

Assembly Planning 
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18.3 New Drawing Type for Assembly ADP Drawings 

There is a new drawing type in 12.1, ―Assembly ADP drawing‖ dedicated for drawings created by 

the Assembly Automatic Document Production application. You can see that there is a new 

drawing type in the open/save drawing dialogues: 

 

 

 

If you want to handle the new drawing type in your project you need to assign two new logical 

names  in your marine project setup file (D065<proj>.sdb): 

 

SB_ASSADP_PDB                 SB_ASSADP_PDB 
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SB_ASSADP_PDB_PADD            <name_of_dept>;<name_of_regi> 

 This is for the system to recognize the type. 

This defines the name of the DEPT and then REGI where you want Marine Drafting to find your 

Assembly ADP drawings. 

Benefits 

To make a distinction between general assembly drawings and drawings generated by Assembly 

ADP. 

Compatibility Constraints 

Assembly Drawings created in earlier versions will still have the old drawing type (Assembly 

Drawing) and will thus not be listed as an Assembly ADP Drawing but as an Assembly Drawing. 

For More Information 

Only noted here, 

Affected Programs 

Assembly Planning 
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18.4 Multiple Select 

Description 

A very useful method for user to populate the assembly structure by design parts is provided by the 

drag & drop facilities. However, collection elements from Design Explorer only allow single element 

selection. With the EditElements addin, now available in the Hull and Outfitting Design modules, 

multiple element selection is enabled e.g. for collecting elements to assembly. 

This addin is enabled in Hull and Outfitting Design only for the purpose to facilitate multiple select. 

Additionally the addin exposes a general function to an edit element, such as create and delete.  

Please note that, although the addin is called Edit Elements, it must never be used to edit any 

elements in Hull. In Hull it is useful for listing members, making selections etc. 

Benefits 

Extended possibilities to make element selections for e.g. drag & drop operations. 

Compatibility Constraints 

None. 

For More Information 

Only noted here. 

Affected Programs 

Hull Outfitting Design 

Assembly Planning 
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18.5 Change Projection of an Assembly ADP Drawing 
View  

There are some improvements when using the Marine Drafting function Tools > Model view > 

Change Projection in an Assembly ADP drawing. Before there was a problem that labels and 

bounding box were not updated to fit the new projection. This is now taken care of. If the drawing is 

of type ‗Assembly ADP Drawing‘ then the user will be asked if he wants to regenerate the labels 

and bounding box. 

Limitations: 

This will only work for drawings that are of the new drawing type ‗Assembly ADP drawing‘.  

Assembly ADP drawing generated in previous program versions will not be handled since they are 

of another type. 

The utility doing the label and bounding box calculations is a part of the Assembly ADP application. 

Therefore this function will only work in Marine Drafting, not in Hull Design. 
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18.6 POS attribute available for ASMBLY Elements 

Description 

The ASMBLY element has been given a POSition attribute. The attribute is not yet used in any 

specific functionality but added for future purposes and to facilitate for some general (draft) 

functionality.  

Benefits 

None. 

Compatibility Constraints 

None. 

For More Information 

Only noted here. 

Affected Programs 

Assembly Planning 
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19. AVEVA Marine Drafting 

19.1 Symbolic View Menu 

Description 

All functionality handling symbolic views has been moved to a new top menu ―Symbolic View‖. 

The ―Symbolic View‖ menu is available in the following applications: 

 

 Hull Design – Curved Modelling 

 Hull Design – Planar Modelling 

 Hull Design – Structural Design 

 Hull Design – Space Management 

 Marine Drafting 

 

 

 

Please note that the menu function previously called ―Create‖ has now been renamed to 

―Section...‖ to unify the function names in this menu. 
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This means that the following has been removed: 

 The Planar Hull/View menu in Planar Modelling and Structural Design. 

 The Curved Hull/View menu in Curved Modelling and Structural Design. 

 The view handling buttons in the Model Selection dialog (Insert/Model). 

Benefits 

All symbolic view functionality is available in one single place making it easier to find these 

functions. 

All symbolic views are also available from Marine Drafting making it possible to use Marine 

Drafting for more types of drawings. 

Compatibility Constraints 

None. 

For More Information 

Please see the Hull Design documentation. 

Affected Programs 

Hull Design 

Marine Drafting 
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19.2 Default Action at Start-up 

Description 

Using a default variable INITIAL_DRAWING it is now possible to define what Marine Drafting and 

Hull Design should do at start-up. 

The following possibilities exist: 

 

Value of INITIAL_DRAWING Action 

NONE Do nothing (same as Hull Drafting 12.0). 

NEW Open a new drawing named UNTITLED<n> where <n> 

is selected so that UNTITLED<n> is non-existing. 

LAST Open the most recently used drawing during last 

session. 

ASK_NEW Show the New Drawing dialog. 

ASK_OPEN Show the Open Drawing dialog. 

 

Benefit 

Most functions in Marine Drafting require an open drawing so the first thing a user does is to either 

create or open a drawing. 

This new default variable will allow users to start working directly when Marine Drafting has started. 

Compatibility Constraints 

None. 

For More Information 

See User Guide Marine Drafting / Appendices / Drafting Default File Keywords / Miscellaneous. 

Affected Programs 

Hull Design 

Marine Drafting 
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19.3 New Module Name 

Description 

Hull Drafting has been renamed to Marine Drafting. 

This name change affects the following: 

 

Old name New name 

Hull Drafting Marine Drafting 

PDMSUI\hdra PDMSUI\mdra 

PMLLIB\hulldrafting PMLLIB\marinedrafting 

PMLLIB\hulldrafting\hDraPickElement.pmlfnc PMLLIB\marinedrafting\mDraPickElement.pmlfnc 

PMLLIB\hulldrafting\apphdramain.pmlfrm PMLLIB\marinedrafting\appmdramain.pmlfrm 

marhdra.exe mardra.exe 

 

Benefits 

Previous name was in many cases misleading and made customers confused when it came to 

which Drafting module to use. Using the Marine Drafting name strengthens our recommendation to 

use Marine Drafting for both hull and outfitting users. 

Compatibility Constraints 

Please note that in order to use Marine Drafting 12.1 with a project, the module definition in the 

project must be modified. This will be done using the upgrade script for 12.1. 

There is also a macro PDMSUI\mdra\admin\hdra2mdra.mac that can be used from the Admin 

module to change the module definition. 

It is important to note that any customisation done by customers that checks the module name 

might have to be modified to work properly. 

For More Information 

See User Guide Marine Drafting. 

Affected Programs 

Marine Drafting 
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19.4 Drawing Export Formats 

Description 

Marine Drafting can export a drawing to the following formats (File/Export): 

 DXF 

 HPGL 

 HPGL/2 

 IGES 

 SDB 

 SVG 

 TIFF with LZW compression 

The following formats have been removed: 

 CGM 

 TIFF with PackBits compression. 

Benefits 

Supporting both HPGL and HPGL/2 will make it easier for customer to interact with different 3rd-

party products. 

TIFF with LZW compression offers better compression. 

Compatibility Constraints 

The CGM format is no longer supported. 

For More Information 

See User Guide Marine Drafting / Operator’s Instructions / File / Export. 

Affected Programs 

Hull Design 

Marine Drafting 
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19.5 Navigate To 

Description 

The context menu available in the 2D canvas of Marine Drafting/Hull Design has been extended 

with a set of new ―Navigate to‖ functions: 

 

 

 

The functions are useful to quickly find out what a selected graphical entity represents. The 

functions will identify the closest entity in the drawing and navigate to the corresponding element in 

one of the explorers: ―Draft Explorer‖, ―Design Explorer‖ or the ―Marine Drawing Explorer‖. You will 

only see the effect of the function if the corresponding explorer is currently opened. 

Benefits 

It will make it easier to get information about a graphical entity in a drawing.  

Compatibility Constraints 

None. 

For More Information 

Only noted here. 

Affected Programs 

Hull Design 

Marine Drafting 
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19.6 General Note 

Description 

The General Note function is extended by multiple-lines feature and a new Options dialog. 

 

 

 

Benefits 

More user friendly way of creating general notes. 

Compatibility Constraints 

None. 

For More Information 

Only noted here. 

Affected Programs 

Hull Design 

Marine Drafting 
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19.7 Choose Projection 

Description 

The Choose Projection dialog has been re-designed. 

 

 

 

It can be displayed by clicking on the Projection button in the InsertModel… dialog: 

 

 

 

It is also displayed during drag & drop from an Explorer tree when choosing to drop an element 

into a new view, or by choosing the ToolsModel ViewChoose Projection menu function. 

Benefits 

This re-designed dialog provides a more modern and attractive user experience. 

The choose projection step during the Insert/Model process is now removed if the user wants to 

use the already selected view projection. 

Compatibility Constraints 

None. 

For More Information 

Only noted here. 

Affected Programs 

Hull Design 

Marine Drafting 



AVEVA Marine 12.1       User Bulletin 

Copyright 1974 to current year. AVEVA Solutions Ltd.   171 
 

19.8 Fill Styles 

Description 

The Outfitting draft Fill Style concept has been implemented in Marine Drafting, making it possible 

to add any combination of hatch patterns to contours in the drawing. A Fill Style can be system-

defined or user-defined, and contains the definition of an arbitrary number of hatch patterns.  

Compared to the existing Hatch Pattern functionality, the Fill Style concept is associative and can 

combine any number of Hatch Patterns. Also Solid Fill is available. 

The Fill Style can be applied to any contour in the drawing, closed or possible to close. It is also 

possible to apply the fill style on a general area defined by multiple contours. In both cases, the fill 

style will be persisted in PADD. 

The Fill Style can be selected and applied to contours in two ways:  

 MB right-click on a contour to define, or modify the fill style applied on that contour. 

 Select the Modify/Fill Style function to select a Fill style to apply to given contours. 

The dialog for selecting Fill Styles looks like below: 

 

 

 

Benefits 

Possibility to use the Outfitting Draft-defined Fill Styles in Marine Drafting, including association. 

Compatibility Constraints 

The new attributes added to HPATTErns (see Outfitting Draft) might not be handled in Marine 

Drafting. 

Note that the old Hatch Pattern concept will be deprecated in a future release. 



AVEVA Marine 12.1       User Bulletin 

Copyright 1974 to current year. AVEVA Solutions Ltd.   172 
 

For More Information 

See User Guide Marine Drafting / Operator’s Instructions / Modify / Fill Style. 

Affected Programs 

Hull Design 

Marine Drafting 
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19.9 Symbol Files 

Description 

The files holding the different symbol fonts have been changed from binary to ASCII format and 

renamed from d012syxxx.sbd to d012syxxx.port. The reason for this is that these files now will be 

easier to maintain and also somewhat more readable for the human eye (even though updating 

such a file still should be done with specific Drafting functionality). 

Benefits 

It will be easier for both provider and customer to maintain the new format. 

Compatibility Constraints 

The system-defined symbol font files will be delivered in the new ASCII format. However, please 

note that any symbol font files modified or created by the customer at site must be converted to the 

new ASCII format before it can be used. This is done by running the conversion utility sb022 that is 

part of 12.0 or older releases. 

Note also that the utility programs sb022 (convert from binary to ASCII format) and sb023 (convert 

from ASCII to binary format) have been withdrawn in this release. 

If needed, the 12.0 or older releases can be used. 

For More Information 

Only noted here. 

Affected Programs 

Hull Design 

Marine Drafting 
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19.10 Dynamic Highlighting 

Description 

During the creation/definition/indication of lines, arcs and contours in Marine Drafting, the resulting 

entity will now be dynamically highlighted as the cursor moves over the drawing. For example, 

when creating an arc segment with three points, the resulting segment is highlighted dynamically 

when third point is about to be defined. 

Dynamic highlighting is implemented during the definition of 

 Line segments:  all definition modes 

 Arc segments:  all definition modes except ―Point, radius and Tangent‖ 

 PolyLine segments: all definition modes 

 Ellipses: ―Circumscribed Rectangle‖ and ―Major & Minor Axis‖ and in the following 
functionality: 

 Modify/Stretch Node 

 Modify/Stretch Elbow 

 Insert Rectangle/Square with a fillet radius 

 Insert/Staircase 

Benefits 

Improved UI during geometry definition: resulting entity is pre-highlighted  

Compatibility Constraints 

None. 

For More Information 

Only noted here. 

Affected Programs 

Hull Design 

Marine Drafting 
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19.11 Arc Quarter Points 

Description 

The UI for defining a point on arc periphery has been improved. 

Instead of first indicating the arc and then keying in the angle, the Combo Box in the Geometry 

toolbar is now used to give the angle. Moreover, by selecting the ―Indicate‖ alternative in the 

Combo Box the point on the arc is defined as the periphery point closest to the arc indication. 

Periphery points close to one of the four cardinal directions will snap to the corresponding quarter 

points (0, 90, 180 and 270 degrees). 

Benefits 

Easy way of defining arc periphery points and in particular the quarter points. 

Compatibility Constraints 

None. 

For More Information 

See User Guide Marine Drafting / Operator’s Instructions / Format / Geometry mode / 2D points. 

Affected Programs 

Hull Design 

Marine Drafting 
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19.12 New Definition of Line Segment, Direction + 
Length 

Description 

When creating a Polyline, a new way of defining a segment has been implemented, namely ―Line 

by Direction and Length‖. It works in the same way as ―Line by two Points‖ except that the length of 

the resulting line is given in the Combo Box in the Geometry toolbar. 

Benefits 

This implements a convenient way of creating a line with a given direction and length. 

Compatibility Constraints 

None. 

For More Information 

See User Guide Marine Drafting / Operator’s Instructions / Format / Geometry mode / Polyline. 

Affected Programs 

Hull Design 

Marine Drafting 
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19.13 Simple Arithmetic in 2D Offset Input 

Description 

When giving an offset during point definition, it is now possible to key in simple arithmetic 

expressions in the 2D Offset input dialog. For example, the following input is valid: 0.02*300 + pi N. 

Benefits 

Simple arithmetic accepted in the offset input dialog. 

Compatibility Constraints 

None. 

For More Information 

Only noted here. 

Affected Programs 

Hull Design 

Marine Drafting 
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19.14 Automatic Chaining of New Contours to 
Existing Ones 

Description 

When creating a new contour, this will optionally be chained to existing contours in the drawing. 

This options is controlled by a new Drafting default keyword AUTO_CHAIN with values ―Yes‖ or 

―No‖ (system default). 

The system will compare the start and ending points of a new contour with the ones of existing 

contours structurally belonging to the same component as the created one. If any of them 

coincides with the start/ending points of the new contour it will be chained to the new contour. Note 

that at most two contours can be chained to the new geometry, one in the beginning and one in the 

end. 

The criterion for an existing contour to be chained to the created one is thus: 

 AUTO_CHAIN is set to ―Yes‖ 

 The existing contour belongs to the same component as the created one 

 The existing contour is not closed 

 The start or ending points of the existing contour coincides (zero tolerance) with the 
start/ending points of the created contour  

The Automatic Chain concept is implemented in the following functions: 

 Insert/Polyline 

 Insert/Staircase 

Benefits 

This will improve productivity. Instead of invoking the Modify/Chain function as post-action, the 

chaining is performed automatically as new contours are created. 

Compatibility Constraints 

None 

For More Information 

See User Guide Marine Drafting / Appendices / Drafting Default File Keywords / Miscellaneous. 

Affected Programs 

Hull Design 

Marine Drafting 
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19.15 Dimensioning UI Improvements 

Description 

A ‖Reset‖ button has been implemented in all dimension dialogs. 

Clicking it will reset the dimension text to its system default value (e.g. #DIM() for linear 

dimensioning). 

When positioning the result of a linear dimensioning (2D, 3D or Axis-parallel), the complete 

graphics (except witness lines) will be highlighted instead of just the dimension lines. 

When positioning the result of a linear dimensioning (2D, 3D or Axis-parallel), it is now possible to 

change the dimensioning parameters (text height etc) without having to re-define all measure 

points. Instead of pressing Cancel and enter the ―Advanced‖ function in the dimension dialog, just 

click Options and do the parameter changes without losing the given measure points. 

Benefits 

This will improve productivity in dimensioning functions. 

Compatibility Constraints 

None. 

For More Information 

Only noted here. 

Affected Programs 

Hull Design 

Marine Drafting 
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19.16 Improved Dragging Technique 

Description 

During dragging, the highlight colour will be the same independently of the background colour (like 

steady highlighting). 

TrueType texts will now be dragged with full display. 

Benefits 

This will improve graphic feedback. 

Compatibility Constraints 

None. 

For More Information 

Only noted here. 

Affected Programs 

Hull Design 

Marine Drafting 
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19.17 Plane Reference Text in Distance-To-Plane 
Dimensioning 

Description 

In the Distance To Plane dimensioning, when principal plane is Centre Line, Base Line or Aft 

Perpendicular, modifications of the Plane Reference Text will be remembered and saved in the 

Drafting default system. 

For this purpose, three new default keywords have been introduced: 

 

Keyword System Default 

DIM_DTP_BASELINE_REF_TEXT 
― from BL‖ 

DIM_DTP_CENTRELINE_REF_TEXT 
― off CL‖ 

DIM_DTP_AFTPERPENDICULAR_REF_TEXT 
― from AP‖ 

 

Benefits 

This will improve productivity. The system remembers user modifications of Plane Reference Text. 

Compatibility Constraints 

None. 

For More Information 

See User Guide Marine Drafting / Appendices / Drafting Default File Keywords / Dimensioning. 

Affected Programs 

Hull Design 

Marine Drafting 
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19.18 Delete Last Entity 

Description 

The Edit/Delete/Last Entity functionality has been re-introduced. 

Benefits 

Make it possible to ―undo‖ last created entity without having to exit current function and explicitly 

delete the entity. 

Compatibility Constraints 

None. 

For More Information 

See User Guide Marine Drafting / Operator’s Instructions / Edit / Delete / Last entity. 

Affected Programs 

Hull Design 

Marine Drafting 
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19.19 Persisting Contours to PADD 

Description 

In 12.1 release of Marine Drafting, persistence to PADD has been further implemented. 

Creation and modification of contours will now be persisted in most situations, like: 

 All Insert functions, except Spline and Fillet 

 Modify/Transform and Copy 

 All Modify/Trim functions (To Entity, By Length, Gap, Cutout) 

 All Modify/Stretch functions (Node, Elbow, By Polygon) 

 Modify/Chain and Dechain 

 Modify/Fill Style 

 Tools/Subpicture/Regroup and Split 

However, any persistence of contours must be explicit enabled by the user, by setting the 

environment variable TB_ENABLE_PERSIST_CONTOUR to ―Yes‖ 

Benefits 

More drawing information persisted in PADD. 

Compatibility Constraints 

None. 

For More Information 

Only noted here. 

Affected Programs 

Hull Design 

Marine Drafting 
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19.20 Text Font Attributes 

Description 

The attributes Bold, Underline and StrikeOut of texts using legacy system fonts will now be 

displayed properly. 

Benefits 

This will improve graphic feedback. 

Compatibility Constraints 

None. 

For More Information 

Only noted here. 

Affected Programs 

Hull Design 

Marine Drafting 



AVEVA Marine 12.1       User Bulletin 

Copyright 1974 to current year. AVEVA Solutions Ltd.   185 
 

19.21 Dimming & Checking of Menu Items 

Description 

The enabling and checking of menu items and toolbar buttons has now been implemented and will 

reflect the current context and state. 

Benefits 

This will improve productivity. 

Compatibility Constraints 

None. 

For More Information 

Only noted here. 

Affected Programs 

Hull Design 

Marine Drafting 
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19.22 Unicode 

Description 

Better support for Unicode (i.e. non-latin characters such as Korean, Chinese and Japanese) has 

been added to Marine Drafting. Unicode characters may be used in the following areas: 

 Drawing names  

 Values of Drafting‘s default variables  

 Dimension annotations 

 Model names (except Hull) 

 MarAPI (nb. Limited or no support for Unicode in Hull functions) 

Benefits 

Supporting Unicode e.g. provides functionality to make annotations in the user‘s native language. 

Compatibility Constraints 

There is limited Unicode support among the Hull Design specific functions. 

For More Information 

Please see the Marine Drafting documentation. 

Affected Programs 

Hull Design 

Marine Drafting 



AVEVA Marine 12.1       User Bulletin 

Copyright 1974 to current year. AVEVA Solutions Ltd.   187 
 

19.23 Restriction of Symbolic Views 

Description 

An additional option has been added to the function Symbolic View/Planar Hull View/Modify to 

change the restriction of an existing symbolic view.  

The restriction could be  

 an existing contour,  

 a contour created interactively or  

 an infinite line (the user is asked to choose the side of the line were the geometry is to be 
kept. 

There is also an option to make a new view as the restricted view. 

Note that this restriction is an addition to the restriction possible in the view/create function with 

limitation in the principal axis. 

The second tab Limits contains the limits.  

 

It is possible to take away the restriction made in View/modify by removing the tick for the restrict 

button. 

Benefits 

Enables the view to be restricted in a more flexible way. 

Compatibility Constraints 

None. 
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For More Information 

Only noted here. 

Affected Programs 

Hull Design 

Marine Drafting 



AVEVA Marine 12.1       User Bulletin 

Copyright 1974 to current year. AVEVA Solutions Ltd.   189 
 

19.24 Inspect Drawing 

Description 

In some cases, text will not be displayed properly on drawings migrated from Tribon M3 to AVEVA 

Hull & Outfitting 12. One reason could be that the codepage used to encode multibyte text has 

been changed to UTF-8 in AVEVA Hull & Outfitting 12. The ‗Inspect Drawing‘ function has been 

extended with an option to correct such texts. This new function displays a dialog box presenting a 

list containing all texts within the current drawing, and the user can choose which texts to convert. 

Benefits 

Make it possible to correct texts with the wrong codepage. 

Compatibility Constraints 

None. 

For More Information 

Only noted here. 

Affected Programs 

Hull Design 

Marine Drafting 



AVEVA Marine 12.1       User Bulletin 

Copyright 1974 to current year. AVEVA Solutions Ltd.   190 
 

19.25 Draw Assemblies 

Description 

There are new ways to insert an assembly into the drawing. The first one is in the ―Insert model‖ 

dialog which has been updated with a new line for assemblies: 

 

 

 

In the name field you can give the name of an assembly object optionally with wild cards. In the 

―Block/Zone/Wld/Env/Asm‖ you can give a name of an assembly or assembly world element. If 

given, the search will be limited to assemblies below this element. If this field is left empty the 

whole MDB is searched. 

The second possibility to add an assembly to the drawing is to use drag&drop from the design 

explorer: you select an assembly in the design explorer drag it and drop it in a view in the current 

drawing. (The drag&drop is a new feature in this release, please see a separate release note for 

more documentation.) 

Another improvement is that the assembly is always shown with the correct number of parts. One 

effect of this improvement is that the appearance of hull models may be different from what it was 

in previous releases regarding line styles, colours, p-lines etc.  The appearance of the hull models 

will now be controlled by the representation rule set defined for the view. This is valid for all view 

types (―Wireline‖, ―Wireline Hidden Line‖, ―Modelled Wireline‖, ―Local Hidden Line‖, ―Global Hidden 

Line‖ and ―Universal Hidden Line‖). 
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Benefits 

It is easy to add assemblies to the drawing. The assemblies are always drawn with correct number 

of parts. 

Compatibility Constraints 

The appearance of hull models may be different from what it was in previous releases regarding 

line styles, colours, p-lines etc. 

For More Information 

Only noted here 

Affected Programs 

Hull Design 
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19.26 RSO Default Colours 

Description 

An RSO is given a default colour related to the type of RSO. The following colours are used: 

 

RSO Type Colour 

Compartment limit Blue 

General Inner Structure Steel blue 

Block Limit Navy Blue 

General Limit Slate blue 

Backdrop Light blue 

 

The colour settings are valid both when an RSO is drawn in drawings and when drawn in the 3D 

canvas. 

Benefits 

Easier identification of RSOs. 

Compatibility Constraints 

None. 

For More Information 

See User Guide Structural Design / Functions Overview / Functions in the Functional Structure 

Menu. 

Affected Programs 

All programs with graphical presentation of RSOs 
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19.27  RSO Enhancements in Insert Model 

Description 

Input Model has been enhanced to allow users to easier select and insert RSOs into a drawing.  

RSO selection can now be filtered on type. Wanted type can be selected from a drop-down list with 

the following values: 

 

The values in the drop down list corresponds to 

 Any type (no filtering) 

 Compartment Limit 

 General Inner structure 

 Block Limit 

 General Limit 

 Backdrop 

RSO selection can now also be made on envelope. All RSOs belonging to a given envelope are 

selected. 

It is no longer necessary to specify the ―_RSO_‖ prefix when keying in the name of an RSO in the 

input field. 

Benefits 

Enables RSO modelling to be made in a more flexible way. 

Compatibility Constraints 

None. 

For More Information 

See User Guide Structural Design / Functions Overview / Functions in the Functional Structure 

Menu. 

Affected Programs 

Hull Design 

Marine Drafting 
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19.28 Curved Panel Holes in Input Model 

Description 

Curved panels presented using the function Input model now displays holes defined to be marked 

with a dashed line type. 

Benefits 

The model display reflects the design more correctly. 

Compatibility Constraints 

None 

For More Information 

Only noted here. 

Affected Programs  

Hull Design 

Marine Drafting 
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19.29 Base Line Position Ruler 

Description 

The Base Line ruler is always located at zero height in the ship. But there are other 

constructions/ships where it would benefit if this ruler could be located at another height. To be 

able to control this, a new default keyword, BASE_LINE_POSITION, has been added. By 

assigning a height to this keyword, the base line in the project can be set to another default 

position. If not given, the height zero will be applied. 

Affected functions are: 

 Dimension  3D  Distance to Plane  Leader  4 BL 

 Dimension  3D  Distance to Plane  Box  4 BL 

 Annotate  Position Ruler  Base Line 

Benefits 

Makes it possible to have different Base line and take automatic measure from that. 

Compatibility Constraints 

None 

For More Information 

Only noted here. 

Affected Programs  

Hull Design 

Marine Drafting 
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19.30 Overlays 

Description 

The ability to use overlays on a drawing has been added to Marine Drafting. Overlays may take the 

form of external plot files (.plt), or may be database elements. 

An overlay sheet can be placed anywhere on the drawing sheet, and can be of any size. Any 

number of overlay sheets may be used on a drawing sheet. 

Benefits 

Overlays have been made available to Marine Drafting and Hull Design. 

Compatibility Constraints 

None. 

For More Information 

See User Guide Outfitting Draft / Underlays and Overlays. 

Affected Programs 

Hull Design 

Marine Drafting  
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19.31 Protection of the Drawing Form View 

Description 

In order to give Marine Drafting users better control of how to protect the contents in the drawing 

form view, the Drafting keyword ALLOW_TEXT_MODIFICATION_IN_FORM_RULE has been 

replaced by the keyword ALLOW_MODIFICATION_IN_FORM_VIEW.  

 
Keyword: 

  
ALLOW_MODIFICATION_IN_FORM_VIEW 

  
System default value: 

  
"No" 

  
Explanation: 

  
User can modify protection flag for contents in the drawing form view. 

  
Legal values: 
 
"No" :    Whole form view is protected from modification 
"OnlyRuleBasedText" : Texts defined by rules can be modified 
"Yes" :    Contents of whole form view can be modified 
 

Benefits 

Better control of how to protect the contents in the drawing form view. 

Compatibility Constraints 

The old keyword ALLOW_TEXT_MODIFICATION_IN_FORM_RULE has been removed. 

For More Information 

See User Guide Marine Drafting / Appendices / Drafting Default File Keywords / Miscellaneous. 

Affected Programs 

Hull Design 

Marine Drafting 
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19.32 Open Drawing 

Description 

Lookup of drawings using the ―Open Drawing‖ dialog can be slow in projects with a large number 

of drawings. This functionality has been improved using a type index. 

This means that from this release it is often preferable to have the ―Search all departments‖ option 

checked. The initial value of this option is controlled via the Marine Drafting default keyword 

―SEARCH_ALL_DEPTS‖. 

It is also advisable to give one or more initial characters before a wild card since it speeds up the 

search significantly. 

Please note that if the search string starts with a wild card and ―Search all departments‖ is not 

checked, the performance will be as in previous release. 

Benefits 

Lookup drawing view name and type in the ―Open Drawing‖ dialog is much faster. 

Compatibility Constraints 

None 

For More Information 

Only noted here. 

Affected Programs 

Hull Design 

Marine Drafting 
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19.33 Drag and Drop to the 2D Canvas. 

Description 

It is possible to drag and drop model items onto the 2D Canvas. The result of a successful drag-

drop operation matches that of an ―Insert Model‖ using the ―Insert Model‖ dialog. 

It is possible to drag items to create new views, insert into a specific view or insert into all views. 

The new functionality includes standard left mouse button drag drop, right mouse button drag drop 

and other sources such as dragging items from other gadgets than the explorer, e.g. the ―Search 

Result‖ and ―My Data‖. 

Benefits 

Easy ways to insert Model to the 2D canvas. 

Compatibility Constraints 

None 

For More Information 

See User Guide Marine Drafting / Model Viewing and General Drafting / Common Functions and 

Routines / Drag and Drop to the 2D Canvas. 

Affected Programs 

Hull Design 

Marine Drafting 
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19.34 Marine .NET API (hull views) 

Description 

All hull symbolic views can now be created and modified from the user-interface of Marine Drafting 

12.1. The corresponding Marine .NET APIs have therefore been implemented into the 

AVEVA.Marine.Drafting namespace as well. 

The following Marine .NET APIs have been implemented in the AVEVA.Marine.Drafting 

namespace. 

Please note that some APIs have been renamed to reflect changes in menus. The changes are 

marked with bold. 

Please also note that MarDrafting.Recreate is used to recreate all kinds of hull views. 

 

Old (still available, marked as obsolete) 

Aveva.Marine.Design 

New 

Aveva.Marine.Drafting 

MarChm.ViewBodyPlanNew MarDrafting.ViewBodyPlanNew 

MarChm.ViewCurvedPanelNew MarDrafting.ViewCurvedPanelNew 

MarChm.ViewDevPlaNew MarDrafting.ViewDevPlaNew 

MarChm.ViewShellXNew MarDrafting.ViewShellXNew 

MarChm.ViewShProfNew MarDrafting.ViewShProfNew 

  

MarChm.ViewModify MarDrafting.ViewCurvedModify 

MarChm.ViewRecreate MarDrafting.ViewRecreate 

  

MarHullPan.ViewDetailNew MarDrafting.ViewDetailNew 

  

MarHullPan.ViewSymbolicModify MarDrafting.ViewSectionModify 

MarHullPan.ViewSymbolicRecreate MarDrafting.ViewRecreate 

  

MarHullPan.MAR_BRACKET MarDrafting.MAR_BRACKET 

MarHullPan.MAR_BRACKET_PML MarDrafting.MAR_BRACKET_PML 

MarHullPan.MAR_FLANGE MarDrafting.MAR_FLANGE 

MarHullPan.MAR_FLANGE_PML MarDrafting.MAR_FLANGE_PML 

MarHullPan.MAR_SEAM 
MarDrafting.MAR_SEAM 

MarHullPan.MAR_SEAM_PML MarDrafting.MAR_SEAM_PML 
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MarHullPan.MAR_STIFFENER MarDrafting.MAR_STIFFENER 

MarHullPan.MAR_STIFFENER_PML MarDrafting.MAR_STIFFENER_PML 

 

The following APIs have been renamed to reflect changes in menus. 

 

Old (still available, marked as obsolete) 

Aveva.Marine.Drafting 

New 

Aveva.Marine.Drafting 

MarDrafting.ElementIsSymbolicView MarDrafting.ElementIsSectionView 

MarDrafting.ViewSymbolicNew MarDrafting.ViewSectionNew 

MarDrafting.ViewSymbolicModelTra MarDrafting.ViewSectionModelTra 

 

It is strongly recommended that you change your customisation files (C#, PML) to use the APIs 

from AVEVA.Marine.Drafting as soon as possible. 

Benefits 

A Marine Drafting 12.1 license is sufficient to be able to create hull views using the Marine .NET 

API. 

Compatibility Constraints 

The APIs have been marked as obsolete in the AVEVA.Marine.Design namespace. 

They will continue to be available in this namespace in 12.1 but they will be removed in a future 

release. 

When using the APIs from the AVEVA.Marine.Design namespace, you will get a warning when 

building a C# solution. 

For More Information 

See User Guide Customisation / :NET Customisation / Hull and Marine Drafting .Net API. 

Affected Programs 

Hull Design 

Marine Drafting 
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19.35 Removing Default Variables 

Description 

A number of default variables used in earlier releases of Drafting, but not in Hull Drafting 

12.0/Marine Drafting 12.1, have been removed to avoid unnecessary confusion. The obsolete 

default variables that have been removed are listed below. 

Tribon M3 Outfitting has been replaced by AVEVA Outfitting so the following default variables are 

no longer valid: 

 FLOW_UNIT_SYSTEM 

 IMPEDANCE_UNIT_SYSTEM 

 INDUCTANCE_UNIT_SYSTEM 

 LUMINANCE_UNIT_SYSTEM 

 PDI_STRUCTURE_VRML 

 PDI_TRANS_STRUCTURE 

 PRESSURE_DROP_UNIT_SYSTEM 

 STRUCT_COMP_CODE_DET 

 STRUCT_COMP_CODE_DRAW 

 STRUCT_COMP_VOLUME_COLOUR 

 STRUCT_KEEP_INSERT_OBJ 

 STRUCT_KEEP_STAND_REF 

 STRUCT_MODULES_IN_HULL 

 STRUCT_MODULES_IN_OUTF' 

 TEMPERATURE_UNIT_SYSTEM 

 VELOCITY_UNIT_SYSTEM 

The volume concept in Tribon M3 has been replaced by AVEVA Outfitting so the following default 

variables are no longer valid: 

 INCL_COMP_VOLUME_EVENT_POINTS_IN_EQUIP 

 INITIAL_VOLUME_DB 

 PLACVOL_NAME_CODE 

The database in Tribon M3 has been replaced by Dabacon so the following default variables are 

no longer valid: 

 AUTO_CLEAN_WORKSPACE 

 BACKUP_ACT 

 BACKUP_TIME 

The control point concept in Tribon M3 has been removed so the following default variable is no 

longer valid: 

 DIM_CONTROLPOINT_MID_TOL 

Benefits 

Avoid confusion by not showing obsolete default variables in the Format/Defaults dialog. 
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Compatibility Constraints 

Not applicable. 

For More Information 

Only noted here. 

Affected Programs 

Hull Design 

Marine Drafting 
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19.36 TBSystemFonts 

Description 

It is a known issue that the old legacy fonts do not function very well in AVEVA Marine 12. These 

fonts are: 

 TBSystemFont0 

 TBSystemFont1 

 TBSystemFont2 

 TBSystemFont3 

 TBSystemFont4 

 TBSystemFont5 

 TBSystemFont6 

 TBSystemFont7 

 TBISOFont101 

 TBISOFont105 

The issue is that these fonts cannot be used for text elements stored in the PADD database. This 

is for example all texts created with the ―Insert\Text‖ function in Marine Drafting.  TBSystemFonts 

will in this case be replaced with a default true type font. 

In 12.1 we have introduced a way to map a TBSystemFont with any true type font available in the 

project. The mapping is primarily intended to be used when migrating drawings from M3 to 12. 

The font mapping is setup in a file with a simple format, where each TBSystemFont can be 

associated with a true type font (separated by a blank or a TAB). The name of the file is assigned 

to the environment variable ―TB_SYSTEMFONT_MAP‖. This is a sample file: 

 

TBISOFont101 Arial Unicode MS 

TBISOFont105 Lucida Sans 

TBSystemFont0 Arial Unicode MS 

TBSystemFont1 Times New Roman 

TBSystemFont2 Times New Roman 

TBSystemFont3 Times New Roman 

TBSystemFont4 Courier New 

TBSystemFont5 Courier New 

TBSystemFont6 Lucida Sans 

TBSystemFont7 Times New Roman 

 

The font mapping will affect the text font when: 

 migrating a drawing with the SY013 migration utility 

 importing a drawing with the ―File\Import\SDB‖ utility 

 importing a drawing with the Copy Assistant utility. 

Benefits 

TBSystemFonts can be replaced with any true type font available in the project, not only the default 

font. 

Compatibility Constraints 
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None 

For More Information 

Only noted here 

Affected Programs 

Hull Design 

Marine Drafting 
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19.37 Persisting of part level modifications in Linear 
Dimensions 

Description 

In Marine Drafting 12.1, it is now possible for the user to get certain ―part level‖ modifications in 

linear dimension persisted in Dabacon.  Modification on ―part level‖ means e.g changing the size, 

position, value, colour etc. on individual measure texts in a linear dimension. 

The Modify/Dimension sub-functionality has changed slightly 

  

 

 

 

Move Dimension Line 

 

No change of functionality. Modification is persisted.as before. 

To be more specific, the caption text has been changed slightly. 

 

Slant Witness  Line 

 

No change of functionality. Modification is persisted as before. 

 

Presentation 

 

No change of functionality. Modification is persisted as before. 

 

Text Properties 
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Functionality has been improved: Here the user can toggle between updating on component level 

(whole dimensioning) and part level (individual texts in it). To toggle, just press the Option button 

when the system asks the user to indicate the dimensioning (text) to modify. Modifications both on 

component and part level will be persisted. 

The following properties can be modified: 

 Font 

 Size 

 Aspect 

 Slant 

 Colour 

 

Text Value 

 

Functionality has been improved: Here the user can toggle between updating on component level 

(whole dimensioning) and part level (individual texts in it). To toggle, just press the Option button 

when the system asks the user to indicate the dimensioning (text) to modify. Modifications both on 

component and part level will be persisted. 

 

Move Dimension Text 

 

Functionality has been improved and renamed (from Transform Text): Here the user can move 

individual texts within an arbitrary linear dimensioning. The changed position of the measure text 

will be persisted. 

 

Flip arrow 

 

No change of functionality. Modification is not persisted as before. 

 

In case the Drafting default keyword DENY_UPDATE_OF_NON_PERSISTED_GEOM is set to 

―Yes‖, the same part-level functionality that is offered within the Modify/Dimension function can be 

also be invoked by clicking the right mouse button (RMB) on a text in a linear dimensioning and 

selecting one of the submenus: 

 

RMB/Edit (or Edit/Text) 

same functionality as Modify/Dimension/Text Value 

 

RMB/Move (or Modify/Move/Text) 

Same functionality as Modify/Dimension/Move Dimension Text 

Note the whole dimension line will not be moved (as in 12.0), but only the indicated text within the 

dimensioning 

 

RMB/Properties 

Same functionality as Modify/Dimension/Text Properties 
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Benefits 

Improved productivity in dimensioning modifying functions. 

Compatibility Constraints 

None 

For More Information 

Only noted here. 

Affected Programs 

Hull Design 

Marine Drafting 
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20. AVEVA Outfitting Draft 

A number of improvements have been made to Outfitting DRAFT and its associated applications. 

20.1 Extended Hatch Patterns  

This development has three components: 

 An additional 12 system-defined Fill Styles (or patterns) bringing the total to 30. These 
cover patterns such as brickwork and concrete and are shown in Fig 8-6 of the updated 
DRAFT User Guide. 

 Creation of user-defined Fill-Styles has been enhanced to allow the use of non-solid line-
styles. Two new attributes have been added to HPATTErns (see below). These provide 
values for new Wigwam parameters. As a result, users can create very complicated 
patterns. 

 The existing GUI, allowing users to pick the system-defined Fill Styles, has been extended 
to include the 12 new ones. This meant the provision of 12 new icon files. 

In addition, hatch and fill patterns are now exported to DXF as the appropriate entities rather than 

lines. 

20.2 Line Styles 

User-defined LineStyle & FillStyle elements have a system-generated Style Number that should be 

unique within the MDB. These attribute values are automatically created upon element creation. 

However, if a DRAFT database containing a Style World (STYLWL) is added to an MDB that 

already has a STYLWL it is possible for duplication of numbers to occur.  

At Hull & Outfitting 12.0, it is the later of the duplicates (in database order within the MDB) that has 

precedence when a Style of a given number is used. This is opposite to the case of duplicate 

names where it has always been the first that has precedence.  

At Hull & Outfitting 12.1, this has been changed to ensure consistency of behaviour between 

duplicate styles and names. When an MDB contains Styles with duplicate Style Numbers, it is the 

first (in database order within the MDB) that will be used when that Style Number is used to draw 

graphical elements. 

20.3 Line Widths  

Hull & Outfitting 12.1 has been enhanced to allow accurate line widths to be output in all output 

formats. The definitions of the system line-styles are held in the System database and set up in the 

Admin module, using Line-style Width Definition elements (LSWIDDEFINITION) in a new Line-

style World Element (LINESTYLEWORLD).  

The upgrade from Hull & Outfitting 12.0 to 12.1 can do this or Hull & Outfitting can be left to use its 

default values. The AVEVA sample projects are provided with this hierarchy and new projects will 

also be created with it present. 

Full details are given in the various Draft User Manuals and the Administrator User Guide. 

20.4 System Defined Line Styles 
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The system line widths of THIN, MEDIUM, and THICK are now configurable in ADMIN using the 

new line-style hierarchy in the system database.  

By default, they have been changed to standard values from the ISO 128 standard, which specifies 

line widths of: 0.18, 0.25, 0.35, 0.5, 0.7, 1.0, 1.4, & 2.0 mm. The values chosen for THIN, MEDIUM 

and THICK are: 0.25, 0.35 and 0.7 mm, rather than the former 0.22, 0.5, & 0.7 mm. 

The Minimum pen line width, formerly set by a gadget on the Plotting Options form, no longer 

appears. This is a parameter of the Plot command and is no longer required as the user has much 

better control of the widths. A very low value will be treated as the minimum width allowed for the 

format specified – PDF, DWG, etc. These may vary or have some special meaning. 

Note: the line width resolution of PDF output is currently controlled by a reference printer, which is 

either the user‘s default printer (if there is one) or the user‘s screen resolution. If the resolution of 

the said printer is 600dpi, it will not be sufficient to show the difference in width of the example lines 

on A0. One way to prevent this problem from occurring is to set a default printer with a higher 

resolution, say 1200 dpi. 

20.5 User Defined Line Styles 

User-defined line-styles will no longer be converted to a multiple of 0.2mm. Instead the precise 

width in mm specified by the user will be transferred directly to the export format. 

20.6 Minimum Line Width 

The MINLW parameter is configurable by the user in the DRAFT UI and via the DRAFT PLOT 

command; it was used to change the value of both THIN and the minimum user-defined line-style 

width. It applied only to the hardcopy exports (PDF, EMF etc) and did not affect DXF or AVEVA 

PLOT files. 

It is no longer required, as the line-styles are now precisely defined. It has been withdrawn from the 

UI and the PDMSUI/dflts/plotter_user_defaults file where its default value was defined.  

Its use with the PLOT command is deprecated: its value is ignored and a warning given if it is 

used. 

Note that this means that the user no longer has a way to artificially thicken thin lines on a drawing 

during export. This was introduced at 12.0 and was a side effect of allowing the user to determine 

the value of THIN line-styles. 

20.7 Plotting User Interface 

20.7.1 DRAFT “Plotting Options” Form 

The plot utility form, accessed from Utilities > Plot CE > Plotters, no longer has the Minimum Line 

width fields at top left: 
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Dimension Origin

(by intersection)

  Dimension Direction

Dimension Direction 29.60

 

20.7.2 DXF – General Options 

The "Polyline width factor" and "Character encoding" 

fields have been removed from the DRAFT ―DXF - 

General‖ form, which is accessed from:  

   Utilities > Configurable DXF output > Modify > 

General 

or in Draft administration mode: 

   Settings > DXF configuration settings > General 

 

 

20.8 Enhanced Angular Dimensions  

Angular Dimensions (ADIMs) no longer need to have 

their origin defined, if it can be deduced from the 

vectors defined by their first two dimension points. 

Typically these are directions defined by P-lines but 

they can also be defined by P-points. 

For example, the figure shows an Angular Dimension 

with its origin defined implicitly by the intersection of 

the two Dimension directions, which are P-lines of 

SCTNs.  

This Angular Dimension could be created by typing 

the following commands, starting at Layer level: 

NEW ADIM     Create new Angular Dimension element 

FROM DIR IDPL @ TO DIR 

IDPL @  

Use cursor to pick P-lines defining the first and 

second Dimension Directions. 

DPOS @  Use cursor to pick a Sheet position through which the 

Dimension Arc will pass. 

For full details, please refer to the DRAFT User Guide, section 12.6 Angular Dimensions, which 

has been extensively revised. 
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20.9 Enhanced P-line Picking 

There is now an option for P-lines to behave in a similar fashion to P-points when creating 

annotation. If enabled on a View, P-lines appear as the mouse passes over them so that they can 

be picked. They can of course also be made part of the SCTN‘s permanently visible representation 

when required on the drawing. 

The number of P-lines drawn thus can be limited by use of their PVIF attribute, as for P-points. 

Performance for Update Design when drawing sections with a large number of P-lines will 

therefore be improved by making suitable adjustments to the catalogue! Pseudo-attributes 

PLVIFlag and PLVISibility, equivalent to the PPVIF and PPVIS attributes, are also available. 

The behaviour for picking is as previous versions when the new option is ‗OFF. 

For full details, please refer to the DRAFT User Guide. 

20.10 Improved Performance of Extrusions  

These enhancements are focused on speeding up Extrusions and Panels by improving the 

handling of their vertices. Vertex (VERT) & Panel Vertex (PAVE) elements have 10 p-points, 

mostly for dimensioning purposes. Each p-point number has a particular functional position: 

  P0 Origin of Vertex 

  P1  Bottom panel face in line with panel vertex 

      P2   Midway through panel in line with panel vertex 

      P3   Top panel face in line with panel vertex  

      P4, P6   Bottom face tangent points (for filleted radius at vertex) 

      P5, P7   Top face tangent points (for filleted radius at vertex) 

      P8  Bottom face fillet centre 

      P9  Top face fillet centre. 

There are two changes to improve performance: 

 calculate all the p-point positions in one go when drawing them in Draft 

 omit P5 to P9 when the fillet radius is zero, as they are coincident with the first four 

20.11 Drawing Gridlines  

Plant Design grids (GRIDSYstem and GRIDAXis elements) may now be added to IDLists, but may 

not be the sole member of the IDList. They are drawn using the Centreline Style/Colour; their 

GRIDLNs are considered to be of infinite length and so are extended to the VIEW boundary. AUTO 

commands ignore these elements when calculating the VSCA, THPOS, and SIZE attributes of a 

VIEW.   

For details, please refer to the DRAFT User Guide, section 4.2, 4.3 and 12.9. 

20.12 Intelligent Text Handling Enhancement 

Draft allows all Design and Catalogue database attributes and pseudo-attributes to be used in the 

annotation of drawings. It is also possible to use attributes of related elements; for example, #SITE 

gives the name of site owning the referenced element.  

Hull & Outfitting 12.1 additionally allows the more commonly used position attributes (POS, HPOS, 

TPOS, APOS, TPOS, NPOS, POSS, POSE, DRPS and DELP) to be qualified so as to provide 

only one of the coordinates. For example: 

 #POS full 3D position, e.g. W12250 N7890 U3120 

 #POSE Easting coordinate only, e.g. E12250, W9675 
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#POSN, #POSU, #POSX, #POSY, #POSZ are also provided. 

Note that the codeword #POSE can have two meanings depending on the context: for SCTNs it 

means the POSE attribute (Section End Position), in other cases it means the Easting of the POS 

attribute  

For other position attributes, single coordinates can be obtained by using a single index qualifier. 

For example: 

 #GCOFG[2] would give the Northing (Y coordinate) of the Gross Centre of Gravity. 

Positions can be output in ‘+/-‘ format by appending ‘+’ to the codeword. For example: 

 #POS+    would give -12250 +7890 +3120 for the example above 

For full details, please refer to Chapter 14 of the DRAFT User Guide. 

20.13 Export to CAD Formats  

Significant improvements have been made to the export of DXF, DWG and DGN format files from 

Draft, using the ‗configurable‘ drivers (Draft_XXX_LI).  

Recommended AutoCAD versions are 2007-2010, as shown in section 2.9.1. The DXF version 

used is now AutoCAD 2006, so it cannot be supported in earlier releases. Recommended 

MicroStation format is now v8. Additional limitations may apply for earlier releases. 

For full details of configuration, please refer to the Draft User Manual. 

20.14 Support for Unicode Text 

Drawing export to recent releases of AutoCAD and MicroStation should now cope with all 

supported languages for which the computer is set up. Full support is not possible for AutoCAD 

releases before 2007 or for MicroStation DGN v7 format. As noted elsewhere (see section 4.1.3), it 

is recommended that Latin filenames are used. 

20.15 Improved Drawing Feature Export 

These changes should result in a much more usable drawing and smaller file sizes. The main 

improvements for the 3 formats are: 

 User defined Line-styles:  defined with PATDEF and PATREP but not PATNAM  

 Fill Styles: export in native format hatch entities for all system defined styles 1-30: this 
includes the new ones (see section 20.1) 

The following limitations apply: 

 Draft's intelligent blanking primitives are not exported  

 User-defined line styles with Glyphs and line pictures are not supported 

 Only ―built-in‖ line patterns are supported at present for layer definitions, not the full range 
of configurable line patterns 

20.16 Configurable DXF & DWG Export  

Improvements also include: 

 Symbols and Logos are exported as Nested Blocks; differentially scaled symbols are 
supported. 

 Overlays and Design Elements are exported as Nested Symbols. 
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 Ellipse is exported as an entity (AcDbEllipse) 

 Layers can be defined and exported – new switches control their use; for example rules 
can create new layers, set their colour, assign elements to layers by type. However, 
―colour bylayer‖ is not used for objects in the DXF/DWG file. 

 Text Alignment has been improved 

20.17 Configurable DGN Export 

Improvements also include: 

 Symbols, Backing Sheets, Frame and Logos are exported as cells; differentially scaled 
symbols are supported. Cells are exported with Tag data attached. 

The following limitations apply: 

 Although user-defined glyphs and line pictures are ignored, it is possible to specify a 
MicroStation custom line-style for a given DRAFT pen number. 

 Hatching (fill) patterns from HPATTERN19 to HPATTERN30 use a common shared cell 
definition. For these: Colours, Line weight and Line style will not be set. 

 Dimensions are not exported as MicroStation dimensions. However, they may be grouped. 

20.18 AVEVA Isometric ADP  

This add-on application has been completely overhauled for Hull & Outfitting 12.1. It can now be 

used for drawing detailed drawings, complete with parts lists, of both HVAC and Cable trays.  

It is fully configurable and produces a fully annotated Isometric-style drawing with: 

 Dimensioned and labelled Spool  

 Material Take-Off Table 

 Location Plan of the Spool in the Main 

 Keyplan of location to nearest Grid Line 

 Revision table 

 Total Weight and Centre of Gravity 

Drawing output is in PDF format, with Material Take-off to MS Excel. In addition, there is a 

dedicated Toolbar, Edit tools and a Print Tool for Multiple drawings. 

Please note that this new release will not work with earlier versions of Hull & Outfitting and that 

many areas are significantly different, including the following; 

 HVAC Catalogue upgrades 

 Draft Library elements for True-Type Fonts 

The appropriate changes have been made to the sample data supplied with Hull & Outfitting. 
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For full details, please refer to the updated Isometric ADP user documentation: 

 Installation Guide 

 User Guide 

 Administration Guide 
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21. AVEVA Marine Migration 

21.1 Preparing Databanks for Import into Hull and 
Outfitting 12.1 

The ability to read native Tribon indexed databanks has been removed from AVEVA Marine. 

Before using the migration program to migrate a Tribon project to AVEVA Marine, the Tribon 

databanks need to be upgraded to a neutral format (Tribon Model Index). There is a Tribon M3 

program called sa021.exe for this purpose: 

sa021 { –sourcedb <dbname> | –sourcedir <dir> } –targetdir <dir> 

Example. Convert the databanks in a native Tribon M3 project to Tribon Model Index-databanks: 

sa021 –sourcedir c:\m3projects\testproj –targetdir c:\tmi 

This will convert all databanks in the directory given by ‗-sourcedir‘ to Tribon Model Index 

databanks and store them in the directory given by the ‗-targetdir‘ option. 

 

Please contact your local AVEVA representative to get a copy of the sa021 utility. 

 

Please note that this is a Tribon program and must be copied to and executed in the Tribon bin 
directory, for example C:\Tribon\M3\bin.  
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22. AVEVA Schematic 3D Integrator 

Integrator has been extensively updated since its first release at 12.0; some of the developments 

noted below were first introduced in the Schematics Update Release at 12.0.SP6.8. 

22.1 New Integrator Object Method 

Integrator link information stored on CYMLNK elements consists of references to schematic and 

3D elements. It is possible during project execution for these references to become invalid when 

elements are deleted. A method is provided to clean up CYMLNK elements with invalid references. 

!!Integrator.ValidateLinks() 

Note: This method should be used only when all of the schematic and design databases, holding 

elements that have been linked, are current on the MDB. 

22.2 Electrical Connections 

When building an equipment with a template, Integrator will try to match schematic electrical 

connections to 3D electrical connections within the template. It already does this for nozzles which 

are matched on BORE, but for ELCONNs it now tries to match on CATREF. Details are included in 

the updated Integrator User Guide Section 5.4.1 Building Equipment. 

22.3 Whole Diagram Compare  

The Comparison Options form has been extended with new options. The Whole Diagram Compare 

options allow you to set which main types will be included in the report for a Compare Diagram 

operation. 

 

22.4 Selector Rules  

Quotes are no longer required in selector rules for long STYPs as Integrator will automatically 

include quotes for text selectors. For example, a rule with SCSTYP OF source operating on an 

SCVALV with SCSTYP PTFE-LINED will generate Choose with STYP |PTFE-LINED|. 
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22.5 Improved Links Administration 

Integrator no longer automatically creates a Link World. Project administrators are recommended 

to create a separate Design Reference database to hold links, and then use the new Manage 

Links dialogue, available from the Integrator > Settings menu. This can be used to create and 

manage Link Worlds in the appropriate database, including consolidating links from separate 

databases. 

 

Manage Links is also available with the new Compare/Update Utility. 

For More Information, please refer to the Integrator User Guide sections 4.7.16, 5.2 and 5.3. 

22.6 Configuration Rules Extensions 

Integrator‘s Project Configuration Explorer is now shared with the Compare/Update Utility, and so 

can hold rules for comparing elements between design, schematic and engineering databases. A 

Rule Set holds all the Rule Groups for a particular pairing of database types. For example, the 

sample configuration has a default Rule Set for comparing Design database content against 

Schematic database content. You can add Rule Sets for other combinations of database types, 

e.g. schematic and engineering, for use with Compare/Update. 

 

Top level Rule Groups now have a source type which is the type of element for which they will be 

applied (in place of the condition setting type of source). 

For More Information, please refer to the Integrator User Guide section 6.5.5. 
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22.7 Example Macro 

Some users may prefer to use a macro to run the comparison. The example macro below 

compares all schematic equipment and pipelines that appear on a particular diagram: 

-- File: compare macro for user guide.pmlmac 

 

-- Initialise Integrator 

!!integratorInit() 

 

-- Collect schematic equipment and pipelines that appear on this 

drawing 

!scgroup = |/Piping_Diagrams| 

!sctypes = |SCEQUI SCPLIN| 

!diagExp = |name of diaref eq '/A1-51-2003'| 

!sccoll = object COLLECTION() 

!sccoll.scope(!scgroup.dbref()) 

!sccoll.types(!sctypes.split()) 

!sccoll.filter(object expression(!diagExp)) 

-- Integrator compare method needs array of strings 

!comlist = ARRAY() 

do !element values !sccoll.results() 

  !comlist.append(!element.ref.string()) 

enddo 

 

-- Set report direct to file and do compare 

!!integrator.setreportvisible(false) 

!!integrator.setreportpath('c:\mac\compareReport.xml') 

if (!comlist.size() gt 0) then 

  !!integrator.compare(!comlist) 

  handle any 

    write !!error.text 

  elsehandle none 

    -- Write out the compare summary 

    !!integratorSupportHandler.printSummary() 

    -- View the report unless running in non graphics mode 

    if (not istty) then 

      !file = object FILE('c:\mac\compareReport.xml') 

      if (!file.exists()) then 

        !!integrator.openreport() 

      endif 

    endif 

  endhandle 

endif 
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23. AVEVA Diagrams 

23.1 Diagram Change Highlighting 

Changes to schematic diagrams can now be highlighted in the Diagrams, Schematic Model 

Manager and Tags modules, using a new Diagram Change Highlighting add-in. This add-in 

enables the database changes between two database sessions to be viewed, using the AVEVA 

SVG Viewer to highlight the changes in colour. It also provides a summary of the changes in the 

list below the two viewer screens. 

It can be accessed from the context menu of the Schematic Explorer: 
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Note: For this function fully to work with the data created by the Diagrams application, it requires 

that SVG files are created for the relevant sessions. This is affected by the ―Keep session files‖ and 

―Create SVG on Save Work‖ settings in Diagrams Options, as well as the possible use of the 

―Release Diagram to 3D‖ button.  

For more information 

Only noted here. 
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23.2 Connection between Instrument and Process Items  

 

 

It is now possible to use Instrument Relationship Shapes to connect Offline instruments or 

Actuators to any valid process item. The connection point will be created automatically on the 

shape if connection is possible, so the user will not have to create any additional ones beforehand. 

However, connection points on in-line items that were designed for in-line flow connections cannot 

be used for instrumentation connections. 
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23.3 Automatic Upgrade of Options Settings Files 

The Diagrams Options files (DiagramsDefaultSettings.xml and DiagramsAttributePresentation.xml) 

are now automatically upgraded from previous versions, so that existing project settings can be 

preserved in the upgrade process while also gaining access to new settings and options introduced 

in the latest version. 

The process of upgrade relies on a proper placement of the file containing the options values from 

an older version of diagrams. The proper place for the file is described in detail in the Diagrams 

User Guide, in the DiagramsGetting StartedApplication SettingsDiagrams Options section. 

The upgrade is fully automatic and executes upon application start. A report of the upgrade 

process, containing descriptions and locations of the participant files and any problems that might 

have occurred is available in the Diagrams Message Log. 
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23.4 Admin Settings vs. User Settings 

It is now possible for customers to define and set up which settings should be Admin Settings and 

which settings should be possible for regular users to change. 

The administrative set has the same format as the current version of diagrams options store, but is 

located at a location which is write protected for the user but read/write for administrators. 

When an option in the administrative set has a ―ro‖ value of the access attribute (access=―ro‖), this 

option‘s value will overwrite the value set in the user‘s options store, and the option will be disabled 

(greyed out) in the Diagrams Options dialogue. 
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23.5 Handling of Units in Annotations 

With the release of AVEVA Hull and Outfitting 12.1, some changes and enhancements have been 

made to the handling of Units. 

In AVEVA Diagrams changes have been made to accommodate the new functionality and to allow 

presentation of values with or without units in shape text and annotations. 

Some attributes with numeric values are now dimensioned and have associated units. For 

example, attribute PRESS of element of type SCPLIN currently has a dimension of type ―pressure‖ 

and can have units of pressure (psi, bar, etc.). All attributes that are dimensioned have current 

session units.  

If the current session unit for the dimension of pressure is psi, and the value of the attribute 

PRESS is 23psi, one can use [scplin.press] to use the value of the attribute in annotation: this will 

produce the value of the attribute in the current units - ―23‖. If the units are desired, the ―.withunit‖ 

keyword can be used - [scplin.press.withunit] will give the result in the annotation text as ―23psi‖. 

The following screenshot shows annotation where the ―.withunit‖ keyword is used: 

 

This shows the same annotation without using the ―.withunit‖ keyword: 

 

For More Information 

See User Guide Schematics / Diagrams / Appendices / Attribute Presentation Notation. 

Affected Programs 
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AVEVA Diagrams 
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23.6 Publish Diagrams Data to AVEVA NET 

Description 

 

This version of AVEVA Diagrams has new functionality to publish Diagrams data to AVEVA NET. 

Publishing can be done on individual pages in a diagram. This will make the diagram and the 

schematics data on the diagram available in AVEVA NET. 

 

 

 

 

It is also possible to publish several diagrams using the Batch Job function, and also to publish the 

diagrams while releasing the Diagrams data to 3D. 

For More Information 

See User Guide Schematics / Diagrams / Utilities / Publishing Data to AVEVA NET. 

Affected Programs 

AVEVA Diagrams 
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23.7 Automatic Line Breaks Depending on Line Priority. 

Support for line jumps has been introduced in the Auto Formatting Rules feature. Two new format 

types have been added on the ‗Format to Assign‘ tab in the ‗Auto Formatting Rule Details‘ window: 

 Add line jumps – allows the user to specify the behaviour of the line when crossing another 
line shape. It can be selected from a list of standard values: 

 

 Line jumps style – allows the user to specify the style of jump if the line is the one which 
should break. It also can be selected from a list: 

 

The new settings together allow the user to specify the behaviour of crossing lines depending on 

defined conditions. If the settings are applied properly by rule, the result is visible on the drawing 

and also appropriate values are shown for particular shapes on the tab in the Visio Format-

>Behaviour dialog. 

For More Information 

See User Guide Schematics / Diagrams / Working with Diagrams / Auto Formatting Rules. 
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23.8 Improved Shape Annotation in Schematic Model 
Viewer 

It is now possible to individually control the shape annotations for the element types in the 

Schematic Model Viewer. The following settings can now be made using the options dialog in the 

Schematic Model Viewer: 

 Display criteria for selection of shapes 

 Display text 

 Icon (.png file) 

 Stencil shape 

For More Information 

See User Guide Schematics / Diagrams / Schematic Model Viewer. 
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23.9 Automatic Line Breaks Depending on Line Priority. 

Description 

Previously Diagrams did not provide functionality to configure automatic line jumps with priorities 

depending on attributes. To capture the requirement, support for line jumps has been introduced in 

the Auto Formatting Rules feature. Two new format types have been added on the ‗Format to 

Assign‘ tab in the ‗Auto Formatting Rule Details‘ window: 

 

 

 

 Add line jumps – the setting allows to specify the behaviour of the line when crossing 
another line shape. It can be selected from a list of standard values: 
 

 

 

 Line jumps style – allows to specify the style of jump if the line is the one which should 
break. It also can be selected from a list: 
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The new settings together allow specifying behaviour of crossing lines depending on defined 

conditions. If the settings are applied properly by rule, the result is visible on the drawing and also 

appropriate values are shown for particular shapes on the tab in the Visio Format->Behaviour 

dialog: 

 

 

Benefits 

Auto Formatting Rules functionality covers user needs in a better way. 

Compatibility Constraints 

None. 

For More Information 

See User Guide Schematics / Diagrams / Working with Diagrams / Auto Formatting Rules 

Affected Programs 

Diagrams 
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23.10 Improved Shape Annotation in Schematic 
Model Viewer 

Description 

It is now possible to individually control the shape annotations for the element types in the 

Schematic Model Viewer. The following settings can now be made using the options dialog in the 

Schematic Model Viewer: 

 Display criteria for selection of shapes 

 Display text 

 Icon (.png file) 

 Stencil shape 

 

 

Benefits 

Enables the user to better control shape annotations in the Schematic Model Viewer. 

Compatibility Constraints 

None. 

For More Information 

See User Guide Schematics / Diagrams / Schematic Model Viewer 
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Affected Programs 

Diagrams 
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23.11 Split-Merge for SCBRAN 

Description 

Split-Merge functions for SCBRAN now available in Diagrams.  

 Join 

To join two branches please select two valid connectors and execute the Join <LineType> Branch 

option from toolbars or menus: 

 

 

 

 

If join will not be possible the system will notify the user in the System Message log. 

 Split 

To split branches use the ‗Branch splitter‘ symbol which works in the same way as ‗Line splitter‘. 
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Benefits 

The possibility to join/split branches in simple way without using workarounds. 

Compatibility Constraints 

None. 

For More Information 

Only noted here.. 

Affected Programs 

Diagrams 
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23.12 Setting SCVALV GTYP to INST rather than 
VALV 

Description 

It is now possible to use INST as a GTYP on SCVALV elements instead of VALV, VTWA or VFWA 

gtypes. To achieve this, the master shape must have the ‗Classify as Instrument (GTYPE=INST)‘ 

option checked on the Edit/Import master dialog.  

 

 

 

When this option is checked in the master item, all SCVALV‘s that will be created from this master 

will have GTYPE set to INST.  

Changing existing items 

1. Changes on opened diagram 

It is possible to change existing SCVALV gtyp from VALV, VTWA or VFWA to INST using the 

shape context menu option ‗Replace Symbol‘. 
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If your current item has a GTYP different to INST and you replace this shape with a master that 

have the ‗Classify as Instrument‘ option checked, then after shape replace, the system will change 

GTYP from the existing one to INST and give a warning message in the System Message Log. Of 

course this can work the opposite way around. The system is able to change INST GTYP to VALV, 

VTWA or VFWA.   

2. Batch changes 

In case you have many diagrams and you want to update all items on all drawings you can use the 

‗Update symbols according to master shapes‘ option from the Batch Job update: 
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Before you can use this option you have to modify the masters that were used to create valves by 

checking/unchecking the ‗Classify as Instrument‘ check box. After that, you need to select it using 

the dialog below: 
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In case the system will change GTYP during this operation, a warning message will be displayed in 

the batch job log.  

Specification search during batch job: 

If GTYP has been changed and existing item has valid SPRE attribute set then system will try to 

find the new specification. The search algorithm is presented below: 
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SCVALVE Item

Check if Item contains 

valid SPRE

Check in diagrams settings if 

specification should be used.

and

Check if SPRE type is SPCO

Give a warning that current 

SPRE might be not valid

Item has no SPCO set 

before. Do nothing
NO

YES

NO

Check if any SELE or SPEC 

element asks about TYPE

YES

NO

The current SPCO does not 

depends on GTYP.

Do nothing

Find the element with TYPE question and start searching downstream looking for 

new SPCO. The following criteria is considered during search:

o For PPBO, TYPE and STYP questions the answer is taken from SCVALVE 

directly.

o For other questions, the default answer will be used (in case if there is only one 

possible item to choice then this item will be taken). In case if above fails then 

system will try find the answer for current question from existing SPEC 

„Question-Answer path‖. 

If no items fit to the answer then system put message in log that SPCO can not be 

found. Otherwise system will continue search until it find correct SPCO. If SPCO is 

found then the system warn the user about the SPRE change.

YES

For More Information 

See User Guide Diagrams / Utilities / Batch Job. 
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23.13 Changes to Upgrade Drawing Functionality. 

Description 

Previously after ‗Upgrade Drawing‘ was executed either automatically on open or manually from 

the Tools menu it was not possible to cancel the operation. However, it was possible to close the 

drawing before the upgrade was completed and this caused an exception. 

Now a progress bar is shown during ‗Upgrade Drawing‘ and the operation can be safely cancelled: 

 

 

Also, appropriate messages are added to the message log on operations start and cancel/finish: 

 

 

 

 

Additionally, when ‗Upgrade Drawing‘ is called manually from the Tools menu, a status window 

appears after the operation is completed: 

 

 

or was stopped by the user: 
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In case the user opens a drawing that is not updated to the current product version and the 

‗Upgrade drawing on Open‘ option is set to false, the following warning appears in the message 

log: 

 

 

If the ‗Upgrade drawing on Open‘ is set to true, but for some reason the drawing cannot be opened 

automatically, an appropriate error message is added to the message log: 

 

 

Benefits 

The ‗Upgrade Drawing‘ functionality works better and does not cause any errors. 

Compatibility Constraints 

None. 

For More Information 

Only noted here. 

Affected Programs 

Diagrams 
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23.14 Linked Files Update 

Description 

New ways to update linked objects in a diagram.   

 Use Edit->Links… dialog 

When a drawing that contains linked objects is active then the ‗Links…‘ option is active in the ‗Edit‘ 

menu. This option is hidden when a drawing has no linked objects. 

 

 Use ‗Update Diagrams‘ in batch job. (File->Batch Job…) 

This option allows the user to update linked objects in many drawings in one go. 

Benefits 

Allows users to update and manage linked objects. 

Compatibility Constraints 

None. 

For More Information 

Only noted here. 

Affected Programs 

Diagrams 
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23.15 Possibility to Determine Connector Re-route 
Style 

Description 

It is possible to determine a connector re-route style for newly created lines. For HVAC, Pipe and 

Instrument line types a special option called ‗Reroute‘ has been added. This option allows the 

settings ‗Never reroute‘ or ‗Use shape settings‘ for newly created connector lines. By default ‗Never 

reroute‘ is selected. In case the ‗Use shape settings‘ is selected then Visio decides which setting 

will be used. 
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Benefits 

Newly created ducts or tubes can have routing style set to ‗Never Reroute‘ by default. 

Compatibility Constraints 

None. 

For More Information 

Refer to User Guide Diagrams / Piping and Instrumentation Diagrams / Adding Parts to a Branch / 

Dropping and Connecting. 

Affected Programs 

Diagrams 
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23.16 Default Value of the Stencil in Batch Job 

Description 

To be able to set default values for all existing items that have been created from particular 

equipment masters it is necessary to edit the equipment master and set the default value for the 

new UDA. Then running the Batch Job with ‗Update attribute presentation settings‘ selected. The 

master that contains the modified data must be selected. 

 

 

 

Before starting the batch update it is necessary that ‗Allow individual shape settings to override 

default settings‘ is checked for items that needs to be updated. 
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If this setting is not checked, the default value of the new UDA will be taken from ‗Session 

Defaults‘. 

 

 

 

If the system changes the database attribute, there will be detailed information in the batch job log. 

Please note that the system will not set attribute value for items where a UDA was already defined 

in shape data. If refresh is executed before the update then refresh will add any missing UDA to 

shape data with a default value. Then the system detects it and will not set a default value to 

database. 

Benefits 

The possibility to update existing items about newly created attributes values using batch job. 

Compatibility Constraints 

None. 

For More Information 

See User Guide Schematics /Diagrams / Utilities / Batch Job / Batch Update. 

Affected Programs 

Diagrams 
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23.17 Auto Hide Option for Shape Text for Short 
Connectors 

Description 

Two new options have been introduced to keep diagrams nice and clean where text will be 

displayed on connectors only when some criteria are met. The options described below are valid 

for pipelines, instrument lines and HVAC lines. 

 Auto hide text by leg length.  

This option allows to determine a minimum size for the tallest connector leg where text will 

be visible. If the tallest leg of a connector will be shorter than the default then the text will 

be automatically hidden and the system will notify about this in the System Message Log. 

It is possible to use metric as well as imperial units to determine the distance value. To 

disable this option, set it to 0 or just use blank. 

 

 

 

 Auto hide text by text fit 

This option will hide the text on the connector in the case the tallest leg of this connector 

will be shorter than the text that is currently displayed on it. If this happens the system will 

notify this in the System Message Log. 
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Both options will work when the connector size is changed. This means that text on connectors will 

be visible after you modify above options and accept changes. To make it work the connector size 

must be changed. 

To enable text that has become invisible because of these options, the ‗Show Text‘ option in the 

Shape Context menu must be ticked. 

 

Benefits 

There is a possibility to hide text on connectors because of the connector leg length. 

Compatibility Constraints 

None. 

For More Information 

Only noted here. 

Affected Programs 

Diagrams 
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23.18 Miscellaneous Minor Improvements 

A number of further improvements have also been made to Diagrams for this release: 

 Area Shapes DB representation: A new Database Element Type (SCAREA) to represent 
Area Shapes has been introduced. This allows data to be stored in the database related 
with Area Shapes, allowing them, for instance, to represent rooms with related attributes 
and properties. 

 Consistency Check Improvements: The Consistency Check function now detects further 
issues that may exist with the objects on the diagram, such as bad references and 
inconsistent use of fluid between connected pipelines. 

 Auto Formatting Rules Improvements: The ―Format to Assign‖ tab in the Rule Details 
window now includes more options for format type; a number of UI enhancements have 
also been made to the Auto Formatting Rules windows. 

 Diagram and Page References: Pseudo attributes that return references to the 
diagram(s) and page(s) on which objects are shown have now been introduced for further 
types of objects, for instance inline valves & fittings. This may help integration with other 
data sources such as Instrumentation. 

 Fixed Shape Text and Label position: For tube & branch labels on Visio connectors, 
when the option 'Use Control Handle' is set and the text of a line is positioned using this, 
the position will be kept when the line is split by inserting a component.  For all 2D shapes, 
there is now a new ―Move label with 2D shapes‖ setting in the Annotations section in 
Diagrams Options. This allows the user to have labels with a fixed position, for instance 
Equipment Data Block labels that will not move when the equipment item itself is being 
moved. 
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24. AVEVA Engineering 

A new AVEVA Engineering product has been introduced with the release of AVEVA Plant and 

AVEVA Marine 12.1. This new product includes a new Tags module as well as a new ENGIneering 

Dabacon database type, designed and optimized for Engineering data. The Engineering product 

also includes Schematic Model Manager, which is no longer sold as a separate product. 

24.1 Tags 

The new Tags module provides an easy-to-use and powerful user interface for engineering users, 

allowing them to work on Engineering Lists & Schedules and related data. 

Some of the more prominent features and functions of the Tags module are as follows: 

 Easy-to-use User Interface: Familiar Microsoft Office 2010-like UI. See pictures overleaf. 

 List Editing: Grid-based editing of list data in the new ENGI database. List views can be 
set up Project Wide by administrators. It is also possible for regular users to create and 
use their own specialized layouts. This includes grouping/filtering and bulk editing 
capabilities. 

 Multi-discipline concurrent engineering: By using the new Distributed Attributes and 
Database Views mechanisms, it is possible to allow true parallel work between different 
disciplines, even on the same object. 

 Navigation: In addition to the list editing, it is also possible to navigate the engineering or 
system hierarchy to find and edit individual items. 

 Data Management functions: A number of management functions such as Status 
Control, Change Highlighting, Attribute History and Extracts are available to manage the 
lifecycles of engineering objects.  

 Change Highlighting: It is possible to highlight and report on changes made by different 
users and disciplines. This also includes highlighting of changes made in diagrams. 

 Diagram viewer: A built-in diagram viewer allows users to view and navigate P&IDs and 
other schematics.  

 Compare & Update: Engineering data can be compared and updated against a number of 
other AVEVA sources, such as Schematics, 3D, AVEVA Instrumentation etc. (see 
Compare/Update). It is also possible to compare individual items of the same kind against 
each other to find differences. 

 Excel Import/Export: Engineering data can be imported from external sources and 
exported to external applications by using Excel Import/Export utilities. 

 AVEVA NET Integration: Engineering data can be exported to AVEVA NET 

 Reports: Project-quality formatted reports can be created direct from the Dabacon 
databases. As Engineering is based on the same platform as the 3D and Schematics 
tools, it is very easy to combine data from these sources into common reports. 
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For full details of this important new module, please see the AVEVA Tags User Guide. 

24.1.1 Admin Tab 

The Tags module includes a new concept for administration. There is an ―Admin‖ tab in the ribbon 

bar which is only available for users that are: 

 Free users (Like SYSTEM) 
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 Members of the TAGSADMIN team 

Allocating users to the TAGSADMIN team allows superusers or department managers to perform 

certain admin tasks in Tags / engineering, without them having to be free users. 

24.1.2 Tag Deletion 

In the new Tags module, data for a single tag can be distributed over multiple databases to allow 

for different disciplines, possibly operating in different locations. For any tag, the data for each 

discipline is stored on a separate object but presented as if on a single object. It is thus possible to 

delete a tag but not have access to delete all of the distributed data, and this can result in orphan 

objects remaining. 

The Delete Tag Orphans.pmlmac macro (available from AVEVA Support Knowledge Base) can 

be run in the Tags module to find and delete orphan objects. Please note that all relevant 

databases should be current before running this macro (it contains a warning). It maintains a log of 

its results including any errors where it is unable to delete an object. It may need to be run at 

different locations to tidy up periodically. 
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24.2 Schematic Model Manager 

24.2.1 Use of units  

Schematic Model Manager now uses the new units capabilities rather than its former specific units 

functions. This means that imported data is automatically converted to the appropriate units 

chosen for the project. In the Project Options dialogue, the Units tab has been removed. 

The specific Units UDAs have been removed from the default file and will no longer be populated 

on import. Users can choose to use them but will need to set them up as required. 

The Attribute Type is no longer needed in the Attribute Mapping file, so has been removed from the 

Attribute Mapping UI. 

24.2.2 Units upgrade 

Schematic data imported prior to 12.1 must be upgraded. A check is performed automatically on 

entry to Schematic Model Manager and the user will be warned if an upgrade is required. The 

upgrade process must be carefully considered by project administrators as it can affect multiple 

projects and locations. Firstly, schematic data is scanned to identify changes required. Secondly, 

UDA definitions are updated for the appropriate units. Thirdly, the changes identified are applied to 

the schematic data. 

Please refer to the Schematic Model Manager User Guide for full details of this process. 

24.2.3 Change Highlighting in Diagram Changes in Diagrams may now be highlighted in 

Diagrams, Schematic Model Manager and Tags, using a new Diagram Change Highlighting add-in.   

Please see section in Diagrams chapter. 
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24.3 Tag Compare / Update  

The new Compare/Update add-in application can integrate data between Design, Schematic and 

Engineering databases, as well as data from AVEVA Instrumentation and AVEVA Electrical. It 

enables populations of tagged objects such as equipment and line lists to be compared, updated 

and linked between the data sources. Compare/Update supersedes the AVEVA Instrumentation 

Data Update application and is available in several Design/Engineer modules: Design, Tags, 

Paragon, Schematic Model Manager and Diagrams. 

 

For More Information, please refer to the new Compare/Update User Guide. 
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25. AVEVA Outfitting Module 

25.1 Model Editor 

25.1.1 Offset From Feature… option 

This new option has been added to the popup menu for the following Model Editor modes:  

  Model Editor, Equipment Editing, Quick Pipe Routing and Pipe Component Modification. 

 

Selecting it gives the user a form to specify the offset and then pick the relevant feature:  

 

25.1.2 Structural primitives 

Primitives owned by structural elements can now be edited in a similar way to Equipment Editing, 

with a right click on the selected item.  

 

Primitives owned by the following additional element types are affected: 

  STRU, SUBS, VOLM, SVOLM, PTRA, AREADE 
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25.2 Move, Drag Move and Plane Move Commands  

The Piping, Equipment, HVAC and old cable tray application now have new positioning menus. 

Structural move commands are unchanged. 

The new forms provide a WRT gadget to allow direction to be specified in terms of a local co-

ordinate system. In addition, UNDO has been implemented for all move operations (i.e. when the 

Apply button is clicked). 

All picks are now EDG picks, replacing the old ID@ style picking. This allows most of the pick 

functions to be replaced by a single EDG pick (i.e. screen, P-point, graphics and element picks can 

all be done using standard EDG position picks.) 

Note that many of the functions provided by these menu commands can also be achieved by using 

the Model Editor and Pipe Route Editor. 

25.2.1 Summary of Move, Drag Move and Plane Move options 

The Move commands enable the user to move the Current Element (CE) in a given direction. CE 

can be moved by a given distance in that direction or it can be moved to a position relative to 

another element, or relative to a plane through a given position.  

For piping and equipment, the Drag command moves a piping item, together with other 

components, equipment and nozzles connected to it which form a constrained network. 

The new form appears with four tabs: 

 

The Distance tab moves an element a distance in a given direction.  

The Through tab moves an element in a given direction until it reaches a point relative to a plane 

perpendicular to the direction of movement through another point.  

The Clearance tab moves an element in a given direction so that its obstruction volume or a P-

point is a given clearance from another element. The clearance is measured in the same direction 

as the direction of movement.  
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The Towards tab moves an element a given distance in a direction specified in terms of another 

element. 

For details, please refer to the Design Common Functionality User Guide. 

25.3 Change highlighting and reversion  

This development provides improvements in the management of change, including that resulting 

from the use of extracts. These changes fall into four categories: 

 Enhanced sessions user interface to show the reason for each database session 

 Command syntax to revert an element, or hierarchy of elements, to a previous state 

 Improved Extract Data Control dialog to highlight extract changes 

 Model Changes Add-in to explore and highlight general changes to the model 

There is a separate Comparison add-in – see section 24.2.3 – available from the Schematic 

Explorer context menu. This can show changes related to diagram elements between two 

database sessions or stamps and can use the SVG Viewer to highlight the changes in colour. 

25.3.1 Enhanced User Interface for Sessions 

Forms that display details of a database session now also include the reason for that the session. 

For example, the database session form, accessed from Utilities > DB Listing, shows it thus: 

 

Users can explore sessions containing an added element by selecting DB Changes or DB 

Differences from the Control menu, and selecting Session in the ―Changes Since‖ radio button 

set. 
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25.3.2 Revert Elements Command 

A new command can revert an element, or hierarchy of elements, to a previous state: 

>- REVert -+- ELEment ---. 

           |             | 

           `- HIERarchy -+- <selele> -+- AT -----. 

                                      |          | 

                                      `- BEFore -+- <comparison> -> 

where the <comparison> syntax is similar to that following the SINCE keyword in the 

DIFFERENCE and OUTPUT CHANGES commands: 

  -->-+- <date/time> -+-----------------------. 

      |               |                       | 

      |- LATEST ------|                       | 

      |               |                       | 

      |---------------+- EXTRACT -+-----------| 

      |                           |           | 

      |                           |- extno ---+ 

      |                           |           | 

      |                           ‘- extname -+ 

      |                                       | 

      `- STAMP - <name> ----------------------+-> 

If the BEFORE option is used, the elements will be reverted to the state they had before the 

specified session.  

Examples: 

 REVERT HIER /EQUIP AT LATEST 

  reverts the element hierarchy rooted at /EQUIP to the latest saved session. 

 REVERT HIER /EQUIP BEFORE LATEST 

  reverts the hierarchy rooted at /EQUIP to the state it had before the latest saved session. 

 REVERT ELE /E1301 AT 20:16 26 / 3 / 2010 

  reverts the single element /E1301 to the state it had on the given time and date 

 REVERT HIER /PIPES AT STAMP /StampMilestone7 

  reverts the hierarchy rooted at /PIPES to the state it had at the named stamp 

 REVERT HIER CE AT EXTRACT 

  reverts the hierarchy rooted at the current element to its state in the parent extract 

The Revert command ensures that every element creation, include, reorder and deletion, and 

every attribute change is allowed before proceeding. If any of these tests fail, for example due to 

legality checks, read-only databases or DACs, then the entire revert operation is cancelled and the 

following error is generated. 

(43,615)  Cannot Revert elements. No changes have been made. 

In this case a series of warning messages is written to the console indicating the causes of the 

error, for example: 

 DAC prevents deletion of element /DELETE_UDET_B 

 DAC prevents creation of element =15752/1363 

 DAC prevents modification of attribute Built on element 

/MODIFY_B_VESS1 
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Element locks do not prevent a Revert operation if those elements were unlocked in the previous 

state. 

Note that this command is not directly related to the REVERT <database name> command 

available in Admin. This command allows an entire database to be reverted to the state it had at a 

previous session. 

25.3.3 Change Highlighting via Extract Data Control 

The Extract Control dialog has been enhanced to highlight outstanding changes in a child extract 

in the graphical view. It can also highlight changes introduced to a child extract by a refresh 

operation. The highlighting is controlled and customised within a ―Change Highlighting‖ framebox, 

shown below. 

When the ―Outstanding in Extract‖ checkbox is selected, all changed elements in the child extract 

that have not yet been flushed or issued to the parent are highlighted if they appear in the current 

graphical view. The Colour button allows selection of the change highlight colour using the 

standard colour palette. The highlighting is cleared when the dialog is closed, or when a 

subsequent extract operation is performed using the dialog. In the latter case the checkbox 

becomes unselected. 

When the ―Introduced by Get All Changes‖ checkbox is selected, all elements that are changed by 

the next Get All Changes action, or Flush or Issue actions if these include Get All Changes, are 

highlighted if they appear in the current graphical view. The same highlighting colour is used as for 

outstanding changes. The highlighting is cleared when the dialog is closed, or if the ―Outstanding in 

Extract‖ checkbox is selected. In the latter case the ―Introduced by Get All Changes‖ checkbox 

becomes unselected. 

There is a subtlety to the Flush and Issue actions available in this dialog: these operations include 

an extract refresh by default. The exception is in a Global project, where the parent extract is not 

primary. In this case a refresh is not included in the operation. In order to clarify whether a refresh 

will occur as part of a Flush or Issue action, an indication has been added to the dialog, as shown 

below: 
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25.3.4 Change Highlighting via Model Changes Add-in 

A new Add-in has been introduced to provide a general mechanism for exploring change and 

highlighting changed elements in the 3D graphical view. The Model Changes Add-in is activated 

and de-activated via menu option Query > DB Changes. This replaces the previous DB Changes 

option, though this function is still available via Utilities > DB Listing: see below. The Add-in is 

shown in its default layout below: 
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The Model Changes Add-in has two vertically split panes. The top split contains a Design Explorer; 

the lower split contains a tabbed pane and controls, as shown below:  

 

 Model Changes Add-in tabs and controls 

The tabbed pane condenses the following displays (see over):  

Model Timeline: every session for every Design database in the current MDB, ordered 

chronologically. 

Stamps: details of every stamp that records session numbers for all of the Design databases in the 

MDB. 

Element History: details of every database session in which the selected (current) element has 

changed.  

Key: static tree control with images, colour and text explaining annotation of changes in the 

Explorer.  



AVEVA Marine 12.1       User Bulletin 

Copyright 1974 to current year. AVEVA Solutions Ltd.   263 
 

 

Model Timeline pane 

 

Element History pane 
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Explorer Annotations Key pane 

The Element History and Key panes are for information only; the Model Timeline and Stamps 

panes allow selection of a session or stamp upon which to base the display of changes in the 

Explorer pane, and optional highlighting of changes in the 3D view. Once a session or stamp is 

selected, changes can be highlighted by clicking the Refresh button at the bottom left of the Add-in 

(see above). 

Two modes of change reporting are supported, according to the current selection in the drop-down 

list in the bottom right of the Add-in: 

Only Changes At... shows only the changes that were made when the highlighted session was 

created. This may have been a Savework or as the result of an extract operation, such as a flush 

or refresh, as indicated by the Reason column in the Model Timeline table. Note that highlighting in 

the Explorer pane and in the 3D view is always with reference to the current state of the model; it is 

possible that no changes from a previous session will be visible, for example if all changes were 

made to elements that have since been deleted. 

All Changes Since... shows all changes that have been made in all databases in the MDB 

between, but not including, the selected session or stamp, and the current state of the model. This 

does include any unsaved changes. Note that for large models this change analysis can take some 

time. 

When the Refresh button is clicked and the change analysis operation is complete the explorer 

tree is updated with annotations which highlight the changed elements in detail. An example is 

shown overleaf:  

The annotations are as described in the Key pane; in this example, we can see that: 

 The World element and SITE element /ATEST are not themselves changed but have 

changed descendants. This helps navigation to the changed parts of the element 
hierarchy; 

 ZONE element /ZONEEQUIP_FROM_A has member list changes only. Since no new or re-

ordered elements are displayed, it can be inferred that all child elements have been 
removed; 

 CONE element /CHANGETYPE_UDET_CONE_A has been modified (its type has been 

changed); 

 EQUI element /MOVE5_A_VESS1 has been moved from the child list of 

/ZONEEQUIP_FROM_A into the child list of /ZONEEQUIP_TO_A; 

 EQUI element /CREATE_A_VESS1 has been created under ZONE element 

/ZONE1.EQUIP, thereby changing its member list. 
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Annotated Explorer 

 

Clicking the highlight checkbox at the bottom middle of the Add-in (see Model Changes Add-in tabs 

and controls picture above) has an immediate effect on all 3D graphical views if changes are 

currently displayed in the explorer tree. Any changed elements that have graphical representation 

and are in the drawlist for any active view are highlighted in colour. This uses the same 

customisable colour used by the ―Highlight element‖ function available via right-click menu in the 

standard Design Explorer Add-in. Unchecking the checkbox returns the graphical display to normal 

colouring. 

All panes of the Model Changes Add-in are updated and Explorer annotations and 3D graphical 

highlighting are reset in the following circumstances: 

 further element changes 

 Savework, Getwork, and Refresh 

 User or MDB switch 

Following any of these operations, the Refresh button must be clicked again in order to update the 

change highlighting. 

Former DB Changes Dialog  

The functions of the Query > DB Changes dialog in earlier versions of Hull & Outfitting are still 

available via Utilities > DB Listing. This dialog is very similar, the only difference being the initial 

mode setting. This mode can be changed using the Control menu on the DB Listing dialog as 

shown below: 
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25.4 Enhanced attribute export to Review  

The Export Attribute form, accessed from the Utilities menu, now allows the user various options 

to specify the element(s) to be exported and to pick the export file name from standard file 

browser. 

 

 

25.5 Weight and Centre of Gravity (CofG) form  

The Within Area option has been removed from this form (Utilities > Mass Properties > Weight 

and Centre of Gravity) as it depends on the INSIDE/OUTSIDE qualifier, which is not supported for 

these mass properties. 

25.6 DRAFT Explorer  

The DRAFT Explorer may now be made accessible in Design; this is only useful if the Draft 

databases are also made accessible in Admin!  

25.7 AVEVA Mechanical Equipment Interface  

It is now possible to export to a single STEP file by specifying a file name instead of a directory 

name, e.g. 
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export file /c:\project\a345\pipe1.stp 

Naming of exported items is unique within this file. 

Note: It is still not possible to create a multi-level assembly hierarchy in a single STEP file. 
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26. AVEVA Outfitting Design Applications 

26.1 Equipment 

The Create>Equipment… form has been redesigned with several enhancements: 

 Equipment may be positioned using graphical picking 

 Attributes are input directly using the creation form rather than a sub-form 

 UNDO is available 

 The form is resizable 

For details, please refer to the Equipment User Guide (Section 4). 

 

26.2 Piping  

26.2.1 Sloping piping 

The data structure for piping includes two new concepts for better handling of slopes or falls: 

 An adaptive or ―wobbly‖ P-point that can accommodate a specified range of angles – this 
is achieved by introducing a tolerance attribute OFFTOL on all types of P-point (in 
Paragon). A PDIR pseudo-attribute defines the actual direction, which must be within the 
tolerance of the nominal direction 

 A Slope element or SLOELE, in a Slope table or SLOTAB, that can be referenced by the 
SLOREF of a SPEC, PIPE or BRANCH to specify default, minimum and maximum slope 

The introduction of these new concepts has no effect on existing Cats & Specs or models. The 

new features are used in Quick Pipe Routing and also for sloping existing orthogonal piping. The 

Paragon GUI has been extended to cover Slope Tables. 

The pipe creation form has an additional option for selecting from a list of slopes and the modify 

pipe form has the same option for setting branch values. The older pipe and branch modification 

forms have also been changed to include new options for slopes. Note: If the SLOREF attribute is 

set at pipe level, it is automatically inherited by new branches. 
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The Model editor has been extensively revised to handle elbows (as well as bends) and the new P-

point options, as well as adding slope options to the menus. A new form can assist in applying a 

slope to an existing pipe, including all the branches within it. To display it, navigate to an existing 

pipe and select Modify>Pipe Slope... 

For full details, please refer to the Piping User Guide. 

26.2.2 Direct setting of Insulation Thickness & Material  

This allows the piping designer to choose piping insulation of a given thickness and material rather 

than setting the temperature and spec for automatic selection. 

New sample insulation specifications are provided as a basis on which users can base company 

and/or project insulation specifications. 

26.2.3 Bending Machine NC Output  

A new option Bending Machine NC Output… in the Utilities Menu allows users to save a file, 

which contains the bending details of a specified list of pipe pieces. To use this, the current 

element must be a Site, Zone, Pipe, Pipe Spool List (PSLIST), Pipe Spool (PSPOOL), Pipe Piece 

List (PPLIST), or a Pipe Piece (PPIECE).  
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This enables you to search for bent pipe pieces, filter them, and then create a report. 

 

26.2.4 Improved production checks  

The Pipe Production Checks can now use a user-defined pipe stock length as well as the bending 

machine maximum material length (MML).  

The Pipe Stock Length is set up in the Pipe Data Table (type PDAELE) using Paragon: the data 

elements of that table now have a field PStLen for pipe stock length. It may be queried using q 

PStLen on a pipe data table element. New Pseudo-attributes enable the pipe stock length of a 

particular (implied) tube to be queried: q ATST for ‗Arrive Tube Stock Length‘ or q LTST for ‗Leave 

Tube Stock Length‘.  

The production checks perform two tests on each pipe piece: 

 Compare the pipe piece length with the stock length for that tube spec. If the piece is 
longer, the test will fail regardless of bending requirements 

 Compare the pipe piece length with the maximum pipe length for the bending machine 
assigned to this branch or pipe. If it exceeds the machine-defined value, the test will fail 

These two tests will be performed in the order above and in addition to any other tests, such as 

wall thickness, corrosion, etc. The user will be notified of the success or the reason for the failure. 

26.2.5 Material search for Pipe Bending Machine setup 

A Search button has been added to allow the user to search for the appropriate material (from all 

SMTE in catalogue or |SOLI in the Property database, with Filters if required). 

26.3 Structures 

26.3.1 Steelwork Connectivity Upgrade 

The user interface for connecting structural elements has been improved in various places to use 

event-driven graphics (EDG) interaction. In addition, several operations now also work on 

GENSEC elements including curved members and UNDO is now available for some functions. 
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In particular, a Connect Ends? check box has been added to the form for creating Curved Section 

GENSEC elements. This check box allows the user to specify whether they wish to connect the 

ends if a suitable start or end point is selected. 

 

Minor changes apply to creation of straight and curved members, connection and disconnection 

and several operations related to joints. For details, please refer to the Structural User Guide. 

When regenerating the support, e.g. by selecting a new template with a different steelwork section 

specification, or creating by dimensions, pads will be regenerated if pads already exist before the 

regeneration process if triggered. If the size of the steelwork sections is not modified then the same 

pad will be used. If the steelwork section is modified then the pad size will be modified.  

26.4 Hole Management enhancements  

The Hole Management Utility which creates and manages penetrations in panels has been 

improved, by the addition of additional catalogue properties in the Pipework catalogue and HVAC 

penetration components. The utility is available only in the Pipework and HVAC Designer 

applications and accessed from the Hole Management Utilities toolbar. 

To start the application, click the Hole Management Utility icon on the toolbar to display the 

Managed Hole Utility window. The main utility form is divided into 4 sections – for the creation, 

merging, modification of holes and utilities. 

For further details, please refer to chapter 4 Multi Disciplinary Penetration and Hole Management 

of the Design Common Functionality guide. 

26.4.1 Create Holes 

In the Clearance field, specify the clearance to apply to the penetrating item. This is not applied if 

the software detects a clash with a pipework or HVAC component that has hole size properties. 

Note: The clearance can be controlled by the component that passes through the panel if the 

penetrating component has a Property AHDI (for circular) or AHX, AHY (for noncircular) in which 

case these property values will control the clearance. For more information, refer to Configuration 

Hole Management Data. 

Click Auto penetrate CE to automatically create holes in panels in a selected structure. 

The clash analysis can take a few minutes; a progress message and bar will be displayed. Once 

the analysis has taken place, the Hole Association Manager window is displayed with the details of 

the newly created virtual holes. 

Note: The Hole Association Manager window is not displayed if no virtual holes are created. 

If more than 30 virtual holes have been created, there will be a confirmation message to display 

the Hole Association Manager window. 

To create holes individually, click Create Hole. The user will be prompted to pick a panel, pipe or 

HVAC branch that penetrates the selected panel. The creation of the hole is identical to the 

automatic hole creation. 

26.4.2 Merge Holes 



AVEVA Marine 12.1       User Bulletin 

Copyright 1974 to current year. AVEVA Solutions Ltd.   273 
 

Merged holes are individual holes merged together into a single hole. To merge holes, click Pick 

holes; the user is prompted to pick a Managed Hole fitting to be combined into a single merged 

hole. 

Note: A minimum of two holes must be picked. 

 

 

Click Merge Holes, the software creates a merged hole containing the selected penetrations. 

26.4.3 Modify (and Delete) Holes 

Created holes can be modified, managed or deleted. 

To modify a created hole, click Modify CE. The Hole Modification window is displayed, modify the 

created hole as required, the Free Hole Boundary Editor can also be started from this window. 

To manage created holes, from the Hole Association Manager window, select Managed Selected 

Holes, the Hole Management - Definition window is displayed. 

Use this window to add single or merged hole penetrations, define the hole type, penetrating 

clearance, hole shape parameters, positioning and an option for the hole to revert to the 

catalogues specifications. 

To delete a created hole, the user is prompted to pick a hole. If the hole has no status it is deleted; 

if the hole is Requested, the user will be prompted to confirm the deletion. If the hole is Approved, 

deletion is not permitted. 

26.4.4 Utilities 

All panels within the volume of the selected pipe or HVAC can be added to the 3D view. To do this, 

from the Utilities part of the Managed Hole Utility window, click Add Structure. 

To view all pipe or HVAC elements within the volume of the selected structural panels, from the 

Utilities part of the Managed Hole Utility window, click Add Pipe/HVAC. 

To generate and define a report on selected holes, click Hole Report. The report can then be 

printed or exported to Excel. 

 

Managed hole reports 

The Hole Association Filter enables the user to specify 

which Managed Holes to list in the Report: 

Current 

Element  

Holes associated with the 

currently selected element only 

Graphical Holes associated with elements in 
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Selection  the current graphical selection 

All Managed 

Holes  

Holes in the MDB 

 

Report Headings may be specified: 

Discipline  Specify holes for all disciplines or a single one specified using the drop-down 

menu 

Status  Specify holes at any Status or at a single Status option using the drop-down menu 

Valid  Select all holes or only those that pass or fail the validation tests 

Note: any option other than Not Checked may significantly slow down report 

generation as all the validation tests will be run for every selected hole 

Invalid  Include hole associations that have any bad references, invalid references or invalid 

data 

Panels  Select holes in panels 

Apply Filter  Refreshes the Hole Report according to the element and filtering options selected 

Note: It is necessary to select Headings required on the report before clicking on 

Apply Filter because heading data is collected when filters are applied. 

Report 

Headings  

Select headings required on the report from three categories: information about the 

hole, information about the penetrated item and information about the penetrating 

item 

Preview  Displays Managed Hole Report window 

The Managed Hole Report window displays the specified report. 

 

You can use grid column functions to sort and filter columns before printing or exporting the report. 

Select Print Preview to view the report or select Export to Excel to export it. 

Right click the Hole Associations list to display the following pop-up menu: 
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Navigate to  the Association, the penetrated or the penetrating item (single selection 

only) 

Add to 3D view  Adds the selected holes and associated items 

Remove from 3D view  Removes the selected holes and associated items 

Focus on Hole  Zooms the 3D view to centre on the selected hole and zoom in.  

Clipping is applied if it is enabled (single selection only). 

Export list to Excel  Exports the report grid to Excel 

Print list  Shows a standard grid print preview for the report grid 

26.4.5 Configuration of Hole Management Data 

Additional hole size properties on piping and HVAC components are used to control automatic hole 

dimensions. If these properties are not provided the system uses hole management default sizes 

(e.g. OD for pipe holes). 

Hole Management Design and Catalogue data configuration is as described in the Design 

Common Functionality User Guide, with the addition of new data set properties on selected piping 

components. 

The following properties are used to control automatic hole sizes. 

Property Name 

(DKEY)  

Description 

AHDI  Property specifying the diameter of the hole required for the component (a REAL 

DISTANCE expression returning the hole diameter.) 

The property is used if:  

1. It is associated with a piping or HVAC component that clashes with the 

panel at the penetration. For example, this property may specify the 

outside diameter of a COUP element that represents a penetration sleeve. 

2. It is associated with a FLAN component that is adjacent to a penetration 

clash with pipe implied tube. This allows for a flange clearance hole to 

be created. 

If the AHDI property is applied, the Clearance value is ignored. If the AHDI 

property is not applied, (Pipe OD + Clearance) is used to calculate the hole size. 

AHX  Property specifying the X dimension of a rectangular hole required for the 

component (a REAL DISTANCE expression.) 

If the AHX property is applied, the Clearance value is ignored 

If the AHX property is not applied, (Component width + Clearance) is used to 

calculate the hole size 

AHY  As for AHX, but specifies the Y or height dimension of the hole. 

26.4.6 Hole Association Manager 

The Hole Association Manager window is used to manage the tasks associated with holes. 

The Hole Association Filter is used to select hole association(s) and structural elements to be 

displayed. 



AVEVA Marine 12.1       User Bulletin 

Copyright 1974 to current year. AVEVA Solutions Ltd.   276 
 

 

Select the element, specify the filter criteria and structural elements, then select Apply Filter. The 

selected hole associations will be displayed in the Hole Associations table. 

If some of the hole associations fail, navigate to the hole and use hole management to modify the 

penetration, then select Apply Filter from the Hole Association Manager window. 

To add elements to be managed, select Add Current Element. 

To remove the automatically created penetrations, select Reset, then Refresh. 
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Displaying Holes 

The Hole Association Manager window can also be used to display selected holes in the 3D 

view. 

 

 

Clipped Hole View 

The Focus on Hole option can be used to zoom in on a selected hole and remove all other 

elements from the 3D view. Make sure that the clipping and capping options are selected on the 

active 3D view. 

From the Hole Associations table, right click to select a single hole and activate a popup menu. 

Select Focus on Hole; this zooms to the selected hole and clips the surrounding background. 

To return to the normal view, de-select the clipping and capping options or select a different view. 

Show Tags 

To show tags and a box surrounding a selection of holes in the associations list, check the Show 

Tags box. 

Translucent Penetrated 

To emphasise the penetrated items selected in the associations list, check the Translucent 

Penetrated box. 

26.5 Penetration with Piping Component  

This new pipe penetration function enables a component such as a watertight bulkhead seal, 

modelled as a COUP, to be positioned on either side of the plate being penetrated. It can cope with 

cases where the penetrating pipe is not orthogonal to the plate.  

The component can be shown on pipe sketches and isometrics; Isodraft has been modified to add 

a new SKEY CPCF and a penetration seal symbol. Please see section 26.10.7. 

Full details are given in the Common Functionality User Guide: Chapter 4. Catalogue 

Requirements are given in Section 4.2.13 Project Configuration for Hole Management. 
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26.5.1 Creation of Penetration  

Normally, a penetration ATTA element is created on the pipe to mark the location of a penetration. 

It is possible to put a pipe component, representing a sleeve or penetration seal, at the penetration 

if the piping catalogue is suitably configured. Pipe penetration components are modelled as COUP 

elements. 

When a penetration component is required, select From Pipe Spec in the Specification pull down, 

and select Marker Type COUP. 

 

The CHOOSE form is displayed showing the couplings available from the piping specification. 

Select the required component and click the OK button.  

Note: In the sample MAS project, an example of a pipe penetration component can be found in 

category /MACB2OR. 

 

The Hole Management – Definition form is displayed. If a suitably configured piping component is 

selected, it can be placed on either side of the penetrated plate – an additional Flip Side button 

appears on the form. 

 

Click on the Flip Side button to place the piping component on the other side of the penetrated 

plate. 
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The symbol for this component is represented on an isometric drawing as: 

 

 

 

26.6 Standard Model Library  

This new function, an early version of which was included in the Marine Outfitting Update 

12.0.SP6.10, allows the user to capture multi-discipline design elements, store them in a library for 

re-use and then create any number of instances of them at any position in the model, as required.  

It is accessed from a new Standard Model Library Manager form, accessed from the Utilities 

menu and uses a Create Standard Model Library Item form; these vary somewhat dependent on 

whether a user is a library manager or a general user.  

The first form to appear is the Manager form, which can be used to browse the library and add 

items to it: 
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This creates a new element in a Library in the application data world (APPLDW) – the library item 

is an APPLDA element in an APPDAR. A similar form is used to modify these items. 

Libraries, Areas and Items are modified or deleted from a pop-up menu on the same form: 

 

 

For full details, please refer to the Design Common Functionality User Guide manual. 

26.7 Clash Utility enhancements  

The Clash utility uses a new form, which shows all the options; it uses a grid gadget for filtering 

and grouping and a 3D view of the clash with aid graphics. Simple clipping, navigation, reporting 

and printing are also available. 
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When the form is first shown, the current element is selected in the Check field. Users can change 

this as they wish by typing any Design name or syntax such as ZONE. The element to be checked 

is always named in this text box. The options available are: 

 Check Check the named element for Clashes 

 Check CE Show the name of the current element and check it for Clashes 

The Clashes are displayed in a grid, with the usual facilities for filtering, grouping etc: 

 

The whole grid can be printed or saved to file by the RH popup menu options: 

Print Preview 

Save to Excel… 
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It is necessary to scroll the grid to the right to see all the information about the clash such as 

Position 

 

 

There are also columns for the primary element that clashes or obstructs; any column can be 

dragged in the grid to group rows, for example: 
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The example groups all clashes per branch and then clashes against the same obstruction. This is 

a common useful grouping so there is an option to set the default presentation. 

 

Other options on this panel are covered by the standard DESCLASH defaults.  

In addition to the DESCLASH options there are various other presentation defaults such as the 

View background colour and options to display aid constructs to in the 3D view. 

 

 

By default each clash is displayed in a clipped view; the clip box size can resized by direct input or 

a slider bar above the view – or clipping can be switched off. 
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When checking for clashes, the default obstruction is All; this mean that the element is checked for 

clashes against everything in the MDB. In practice, it is perhaps more realistic to check for clashes 

against specific obstructions. This is specified in the Obstruction/Exclusions panel: 

 

 

There are several options to help the user add to these lists: 
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 Current Element 

 Pick Element 

 Current Selection 

 Current List 

 All 

Remove removes any selected elements and Clear clears the entire list. 

The application allows a limits volume to be set so that only clashes within these limits are 

reported. If all values are zero then there are in effect no limits to the clash check. This can be 

reset using the Clear button. 

The volume box can displayed using the Display option: 

 

 

To set limits the Position can be directly input or set using the options: 

 Current Element 

 Picked Elements 

 Defined by 2 Picks 

 Current Selection 

 Current List 

The 3D view has all the expected functionality of a standard 3D view and can be Printed and 

Saved to file by setting focus to the view and selecting from the View > Print Graphics… and Copy 

Image options. 

26.7.1 Reports 

If a text report of the clashes is required this can be done by ticking the Export report to file toggle 

on the Report panel. The report will be written to file each time a Check is performed 
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Other Changes to the Application 

 The old Clasher settings forms from Settings>Clasher have been removed 

 The old Clasher form is removed but the Menu Utilities Clashes is still the same 

 

26.8 Cable Design 

A number of enhancements have been made. Of particular note is a new Manual Route Cable 

‗task‘ that allows the user manually to create or modify a cable‘s route between its start and end 

references. For details, please refer to the Cable Design User Guide. 

26.9 Multi-Discipline Supports 

26.9.1 Cable Tray Supports 

MDS can now support the new cable tray CTRAY elements, as used in the Cable Design 

application. A CTSUPP element is used instead of an ATTA. 

‗Old‘ piping (BRAN) cable trays and CTRAY cable trays can be supported by the same cable tray 

support using the Add Rack function as usual: 
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26.9.2 Automatic generation of pads  

There is a new application default to turn the auto generation of pads on or off; the default is on. 

If the setting is ‗on‘, pads are created when using a cursor based creation method (CURSOR or 

CLEARANCE) with a PANEL or HPLATE element identified. The section type is checked and a 

suitably shaped pad chosen, appropriate to the section type. For example, triangular shapes are 

used for angle and square (rectangular) for flat bar.  

 

A new ‗Modify pad size‘ button on the Modify Section form enables the user to change the 

dimensions of an existing pad. 

In Paragon, the default value for the Automatic Pads option can be set On or Off in the MDS 

Admin Data form, under the top bar menu Modify > MDS Application Defaults… 

26.9.3 Updating client project defaults  

From time to time new or updated component standards will become available in the MDS 

catalogue. Where users are maintaining their own application defaults databases, these changes 

will not be immediately available because they need to be added to the database.  

A new upgrade tool allows the MDS administrator to update existing standards or add new ones. 

This is useful for users upgrading from a previous version of a project or continuing work on a 

project that uses a copy of a previous version‘s MDS/APPDEFAULTS database. 

The ‗Check MDS Application Defaults‘ tool is a new feature in the Utilities menu of the Paragon 

module and is available to administrators who belong to team ‗CATADMIN‘. For details, please see 

the Multi-Discipline Supports Administrator Guide. 
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26.10 Outfitting Piping Isometrics 

There are several developments in Hull & Outfitting Isodraft version 12.1. For details, please refer 

to the updated User and Reference Manuals. 

26.10.1 New Output File Formats, Including PDF  

Isometrics may now be produced in PDF, Image or EMF (Enhanced Windows Metafile) format. 

This is achieved through an extension of the FILE command, for example: 

FILE PDF /filename 

These formats may also be selected from the Options form: 

 

26.10.2 TrueType Fonts 

TrueType fonts, as defined in Admin, may now be used on isometrics. The user can select the font 

type for all the text on the isometric (including material description) by font number, e.g. TTFONT 

5.  

Examples: 

TTFONT OFF  TrueType fonts are not used 

TTFONT ON  Selected TrueType font is used 

TTFONT 5  Times New Roman font as defined in Admin 

TTFONT 6  Arial font as defined in Admin 

TTFONT NONE  TrueType fonts are not defined 

TrueType fonts may also be selected from the Options form – see above. 

Note: True type fonts may only be used when isometric output files are to be produced in DXF, 

PDF, Image or EMF (Enhanced Windows Metafile) format.   

26.10.3 Large Coordinates  
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ISODRAFT can now handle coordinates larger than other limits in Hull & Outfitting and show them 

on the isometrics. Its limit is now 2,147,483,647,000 mm (approximately 2 million km). 

It can also display large coordinates, such as those encountered when using coordinates related to 

a GPS datum, on the iso. 

26.10.4 Additional Coordinate Formats  

New commands and options on the Annotation Options GUI allow the user to specify format, units 

and precision for coordinates on the iso: 

COFORMAT  

Selects the format for the coordinates output on isometrics:  

USER   User-Defined using Alternative Texts (as before) 

ENU   E, N, U format 

XYZ   X, Y, Z coordinates  

SHIP   Ship Reference system 

NUMBERS   Purely numeric  

 

COUNITS  

Selects units for the coordinates: 

Command Units Example 

MM  millimetres  6263.48 

CM  centimetres  626.348cm 

METRE  metres  6.26348m 

FINCH  feet and inches  20’6.19/32” 

USFINCH  feet and inches (US style) 20’-6 19/32” 

DECINCH  decimal inches  246.59” 

INCH  fractional inches 246.19/32” 

USINCH  fractional inches (US style) 246 19/32” 

 

CODECP  

Selects the precision (number of decimal places) for DECINCH (Imperial decimal) coordinates:  

0  precision to nearest inch 

1  precision to nearest 1/10 inch 

 

COIMPP  

Selects the precision for Imperial fractional coordinates: 

FINCH  (feet and inches) 

USFINCH (feet and inches - US style) 

INCH  (fractional inches) 

USINCH (fractional inches - US style) 

26.10.5 Drawing Pipe Spool 

This enables isometrics to be drawn of the PSPOOL elements stored in PIPEs under a PSLIST. 

This is an alternative, used by pipe fabrication checking, to the SPOOL elements in the SPOOLER 

database. 
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26.10.6  „North‟ Arrow Text  

The text shown with the ‗North‘ arrow may be changed by means of the Alternative Text 

ATEXT(202). The default is ‗N‘; If the User changes ATEXT(202) to ‗LP‘, the symbol will appear as: 

 

 

 

 

 

 

 

 

26.10.7 Pipe Penetration Seal Symbol 

This new user-definable symbol (SKEY CPCF) represents a Penetrating watertight piece modelled 

using a COUP element – see section 26.5.  

This is in addition to the similar user-definable SKEY CPWP used for a Penetrating piece. 

For details, please see the ISODRAFT Reference Manual section 3.27 Symbol Key Reference 

Index.  

26.10.8 Setting Units in Options files 

Isodraft loads the current units setting when the user enters the module but has its own units for 

defining bore and distance on Isometrics; these are built into the individual Isodraft options files. 

There is no change are to the way that bore and distance units are output but changes have been 

made to define the units required for some additional items. 

Previous versions of Isodraft output units for Weight, Pressure and Temperature; these will be 

interpreted in current units and converted to the correct output value. For example Pressure is 

stored in Pascals but the user may require the equivalent in bar on the iso. To ensure this, the 

options file needs to contain the required output settings. 

This is done by adding a block of code for setting units at the end of the options file. Each time an 

Iso is created, the options file is run as a macro so appending the correct units settings to this will 

ensure that Isodraft enter the detailing process with the correct units settings loaded.  The process 

of modifying the option file will automatically append the current units so each option file can 

potentially redefine the current units. 

The standard option setting process is to select Options>Modify from the main Isodraft menu bar 

to show the Modify Options form. After selecting an options file to modify, pick Dimensioning 

Options. A new button (Other Unit Settings) on this form shows the Current Session Units form 

as in Design: 
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The units settings can be reset using this form and need to be activated using the Set … Unit 

button. 

Clicking OK on the options form will save the current units setting into the current options file. Once 

an options file has its own units settings, these will be loaded before generating isos or modifying 

the file. 

Notes:  

 Until an options file has been modified, the units displayed in the Current Session Units 
form will be the current Design session units as on entry to Isodraft. When an options file 
has been loaded, the units defined in the options file become current. Existing Options files 
will have no unit definitions until they have been edited and saved. 

Isodraft does not currently perform any units conversion for UDAs. Isodraft will output them in 

database units. 
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26.11 Future Considerations 

26.11.1 Access platforms, Stairs and Ladders (ASL) 

The new application for Access platforms, Stairs and Ladders (ASL), released in 12.0, is being 

improved to provide an excellent tool for stairs (single flight in the first release), ladders and 

handrailing. The functionality to create platforms with the application is being removed and 

platforms will be created using standard Beams & Columns and Panels & Plates functionality, 

possibly in conjunction with the Standard Model Library utility.  

The new application will, therefore, be known as Stairs, Ladders and Handrailing (SLH). 

Until the new application is released the 12.0 ASL application is kept in the product as is . 

The old Access platforms, Stairs and Ladders application (from Hull and Outfitting 11.6) is still 

available, though it will be removed at a future release. It is available, hidden, at Hull and Outfitting 
12 and can be reactivated by a simple edit to the PML file PDMSUI/des/addins/access. This file is 

all commented out; activate all the code lines after the header and ensure that the application is 

shown on the menu: 
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27. AVEVA Global 

27.1 Global WCF  

This option was introduced with Hull & Outfitting 12.0.SP6.6 to improve the security of all Global 

communications. It is an alternative to the use of RPC which has been used in previous versions of 

Global. 

It provides an interface to the Windows Communication Foundation (WCF) as an alternative to 

Remote Procedure Calls (RPC) for network communications. As a result, Global can now exploit 

the security configurations provided by WCF, which is enabled and configured by modifying values 

in XML configuration files. 

The following security benefits are now available: 

 Transport Layer 

o Apply security to either the connection (ideal for connected networks), or individual 
messages (ideal when sending messages over the internet) 

 Bindings 

o Determine the low level protocol used, BasicHTTP (textual, unsecured), wsHTTP 
(textual, secured) or TCP (binary, faster, but cannot be validated) 

o Determines which ports to use for connections  

 Encryption 

o WCF provides many encryption algorithms to protect data en route 

 Encoding 

o Tied in with the binding, this determines how the message will be sent: text (slow), 
binary (fast) or Message Transmission Optimisation Mechanism (MTOM) which 
will send what it can in text, but will send binary data as binary (a combination of 
the previous two) 

 Authentication 

o At the server side, the message is verified to be from a known source; at the client 
side, the message is sent to a known receiver. Messages can authenticate against 
a Windows account or via a certificate. 

 Message Validation 

o Ensure that messages meet a known format by comparing against a Schema 

Full details are provided in the Global WCF Configuration Guide. Other Global manuals have also 

been updated for 12.1. 

27.2 Global Claim Commands  

Global Claim (to an extract) commands issued from Hull & Outfitting now pass only if ALL claims 

succeed. This is a change as in previous versions, where the Claim command would pass even 

when some claims had failed. 

The Running Global Projects manual has been updated with further details. 

27.3 Global WCF Service Name  
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The Global WCF interface name has changed from that in 12.0.SP6. This affects the Global WCF 

client and server Configuration files. The purpose of this is to force an interface change between 

12.0.SP6 and 12.1 as the databases are not compatible.  

The name has changed from the unversioned name used in 12.0.SP6. This is reflected in the 

endpoint definition within the configuration files GlobalWcfClient.config and 

admindWCF.exe.config.  

The Endpoint has changed from: 

…/GlobalWcfServiceLib/GlobalWcfService 

to: 
…/GlobalWcfServiceLib/GlobalWcfService_11_1_201011 

As a result the WSDL file is now renamed from: 

aveva.globalservice.wsdl  

to:  
aveva.globalservice.11.1.2010.11.wsdl 

The service contract is now:- 

IGlobalWcfService_11_1_201011 

The Endpoint has changed from: 

…/GlobalWcfServiceLib/GlobalWcfService 

to: 
…/GlobalWcfServiceLib/GlobalWcfService_11_1_201011 

The sample configuration files provided with Global 12.1 contain the new versioned names; 

however if you wish to carry the 12.0.SP6 WCF configuration files forward to 12.1 you will need to 

change the references above in both the GlobalWcfClient.config and 

admindWCF.exe.config configuration files. 

27.4 ADUUID Attribute Length 

This attribute provides a UUID (Universal Unique Identifier) for the Global daemon. It is a string of 

hexadecimal values (for example, 92e2714e-0a85-42b0-9d6a-100905aeffc0). Global 

will not work if this attribute does not contain a valid UUID. 

While reviewing all text attributes for Unicode, this one has been shortened to 40 characters; the 

former length of 120 characters is far longer than the maximum possible value.  
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28. AVEVA Catalogue & Specifications 

A number of improvements have been made to the PARAGON module. The most significant are 

listed below: 

28.1 Model Settings  

The Model Settings form has been updated. The most significant change is to allow the alteration 

of catalogue parameters only. 

 

 
 

Model settings can be altered by the Model View form as well as by the Model Settings form. In 

addition to changing the catalogue parameters, the Model View from may change other 

parameters based on a category‘s data set. For example, if the data set includes properties that 

define design parameters, those design parameters in the model settings are set to the default 

property values from the data set. If the ‗Only Update Catalogue Parameters‘ box is checked, the 

Model View form will not update any model settings except those for catalogue parameters. 

28.2 Parameterised Detail Text  

The GUI will now accept Text Expressions in Detail Text fields: these must be entered as valid 

string expressions beginning with ‗(‘ and ending with ‗)‘. If the expression is not specified in this 

way, the Detail Text field will be treated as a simple string. 

For details, please see section 4.1.15 Detail and Material Text in the Catalogues and 

Specifications User Guide. 

28.3 Copy Button for Structural Catalogue  

New Copy buttons have been added to the forms for creating structural geometry components and 

Plines. These make it easy for the user to copy an existing element and then modify the 

expressions rather than start from scratch. This approach is similar to that used for the Data Sets. 

Details of the changes are given in the Catalogue & Specifications User Guide. 
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28.4 Creation of Structural Specs  

In the Specification list form, available from menu Display > Specifications, there is now a button 

Display Spec. Pressing this button brings up the Specification form as before except that the form 

opens in Read Only mode. In this state the form UI changes slightly – the title includes [Read Only] 

and changes the wording of two link buttons from Edit Spec Atts... and Edit CAT Atts... to Show 

Spec Atts... and Show CAT Atts...  

The Create menus in Steel Work and Equipment have had the Specification menu restored, 

moving the Specification World entry down to a submenu next to Create Specification. The 

Modify menus have had the Specification... entry restored. 

 

 
 

When modifying specifications, some non-piping specifications cannot be altered by the form. 

Attempting to modify such a specification will put the form into read only mode as described above.  

This form allows you to access various tasks which administer all aspects of a new Specification. 

The current version is primarily intended for use with piping specifications and may not always be 

suitable for other specifications. 

28.5 Raw Plates in CATA 

The raw plate definition has been moved from the manufacturing database (MANU) to the 

catalogue (CATA) in the Catalogue World. The raw plate elements are defined in Paragon using 

the PML script HullDefineRawPlates. Input to the script is the file which previously was used to 

create the raw plates in MANU. This change is beneficial for projects using Global. 
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29. Known Issues 

29.1 Outstanding Faults and Issues 

29.1.1 General Issues 

Internet Explorer 9 

AVEVA does not recommend the use of Internet Explorer 9. In particular, it has a fault associated 

with the use of the .CHM online help files, when they reference external files such as PDF. It is 

anticipated that a hotfix will be made available by Microsoft during October 2011. 

Unicode Filenames 

The use of ASCII (Basic Latin) filenames is recommended for two reasons: compatibility with other 

systems and various specific issues which have yet to be resolved. This applies to some of the 

systems to which PDMS is interfaced, and even to some of the interfaces where Hull & Outfitting 

makes use of third party software such as output of DXF and DGN. PML Publisher does not 

currently fully support Unicode filenames.  

Limitations 

AVEVA recommends that changes to Database Views (DBVWs) are not made whilst users are live 

in the system. Changes to ATTCOL attributes in Lexicon may otherwise cause Tags to crash. 

29.1.2 AVEVA Schematic 3D Integrator 

Some errors can appear using Integrator if there is no configuration file local to the project. The 

Integrator Link function can raise an Internal Integrator Error and edits in the Project Configuration 

Explorer may not be displayed correctly. The Compare and Build functions are unaffected, and if 

one of these has been run in the session then the Link function will also work.  

The workaround is to copy the file ProjectConfiguration.xml from the installed 12.1 folder to the 

folder <proj>dflts\ModelManagement, where <proj>dflts is the folder defined in the appropriate 

environment variable, e.g. %samdflts%. The same result can be achieved by a free user starting 

up Integrator, then clicking on Integrator>Display>Project Configuration Explorer, then saving the 

file. 

29.1.3  AVEVA Global 

Global 12.1 does not fully support projects with spaces in their pathnames. Work is in hand to 

remove this limitation but no definite release date is yet set.  

The daemon will work when installed in C:\Program Files\ but there is a known issue, see below.  

RPC Daemon cannot detect if a WCF daemon is already running for current location of the project. 

PDMS reports "(1,504)   Unexpected error contacting Daemon - check versions match‖ when 

missing global client dlls. 

Element claims can be lost for distributed extracts if an issue fails. This can lead to the error 

message ‗has been deleted in a later session‘. 

The new Database Distribution allows a collection of DBs to be relocated to another location. If the 

HUB daemon is down, the form will hang until all relocation commands have timed out. 
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Default Drawing files and Stencils are not propagated to location project on creating the new 

location. 

REMOTE CHECK will fail to run Standalone DICE if the daemon is installed in a folder which 

contains spaces, partly due to the semi-colon delimiter. 

Global WCF cannot process database filenames with large DB numbers unless these are named 

using FINO. This is a range error in the validation in the Global WCF Config file. Administrators can 

correct it by modifying admindWCF.exe.config:  FileNumber UpperBound should be 250000 

inclusive. Please see Pivotal Knowledge Base article 3736. 

29.1.4 New Reporting Add-in 

This new feature has a number of known limitations at this release, which will be improved in future 

releases. These include: 

 Improving performance while running reports in batch mode 

 Background colour not exported in RTF format 

 Watermark fails to display in the report 

 No Copy / Cut / Paste available in table modifications 

 Changing the Zoom in the Report designer causes Report to crash – with Exception error 
message, which you cannot close, making it hard to close Tags as Report Designer keeps 
screen focus. 
 

Some other limitations may be worked around as follows: 

Drag and Drop of DBView Array Fields to Report Designer 

This does not work at present; as an alternative, you can use an Array field in a report and place a 

control which can be bound to a field on the report. By setting the Data Binding property of the 

control it can be bound to an array field. 

In the example below a Label has been placed in the Detail section of a report for binding to the 

array field. 
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Quick Reporting – Handling of Grouping 

Where grouping is applied in the search results grid, the group layout result will not be maintained 

when a quick report is generated.  

This is because: 

 This would lead to an inconsistency with quick reporting functionality in Instrumentation 

 Different layouts need to be maintained for use in the reporting tool for grouped and non-
grouped quick reports 

Note: To enable group sorting: right click on the search results grid column heading, selecting 

Enable Group Sorting, and then dragging the column heading of the attribute you wish to group by 

into the group area of the search results grid (see example below).  

 

Use of Summary in Calculated Fields 

Where a summary field is used in a report the results of this summary cannot be used in a 

calculated field. 

This has been identified as a future enhancement. A workaround is available. 

Use of the Results of one Calculated Field in Another Calculated Field 

It is not possible to use one calculated field in another calculated field. 

This has been identified as a future enhancement. A workaround is available. 

Not Possible to Hide Group Header Only 

In the report designer, hiding a group header via the Group and Sort window also hides the group 

footer. However, hiding the group footer still leaves the group header visible. 

Workaround: To hide only the group header, assign the height as 0 to group header. 

PageRange Property Ignored when the ExportMode Property is set to SingleFile 

DevExpress recommends that the ExportMode should be set to any other value to resolve this 

issue. 
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AVEVA Net Gateway - Unicode Characters 

The field list explorer will not display Unicode characters unless the respective language pack is 

installed. The user can specify Arial Unicode font for reporting to display multi-byte characters in 

the report, PDF, excel, etc. without installing the respective language pack. 

Reporting Default Values in Cells 

When a value is not found, the error text ―!Error‖ is given. In the UDA definition there is a default 

value defined, which should be in the report. 

Workaround: This workaround removes ―!Error‖ from the report field, and replaces it with empty 

string. 

 Select the cell/label or control in report designer 

 Add the script for before print, select new when creating script for the first time. 

 Change the text from !Error to desired  string as below: 

 

Reporting Document Fails to Attach to the Mail  

This occurs for PDF files only when you have a Unicode character in the filename; it does the save 

but doesn‘t send it to Outlook. The workaround is to attach to email or right click the file to send it 

manually 

Quick Report exception thrown 

Doing a quick report and then using the HTML VIEW tab throws an exception. 

 

This occurs only with a large number of columns, so the report cannot accommodate them within 

the visible area.  

Large length Reports fail to export at certain formats 

A 509 page report exports as PDF, CSV and TEXT, but fails for all other formats. If you run the 

Excel (XLS) export it warns you and says use (XLSX) but fails on doing so. It can export to the 

CSV version that can then be loaded into Excel. Even if you select single page versions of the 

image export it fails. 

Reporting output differs for different Excel formats  

Exporting the output from Reporting, the data exported differs between XLS and XLSX. The XLSX 

format creates #VALUE! (errors in the cells that are PDMS REFs in the DBViews); whereas the 

XLS format creates the data correctly. 

This issue arises because export to XLSX format considers the data in Value (object) mode by 

default. The workaround is to use the Text export mode: please see below: 
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